Contents

Preface 7
An Introduction to Cinema Tools
8
Editing Film Digitally
10
Why 24P Video?
10
Working With 24P Sources
11
Editing 24P Video
12
About This Manual
13
Apple Websites

Part I  Using Cinema Tools

Chapter 1  17
Before You Begin Your Project
17
Before You Shoot Your Film
18
Which Film to Use?
19
Transferring Film to Video
19
Telecines
20
Transfer Techniques That Are Not Recommended
21
How Much Should You Transfer?
22
Frame Rate Basics
22
Working With NTSC Video
24
Working With PAL Video
25
Working With 24P Video
25
Timecode Considerations
28
Sound Considerations
28
Choosing an Audio Recorder
28
Choosing an Audio Timecode
29
Mixing the Final Audio
30
Synchronizing the Audio With the Video
32
Working in Final Cut Pro
32
Setting the Editing Timebase for Sequences
32
Using Effects
Using the Detail View Window to Connect and Disconnect Source Clips
Using the Clip Window to Enter or Disconnect Source Clips
Fixing Broken Clip-to-Database Links
Reconnecting Individual Clips That Have Been Renamed or Moved
Locating Broken Links and Reconnecting Groups of Clips That Have Been Moved

Chapter 6
Preparing the Source Clips for Editing
Determining How to Prepare Source Clips for Editing
Using the Conform Feature
Reversing the Telecine Pull-Down
Making Adjustments to Audio Speed
Synchronizing Separately Captured Audio and Video
Dividing or Deleting Sections of Source Clips Before Editing

Chapter 7
Editing
About Easy Setups and Setting the Editing Timebase
Restrictions for Using Multiple Tracks
Using Effects and Transitions
Tracking Duplicate Uses of Source Material

Chapter 8
Generating Film Lists and Change Lists
Lists You Can Create With the Film Lists Dialog
Exporting Film Lists
Creating Change Lists

Chapter 9
Export Considerations and Creating Audio EDLs
Considerations When Exporting to Videotape
Considerations When Exporting Audio
Exporting an Audio EDL

Chapter 10
Working With External EDLs and ALE Files
Creating EDL-Based Film Lists
Working With ALE Files

Part II
Working With 24P

Chapter 11
Working With 24P Video and 24 fps EDLs
Considerations When Originating on Film
Editing 24P Video With Final Cut Pro
Using One Final Cut Pro System for Both 24P Offline and Online Editing
Using 24P Video With Final Cut Pro and Cinema Tools
Using Final Cut Pro as a 24P Online Editor
Using Final Cut Pro as a 24P Offline Editor

Contents
Contents

187 Adding and Removing Pull-Down in 24P Clips
188 Working With 2:3:3:2 Pull-Down
189 Removing 2:3:3:2 Pull-Down With Final Cut Pro
190 Removing 2:3:3:2 or 2:3:2:3 Pull-Down With Cinema Tools
194 Pull-Down Patterns You Can Apply to 23.98 fps Video
196 Adding Pull-Down to 23.98 fps Video
196 Using Audio EDLs for Double System Sound

Part III Appendixes

Appendix A 201 Background Basics
201 Film Basics
206 Editing Film Using Traditional Methods
208 Editing Film Using Digital Methods

Appendix B 213 How Cinema Tools Creates Film Lists
215 About the Clip-Based Method
215 About the Timecode-Based Method

Appendix C 217 Solutions to Common Problems and Customer Support
217 Solutions to Common Problems
220 Calling AppleCare Support

Glossary 221
Index 229
An Introduction to Cinema Tools

Cinema Tools with Final Cut Pro gives unprecedented power to film and 24P video editors.

In today's postproduction environment, it's common for editors and filmmakers to find themselves faced with a confounding array of formats, frame rates, and workflows encompassing a single project. Projects are often shot, edited, and output using completely different formats at each step. For editors and filmmakers who specifically want to shoot and finish on film, Cinema Tools becomes an essential part of the postproduction process when editing with Final Cut Pro, allowing you to edit video transferred from film, and track your digital edits for the purpose of conforming workprints and cutting the original camera negative.

For example, when working with film you need to be able to track the relationship between the original film frames and their video counterparts. Cinema Tools includes a sophisticated database feature that tracks this relationship regardless of the video standard you use, ensuring that the film can be conformed to match your Final Cut Pro edits.

Also provided is the ability to convert captured video clips to 24 fps video. For NTSC, this includes a Reverse Telecine feature that removes the extra frames added during the 3:2 pull-down process commonly used when transferring film to video or when downconverting 24P video.

Cinema Tools, in combination with Final Cut Pro, provides tools designed to make both editing film digitally and working with the emerging 24P video standard easier and more cost effective, providing functionality previously found only on high-end or very specialized editing systems.
Editing Film Digitally

Computer technology is changing the film-creation process. Most feature-length films are now edited digitally, using sophisticated and expensive nonlinear editors designed for that specific purpose. Until recently, this sort of tool has not been available to filmmakers on a limited budget.

Cinema Tools provides Final Cut Pro with the functionality of systems costing many times more at a price that all filmmakers can afford. For filmmakers shooting with 35mm or 16mm film who want to edit digitally and finish on film, Cinema Tools allows you to edit video transfers from your film using Final Cut Pro, then generate an accurate cut list that can be used to finish the film.

How Does Cinema Tools Help You Edit Your Film?

For many, film still provides the optimum medium for capturing images. And, if your goal is a theatrical release or a showing at a film festival, you may need to provide the final movie on film. Using Final Cut Pro with Cinema Tools does not change the process of exposing the film in the camera or projecting the final movie in a theater—it’s the part in between that takes advantage of the advances in technology.

Editing film has traditionally involved the cutting and splicing together of a film workprint, a process that is time consuming and tends to discourage experimenting with alternate scene versions. Transferring the film to video makes it possible to use a nonlinear editor (NLE) to edit your project. The flexible nature of an NLE makes it easy to put together each scene and gives you the ability to try different edits. The final edited video is generally not used—the edit decisions you make are the real goal. They provide the information needed to cut and splice (conform) the original camera negative into the final movie. The challenge is in matching the timecode of the video edits with the key numbers of the film negative so that a negative cutter can accurately create a film-based version of the edit.

This is where Cinema Tools comes in. Cinema Tools tracks the relationship between the original camera negative and the video transfer. Once you are finished editing with Final Cut Pro, you can use Cinema Tools to generate a cut list based on the edits you made. Armed with this list, a negative cutter can transform the original camera negative into the final film.
If your production process involves workprint screenings and modifications, you can also use Cinema Tools to create change lists that describe what needs to be done to a workprint to make it match the new version of the sequence edited in Final Cut Pro.

**What Cinema Tools Does**

Cinema Tools tracks all of the elements that go into the making of the final film. It knows the relationship between the original camera negative, the transferred videotapes, and the captured video clips on the editing computer. It works with Final Cut Pro to store information on how the video clips are being used and generates the cut list required to transform the original camera negative into the final edited movie.

Cinema Tools also checks for problems that can arise while using Final Cut Pro, the most common one being duplicate uses of source material: using a shot (or a portion of it) more than once. Besides creating duplicate lists, you can use Cinema Tools to generate other lists, such as one dealing with opticals—the placement of transitions, motion effects (video at other than normal speed), and titles.

Cinema Tools can also work with the production sound, tracking the relationship between the audio used by Final Cut Pro and the original production sound sources. It is possible to use the edited audio from Final Cut Pro when creating an Edit Decision List (EDL) and process (or "finish") the audio at a specialized audio postproduction facility.

It’s important to understand that you use Final Cut Pro only to make the edit decisions—the final edited video output is not typically used, since the video it is edited from generally is compressed and includes burned-in timecode (window burn) and film information. It is the edit-based cut list that you can generate with Cinema Tools that is the goal.
Why 24P Video?
The proliferation of high definition video standards and the desire for worldwide distribution has created a demand for a video standard that can be easily converted to all other standards. Additionally, a standard that translates well to film, providing an easy, high-quality method of originating and editing on video and finishing on film, is needed.

The 24P video standard provides all this. It uses the same 24 fps rate as film, making it possible to take advantage of existing conversion schemes to create NTSC and PAL versions of your project. It uses a progressive scanning scheme and a high definition image (1920 pixels per line, 1080 lines per frame) to create an output well suited to being projected on large screens and converted to film.

Additionally, the 24P standard makes it possible to produce high-quality 24 fps telecine transfers from film. These are very useful when you intend to broadcast the final product in multiple standards.

Working With 24P Sources
With the emergence of high definition 24P video recorders, there is a growing need for Final Cut Pro to support several aspects of editing at 24 fps. To this end, Final Cut Pro and Cinema Tools provide the following:

- the import and export of 24 fps EDLs
- the ability to convert NTSC 30 fps EDLs to 24 fps EDLs
- a Reverse Telecine feature to undo the 3:2 pull-down used when 24 fps film or video is converted to NTSC’s 30 fps
- the ability to remove 2:3:3:2 or 2:3:2:3 pull-down when you capture your source clips from a digital video camera source that applied 2:3:3:2 or 2:3:2:3 pull-down to 24P video, so you can edit at 24 fps
- the ability to output 23.98 fps video via FireWire at the NTSC standard of 29.97 fps video
- the ability to match the edits of videotape audio with the original production audio tapes, and generate an audio EDL that can then be used to recapture and finish the audio if you intend to recapture it elsewhere for final processing

Several of the features mentioned above are included with Final Cut Pro and do not require Cinema Tools, however this book will describe all of these features because they relate to working with 24P, which is of specific interest to many filmmakers.
Editing 24P Video

The excellent quality of 24P video presents a challenge when it comes to editing—the bandwidth and storage space it requires. Editing minimally compressed 24P video directly in Final Cut Pro requires you to have a system with large, fast drives and specialized capture hardware. Even with a properly configured system, you will only be able to capture the video you actually intend to use, not the typical 20 to 100 hours you may have shot.

The typical approach is to edit in two steps: an offline session, using compressed and downconverted (to NTSC or PAL) clips, followed by an online session with recaptured uncompressed clips.

Even if your Final Cut Pro system is not configured to edit uncompressed 24P video, it can serve as an offline editor and export a 24 fps EDL to be used by a 24P online editing system. Even better, if your online 24P editing system uses Final Cut Pro, you can simply copy the project from the offline system, which allows you to preserve far more information about the edit than an EDL alone can provide.
About This Manual

This manual is a fully hyperlinked PDF document enhanced with many features that make locating information quick and easy.

- The homepage provides quick access to various features, including Late-Breaking News, the index, and the Cinema Tools website.
- A comprehensive bookmark list allows you to quickly choose what you want to see and takes you there as soon as you click the link.
- All cross-references in the text are linked. You can click any cross-reference and jump immediately to that location. Then, you can use the navigation bar’s Back button to return to where you were before you clicked the cross-reference.
- The table of contents and index are also linked. If you click an entry in either of these sections, you jump directly to the section for that entry.
- You can also use the Find dialog to search the text for a specific word or phrase.

This manual provides background and conceptual information, as well as step-by-step instructions for tasks and a glossary of terms. It is designed to provide the information you need to get up to speed quickly so that you can take full advantage of the powerful features of Cinema Tools.

- If you want to begin with some introductory background information about editing film traditionally as opposed to editing it using digital methods, see Appendix A, “Background Basics,” on page 201.
- To find out the details of how to use Cinema Tools, as well as some things to consider in the planning of your project, see Part I, “Using Cinema Tools,” next.
- If you’re interested in the 24P aspects of using both Final Cut Pro and Cinema Tools, see Part II, “Working With 24P” on page 175.

Note: This manual is not intended to be a complete guide to the art of filmmaking. Much of the film-specific information presented here is very general in nature, and is supplied to provide a context for the terminology used when describing Cinema Tools functions.
Apple Websites
There are a variety of discussion boards, forums, and educational resources related to Cinema Tools and other Apple products on the web.

Cinema Tools Website
For general information and updates, as well as the latest news on Cinema Tools, go to:

Apple Service and Support Website
For software updates and answers to the most frequently asked questions for all Apple products, including Cinema Tools, go to:
- http://www.apple.com/support

You’ll also have access to product specifications, reference documentation, and Apple and third-party product technical articles.

For Cinema Tools support information, go to:

Other Apple Websites
Start at the Apple homepage to find the latest and greatest information about Apple products:
- http://www.apple.com

QuickTime is industry-standard technology for handling video, sound, animation, graphics, text, music, and 360-degree virtual reality (VR) scenes. QuickTime provides a high level of performance, compatibility, and quality for delivering digital video. Go to the QuickTime website for information on the types of media supported, a tour of the QuickTime interface, specifications, and more:

FireWire is one of the fastest peripheral standards ever developed, which makes it great for use with multimedia peripherals, such as video camcorders and the latest high-speed hard disk drives. Visit this website for information about FireWire technology and available third-party FireWire products:
For information about seminars, events, and third-party tools used in web publishing, design and print, music and audio, desktop movies, digital imaging, and the media arts, go to:


For resources, stories, and information about projects developed by users in education using Apple software, including Cinema Tools, go to:


Go to the Apple Store to buy software, hardware, and accessories direct from Apple and to find special promotions and deals that include third-party hardware and software products:

Part I: Using Cinema Tools

Using Cinema Tools while editing film projects.

Chapter 1  Before You Begin Your Project
Chapter 2  The Cinema Tools Workflow
Chapter 3  The Cinema Tools Interface
Chapter 4  Creating and Using a Cinema Tools Database
Chapter 5  Capturing Source Clips and Connecting Them to the Database
Chapter 6  Preparing the Source Clips for Editing
Chapter 7  Editing
Chapter 8  Generating Film Lists and Change Lists
Chapter 9  Export Considerations and Creating Audio EDLs
Chapter 10  Working With External EDLs and ALE Files
Before You Begin Your Project

Start planning your project early to ensure its success.

Successful film production requires thorough planning well before exposing the first frame. Besides the normal preparations, additional issues must be considered when you intend to edit the film digitally. These issues may affect the film you use, how you record your sound, and other aspects of your production.

This chapter provides basic information on many of the issues you will face:
- which film to use
- choices for transferring the film to video
- frame rate issues between the film, your video standard, and your editing timebase
- sound issues such as which recorder and timecode to use, and how to synchronize it with the video
- issues with Final Cut Pro such as selecting a sequence timebase and using effects

Note: Much of this information is very general in nature and is not intended to serve as a complete guide to filmmaking. Please be aware that the digital filmmaking industry changes rapidly, so what you read here is not necessarily the final word.

Before You Shoot Your Film
Before you begin your project, be sure to discuss it with all parties involved in the process:
- those providing equipment or supplies used during the production
- those involved during the actual production
- the facility that will develop your film, create workprints, and create the release print
- the video transfer facility
- the editor using Cinema Tools and Final Cut Pro (if it is not you)
- the negative cutter
- the audio postproduction facility
These are people who are experts in their fields. They can provide invaluable information that can be the difference between a smooth, successful project and one that seems constantly to run into obstacles.

**Be Careful How You Save Money**

There are a number of times throughout the film production process when you will get to choose between “doing it right” and “doing it good enough.” Often your budget or a lack of time drives the decision. Make sure you thoroughly understand your workflow choices before making decisions that could end up costing you more, both in time and money, in the long run. Problems based on choices made early in the process—for example, deciding not to have a telecine log made—could take you by surprise later.

Having professional facilities handle the tasks they specialize in, especially when you are new to the process, is highly recommended. You may actually save money by spending a little for tasks that you could do yourself, such as using an audio postproduction facility.

Also, do not underestimate the importance of using the cut list to conform a workprint before conforming the negative. While creating and editing a workprint adds costs to the project, incorrectly conforming the original camera negative will cause irreparable harm to your film.

**Which Film to Use?**

One of the first steps in any film production is choosing the film format to use. Cinema Tools’ requirements must be taken into account when making this choice.

Cinema Tools supports 4-perf 35mm and 16mm-20 film formats. See “Film Basics” on page 201 for details on these formats.

Your budget will likely determine which format you use. While it is recommended that you use the same film format throughout your production, Cinema Tools does not require it. Each database record has its own film format setting.
**Transferring Film to Video**

In order to digitally edit your film, you need to transfer it to video so that it can be captured by the computer. There are a few ways to do this, but an overriding requirement is that there be a reliable way to match the film's key numbers to the edited video's timecode. This relationship allows Cinema Tools to accurately calculate specific key numbers based on each edit's In and Out timecode values.

You also need to make decisions regarding film and video frame rates used during the transfer. These affect the editing timebase and impact the accuracy of the cut list that Cinema Tools generates.

**Telecines**

By far, the most common method of transferring film to video is to use a telecine. While a telecine provides an excellent picture, for the purposes of Cinema Tools the more important benefit is that it results in a locked relationship between the film and video, with no drifting between them.

Telecines are typically gentler on the film and offer sophisticated color correction and operational control as compared to film chains, described below. Another advantage is that telecines can create video from the original camera negative—most other methods require you to create a film positive (workprint) first. (While, from a budget viewpoint, it may be a benefit not to create a workprint, they are generally created anyway since they provide the best way to see the footage on a large screen and spot any issues that might impact which takes you use. Even more importantly, they allow you to test the cut list before working on the negative.)

In addition to providing a high-quality transfer, most modern telecines read the key numbers from the film and can access the video recorder's timecode generator, burning in these numbers on the video output. An additional benefit of the telecine transfer method is its ability to provide synchronized audio along with the video output. It can control the audio source and burn in the audio timecode along with the video timecode and the key numbers.

In most cases, telecines produce a log file that can provide the basis for the Cinema Tools database. This allows you to automate capturing the video into the computer.
Transfer Techniques That Are Not Recommended
There are a couple of transfer techniques that are worth mentioning just to point out why you should not use them.

Film Chains
It is recommended that you avoid using a film chain if at all possible. Film chains are relatively old technology, as compared to telecines. They are basically a film projector linked to a video camera. They typically do not support features such as reading the key numbers or controlling video recorders, and cannot create a positive video from a film negative. You must create a workprint to use a film chain.

Using a film chain is usually less expensive than using a telecine, although the cost of creating a workprint partly offsets the lower cost. The biggest challenge is being able to define the relationship between the film's key numbers and the video timecode. This is usually accomplished with hole punches (or some other distinct frame marker) at known film frames.

Important: Older film chains may not synchronize the film projector to the video recorder, potentially causing the film-to-video relationship to drift.

Recording a Projected Image With a Camcorder
Due to the greatly increased chances for error and the additional time you have to spend tracking key numbers, this method of transfer is strongly discouraged and should not be considered.

Projecting your film and recording the results using a video camcorder is a method that, while relatively inexpensive, almost guarantees errors in the final negative cutting. Telecines and film chains are usually able to synchronize the film and video devices, ensuring a consistent transfer at whatever frame rates you choose. The projector’s and video camcorder’s frame rates may be close to ideal, but will drift apart throughout the transfer, making it impossible to ensure a reliable relationship between the film’s key numbers and the video timecode. You will have to spend extra time going over the cut list to ensure the proper film frames are being used. Additionally, there may be substantial flicker in the video output making it difficult to see some frames and determine which to edit on.

Since the video is not actually used for anything except determining edit points, its quality doesn't matter too much. As with film chains, you have to create a workprint to project. Being able to proof your cut list before the original camera negative is worked on is very important with this type of transfer.
How Much Should You Transfer?

Deciding how much of your film to transfer to video depends on a number of issues, probably the biggest one being cost. The amount of time the telecine operator spends on the transfer determines the cost. Whether it is more efficient to transfer entire rolls of film (a “camera-roll” transfer), including bad takes and scenes that won’t be used, or to spend time locating specific takes and transferring only the useful ones (a “scene-and-take” transfer) needs to be determined before starting.

Camera-Roll Transfers

Cinema Tools uses a database to track the relationship between the film key numbers and the video and audio timecodes. The database is designed to have a record for each camera take, but this is not required. If you transfer an entire roll of film continuously to videotape, Cinema Tools only needs one record to establish the relationship between the key numbers and the video timecode. All edits using any portion of that single large clip can be accurately matched to the original camera negative’s key numbers. A drawback to this transfer method is the large file sizes, especially if there are significant chunks of footage that are not going to be used.

Additionally, because of the way it is recorded, audio is difficult to synchronize at the telecine during a camera-roll transfer. During a production, the audio recorder typically starts recording before film starts rolling, and ends after filming has stopped. You also will often shoot some film without sound (known as MOS shots). This means you cannot establish audio sync at the start of the film roll and expect it to be maintained throughout the roll. Instead, each clip needs to be synced individually. The Cinema Tools database includes provisions for tracking the original production sound reels and timecode.

Once captured, it is possible to break a single large clip into smaller ones, allowing you to delete the excess video. Even with multiple clips, it is possible for Cinema Tools to generate a complete cut list with only one database record. Another approach is to manually add additional records for each clip, allowing you to take advantage of Cinema Tools’ extensive database capabilities. See “Create the Cinema Tools database” on page 33 for a detailed discussion of these choices.
Scene-and-Take Transfers
Scene-and-take transfers are a bit more expensive than camera-roll transfers, but they offer significant advantages:
- Scene-and-take transfers make it easier to synchronize audio during the transfer.
- Since the telecine log contains one record per take, it establishes a solid database when imported into Cinema Tools.
- With an established database, Cinema Tools can export a batch capture list. With this list (and appropriate device control), Final Cut Pro can capture and digitize the appropriate takes with minimum effort on your part.

Maintaining an accurate film log and using a timecode slate can help speed the transfer process and reduce costs.

Frame Rate Basics
When transferring film to video, you need to take into account the differences in film and video frame rates. Film is shot almost exclusively at 24 frames per second (fps). Video can have either a 29.97 fps rate (NTSC), a 25 fps rate (PAL), or a 24 fps rate (24P) depending on your video standard.

The frame rate of your video (whether you sync the audio during the telecine transfer or not) and the frame rate you want to edit at, can determine what you need to do to prepare your clips for editing. You may find it useful to read “Determining How to Prepare Source Clips for Editing” on page 109 before you make any decisions about frame rates.

Working With NTSC Video
The original frame rate of NTSC video was exactly 30 fps. When color was added, the rate had to be changed slightly, to the rate of 29.97 fps. The field rate of NTSC video is 59.94. NTSC video is often referred to as having a frame rate of 30, and while the difference is not large, it cannot be ignored when transferring film to video (due to its impact on audio synchronization, explained in “Synchronizing the Audio With the Video” on page 30).

Another issue is how to distribute film’s 24 fps among NTSC video’s 30 fps. You have two options:
- perform a 3:2 pull-down
- run the film at 30 fps
Performing a 3:2 Pull-Down

The most common approach to distributing film’s 24 fps among NTSC video’s 30 fps is to perform a 3:2 pull-down (also known as a 2:3:2:3 pull-down). If you alternate recording two fields of one film frame and then three fields of the next, the 24 frames in one second of film end up filling the 30 frames in one second of video.

As shown above, the 3:2 pattern (actually a 2:3:2:3 pattern since frame A is recorded to two fields followed by frame B recorded to three fields) repeats after four film frames. Virtually all high-end commercials, movies, and non-live television shows use this process prior to being broadcast.

Note that there is not a one-to-one correspondence between film frames and video frames after this pull-down occurs. The duration of a video frame is four-fifths, the duration of a film frame. Because of this discrepancy, if you tried to match a specific number of whole video frames to some number of whole film frames, the durations would seldom match perfectly. In order to maintain overall synchronization, there is usually some fraction of a film frame that must be either added to or subtracted from the duration of the next edit. This means that in the cut list, Cinema Tools occasionally has to add or subtract a film frame from the end of a cut in order to maintain synchronization. For this reason, if you edit 3:2 pull-down video, the Cinema Tools cut list is only accurate to within +/− 1 frame on each edit. This accuracy issue is easily resolved by using the Reverse Telecine feature (or third-party hardware or software) to remove the extra fields and restore the film’s original 24 fps rate before you begin editing digitally.
To work around the inaccuracies related to editing 3:2 video, Cinema Tools includes a Reverse Telecine feature that can be used to remove the extra fields from the video, returning it to its original 24 fps rate, and thus providing a one-to-one relationship between the video and film frames. Setting Final Cut Pro’s editing timebase in the Sequence Preset Editor to 24 fps (or 23.98 fps—see “Synchronizing the Audio With the Video” on page 30) allows you to edit the video and generate a very accurate cut list. See “Determining How to Prepare Source Clips for Editing” on page 109 for more information on issues related to these options.

What’s an “A” Frame?
You will see and hear references to “A” frames whenever you are involved with 3:2 pull-down video. As the previous illustration shows, the A frame is the only one that is complete within a video frame. The others (B, C, and D frames) all appear in two video frames. Since the A frame is the start of the video five-frame pattern, it is highly desirable to have one as the first frame in all video clips. It’s common practice to have A frames at non-drop frame timecode numbers ending in “5” and “0.”

See “About “A” Frames” on page 120 for more information.

Running the Film at 30 fps
Another NTSC video transfer option is to run the film at 30 fps (actually 29.97 fps). While this leads to a one-to-one relationship between each video and film frame, the action in the film is sped up by 25 percent. Due to audio synchronization considerations, this method is not often used or recommended.

Working With PAL Video
The PAL video frame rate is exactly 25 fps. There are two methods used when transferring film to PAL: running the film at 25 fps (referred to as the 24@25 method), and adding two extra fields per second (similar to NTSC’s 3:2 pull-down, referred to as the 24&1 method).

24@25 Method
Running the film at 25 fps sets up a one-to-one relationship between the film and video frames. The drawback is that the action in the film is sped up by 4 percent, and the audio will need an identical speed increase to maintain synchronization. To take advantage of the wide variety of 25 fps video equipment available, you can choose to edit with the action 4 percent faster. Another option is to use the Cinema Tools Conform feature to change the clip’s timebase to 24 fps, correcting the speed. The video can then be edited with Final Cut Pro as long as the sequences using it have a 24 fps timebase.
24&1 Method
Adding two extra video fields per second (the 24&1 method) has the advantage of maintaining the original film speed, at the expense of losing the one-to-one film-to-video frame relationship. This method records an extra video field every twelfth film frame.

Working With 24P Video
With its frame rate, high quality, and progressive scanning, the 24P video standard is well suited for use with telecine transfers. It uses the same frame rate as film, providing a one-to-one relationship between the film and video frames without requiring a frame rate conversion.

Your Final Cut Pro system needs to be equipped with specialized hardware to capture 24P video, either as compressed or uncompressed clips. Alternatively, some DV cameras, such as the Panasonic AG-DVX100 camcorder, can shoot 24P video and use the 2:3:3:2 pull-down method to record it to tape as 29.97 fps (the NTSC standard). Using Final Cut Pro and Cinema Tools, you can capture this video and remove the 2:3:3:2 pull-down so that you can edit it at 24 fps. See “Adding and Removing Pull-Down in 24P Clips” on page 187 for more information.

Be aware that, when used as part of an NTSC system, the 24P videotape recorder’s (VTR’s) frame rate is actually 23.976 fps (referred to as 23.98 fps)—the same rate the telecine speed would be with a normal NTSC transfer.

Timecode Considerations
There are several general issues related to timecode that you should be aware of. If you’re using NTSC video, you can also choose between two timecode formats.

General Timecode Tips
When using video or audio equipment that allows you to define the timecode setting, it is recommended that you set the “hours” part of the timecode to match the tape’s reel number. This makes it much easier to recognize which reel a clip originated from. It is also strongly suggested to avoid “crossing midnight” on a tape. This happens when the timecode turns over from 23:59:59:29 to 00:00:00:00 while playing.
You have the option to use record run or free run timecode during the production:

- **With record run timecode**, the timecode generator pauses each time you stop recording. Your tape ends up with continuous timecode, since each time you start recording it picks up from where it left off.
- **With free run timecode**, the timecode generator runs continuously. Your tape ends up with a timecode break each time you start recording.

To avoid potential issues while capturing clips, it is strongly suggested that you use the record run method, and avoid noncontinuous timecode within a tape.

Whenever a tape has noncontinuous timecode (with jumps in the numbers between takes), be sure to allow enough time (**handles**) for the pre-roll and post-roll required during the capture process when logging your clips. See the Final Cut Pro documentation for additional information on timecode usage.

**About NTSC Timecode**

Normal NTSC timecode (referred to as **non-drop frame** timecode) works as you would expect—each frame uses the next available number. There are 30 frames per second, 60 seconds per minute, and 60 minutes per hour. Since NTSC’s frame rate at 29.97 fps is a little less than 30 fps, non-drop frame timecode ends up being slow (by 3 seconds and 18 frames per hour) when compared to actual elapsed time.

To compensate for this, **drop frame** timecode skips ahead by two frames each minute, except those minutes ending in “0.” (Note that it is only the numbers that are skipped—not the actual video frames.) This correction makes the timecode accurate with respect to real time, but adds confusion to the process of digital film editing.

With non-drop frame timecode, once you find an A frame, you know that the frame at that frame number and the one five away from it will always be A frames. For example, if you find an A frame at 1:23:14:15, you know that all frames ending in “5” and “0” will be A frames. With drop frame timecode, you are not able to easily establish this sort of relationship.

**Note:** It is standard practice to have A frames at non-drop frame timecode numbers ending in “5” and “0.”

It is highly recommended that you use non-drop frame timecode for both the video and audio in all film editing projects, even though both Cinema Tools and Final Cut Pro are able to use either type. Whichever you use, be sure to use the same for both the video and audio tapes.

**Note:** PAL timecode does not have this issue—it runs at a true 25 fps.
What Happens to the Timecode After Using Reverse Telecine or Conform?

The Reverse Telecine feature (changing 30 fps video to 24 fps video) and the Conform feature (changing either 25 fps or 30 fps video to 24 fps) directly affect the timecode of the video frames. Since Cinema Tools must generate new 24 fps timecode for the frames (based on the original timecode), you may see a difference between the burned-in timecode numbers and the numbers shown in Final Cut Pro. Though the timecode discrepancies between the window burn and Final Cut Pro timecodes may be confusing, Cinema Tools tracks the new timecode of the 24 fps video and is able to match it back to its original NTSC or PAL values, and thus back to the film’s key numbers.

This is what happens to the timecode: reverse telecine removes six frames per second, so the timecodes continue to match at the beginning of each second. This means that a clip that lasts for 38 seconds when played at its NTSC rate of 30 fps will still last for 38 seconds when played at the reverse telecined rate of 24 fps.

In the above illustration, the blue NTSC fields represent those that are removed during the reverse telecine process. The window burn NTSC timecode will be different from what Final Cut Pro shows for all frames except the first one of each second, regardless of the clip’s length.

Using the Conform feature to change video rates causes more timecode changes, since all the original frames are kept and you are actually changing the video's speed. A clip that plays for 38 seconds at its PAL rate of 25 fps will play for almost 40 seconds at the conform rate of 24 fps. After the first 24 frames, each frame that follows will have a different timecode number as compared to the timecode of the 25 fps video.
In the above illustration, the burned-in (original) PAL timecode matches the conformed timecode shown in Final Cut Pro for the first 24 frames, but then differs for all frames after that, moving farther apart the longer the clip is.

As confusing as all this sounds, remember that in both cases Cinema Tools tracks the new timecode of the 24 fps video and is able to match it back to its original NTSC or PAL values, and thus back to the film’s key numbers.

**Sound Considerations**

Since the sound for a film is recorded separately on an audio recorder, there are a number of issues that you must be aware of and plan for:

- what type of audio recorder to use
- what timecode to use
- how to mix the final audio
- how to synchronize the audio with the video

**Choosing an Audio Recorder**

When choosing an audio recorder, you have several options: an analog tape recorder (typically a Nagra), a digital tape recorder (DAT—Digital Audio Tape), or a digital disc recorder. Whether analog or digital, be sure the recorder has timecode capability.

**Choosing an Audio Timecode**

Unlike video or film, which must be structured with a specific frame rate, audio is linear with no physical frame boundaries. Adding timecode to audio is simply a way to identify points in time, making it easier to match the audio to video or film frames.

During the shoot, you have the choice of which audio timecode standard to use (typically 30 fps, 29.97 fps, 25 fps, or 24 fps). You also have the choice, with 30 fps and 29.97 fps, of using drop frame or non-drop frame timecode. For NTSC transfers, it is highly recommended that you use non-drop frame timecode for both the video and audio (although Cinema Tools can work with either). See “About NTSC Timecode” on page 26 for more information on drop frame and non-drop frame timecode.
A consideration for the audio timecode setting is how the final audio will be mixed:

- **If the final mix is to be completed using Final Cut Pro**, the setting needs to match the Final Cut Pro Editing Timebase setting in the Sequence Preset Editor.
- **If the final mix is to be completed at an audio postproduction facility**, the timecode needs to be compatible with their equipment.

**Note:** Be sure to consult with the facility and make this determination before the shoot begins.

In general, if you are syncing the audio during the telecine transfer, the timecode should match the video standard (29.97 fps for NTSC, 25 fps for PAL, or 24 for 24P). Check with your sound editor before you shoot to make sure they are comfortable with your choice.

**Mixing the Final Audio**

The way you mix the final audio depends on how complicated the soundtrack is (multiple tracks, sound effects, and overdubbing all add to its complexity), and your budget. You can either finish the audio with Final Cut Pro or have it finished at a postproduction facility.

**Finishing the Audio With Final Cut Pro**

If you capture high-quality audio clips, you can finish the audio for your project with Final Cut Pro, which includes sophisticated sound editing tools. Keep in mind, however, that good audio is crucial to a good film, and a decision not to put your audio in the hands of a audio postproduction facility familiar with the issues of creating audio for film might lead to disappointing results.

You can export the audio from Final Cut Pro as an OMF (Open Media Framework) file for use at an audio postproduction facility. An exported OMF file contains not only the information about audio In and Out points, but also the audio itself. This means that, for example, any sound effects clips you may have added are included. When you use an OMF file, the recording quality must be as high in quality as possible, as this is what the audience will hear. Be sure to use a good capture device and observe proper recording levels.

**Exporting Audio EDLs**

Another approach is to use lower–quality clips in Final Cut Pro and then export an audio Edit Decision List (EDL) for use at an audio postproduction facility. There they can capture high-quality versions of the audio clips straight from the original production sound source and edit them based on the audio EDL. For this to work, the timecode and reel numbers of the original sound tapes must be kept track of and used to create the audio EDL.
Audio clips captured as part of video clips do not retain their original timecode and reel number, and the Final Cut Pro EDL cannot be used by an audio postproduction facility. This is most common with clips created from scene-and-take transfers, where the audio is synchronized to the film and recorded onto the videotape, losing the original audio timecode. But because the telecine log from the transfer generally contains timecode and reel number information for both the video and audio, importing this log into the Cinema Tools database allows the database to track audio usage, and you can export an audio EDL from Cinema Tools once you finish editing.

See “Exporting an Audio EDL” on page 161 for details on the process.

Synchronizing the Audio With the Video
The production sound for a film is recorded separately on an audio recorder; this is known as the double (or dual) system method. Synchronizing the sound with the film and video, ensuring good lip-sync, is a critical step in making a movie. How you synchronize depends on the equipment used and when syncing is done. There are also considerations related to your video standard, how the telecine transfer was done, and the timecode used that directly impact the process.

There are three times when audio synchronization is important:
• during the telecine transfer
• during editing
• while creating the release print

Different strategies may be required to maintain sync at each of these times. Make sure you have planned accordingly.

Synchronization Basics
Synchronizing the audio with the video image can be fairly easy as long as some care was taken during the shoot. There are two aspects to synchronizing your audio: establishing sync at a particular point in each clip, and playing the audio at the correct speed so that it stays in sync.

While shooting, you must provide visible and audible cues to sync on. The most common method is to use a clapper board (also called a slate or sticks) at the beginning of each take. Even better, you can use a timecode slate that displays the audio recorder’s timecode. To sync the audio with the video, position the video at the first frame where the slate is closed, then locate the sound (or timecode) of the related audio. Note that production requirements occasionally require the slate to occur at the end of the take, generally with the slate held upside-down.
Since the film is often either slightly sped up or slowed down during the telecine transfer, the audio must also have its speed changed. If the audio is being synced during the transfer, the speed change is handled there. If the audio is being synced to the videotape after the transfer, the speed change must happen then.

**Synchronizing During the Telecine Transfer**

During the shoot, you typically start the audio recorder a little before the camera rolls, and stop it a little after the camera stops. Since you end up recording more audio than film, you cannot play the audio tape and the film through several takes and have them stay in sync. If you want the telecine transfer to record synchronized audio on the videotape, you must either use the scene-and-take transfer method, synchronizing each take on its own, or create a synced audio reel before performing a camera-roll transfer.

A large benefit to synchronizing during the telecine transfer, aside from having videotapes with synchronized audio ready to be captured, is that the telecine log usually includes the audio timecode and reel number information. Importing the log into Cinema Tools makes it possible to export an audio EDL so that an audio postproduction facility can recapture the audio clips at a higher quality later, if needed.

**NTSC Transfers**

When transferring film to NTSC video, it is always necessary to run the film 0.1 percent slower than 24 fps (23.976 fps, typically referred to as 23.98 fps) to compensate for NTSC video’s actual frame rate of 29.97 fps (instead of an ideal 30 fps). Since the film has been slowed down, audio too must be slowed to maintain sync.

**PAL Transfers**

PAL transfers using the 24@25 method (speeding up the film to 25 fps) require that the audio also be sped up if you are syncing the audio during the telecine transfer or if you intend to edit the video at this rate.

If you are transferring the film to video using the 24&1 method (recording an extra video field every twelfth film frame) you should run the audio at its normal speed regardless of where sync is established. Use 25 fps timecode for the audio in this case.

**Synchronizing in Final Cut Pro**

If you don’t synchronize your sound and picture onto tape via the telecine transfer, they are captured into Final Cut Pro as separate audio and video clips. You can then synchronize them in Final Cut Pro, using the clapper board shots, as mentioned in “Synchronization Basics” on page 30. Once you synchronize two or more clips, you can link them together as one clip, using Final Cut Pro’s merged clips feature. See “Synchronizing Separately Captured Audio and Video” on page 123, and the Final Cut Pro documentation, for more information.
Working in Final Cut Pro

Decisions you make regarding the telecine transfer and how you work with audio affect how you use Final Cut Pro during the editing process.

Setting the Editing Timebase for Sequences

In Final Cut Pro you must set the editing timebase for sequences to match the frame rate of the captured clips.

Important: Do not place clips into a sequence if the clips and sequence have different frame rates. If you do, the resulting film list is likely to be inaccurate. For example, if you want to edit at 24 fps, make sure your clips’ frame rates are all set at 24 fps (either by using the Reverse Telecine or Conform features).

See the Final Cut Pro documentation for details on setting the editing timebase for sequences.

Outputting to Videotape When Editing at 24 fps

One of the benefits of editing at 24 fps is that you get a one-to-one relationship between the film and video frames, allowing for very accurate cut lists. A drawback is that you need a 24P VTR to directly record video as 24 fps—you cannot easily record the video on standard NTSC or PAL video equipment. This can be a problem if you want to record a videotape of the edited project, either to show others or to give the negative cutter a visual reference to use along with the cut list, but there are solutions:

- If you’re working with NTSC video, you can use the pull-down insertion feature in Final Cut Pro to apply a pull-down pattern to the video, thus outputting it at 29.97 fps. See “Pull-Down Patterns You Can Apply to 23.98 fps Video” on page 194 for details. There are also third-party cards and applications that can perform a 3:2 pull-down on the video, allowing it to run at the NTSC 29.97 fps rate.

- If you’re working with PAL video, and you know that you will want to record a videotape when finished, it’s easiest to edit at 25 fps (with the film having been sped up to maintain the one-to-one relationship).

Using Effects

Final Cut Pro provides extensive effects capabilities, including common film effects such as dissolves, wipes, speed changes, and text credits. Keep in mind that the video output of Final Cut Pro is not intended to be transferred to film, and these effects must be created by a facility specializing in opticals, or created digitally using high-resolution scans of footage to be composited. See “Using Effects and Transitions” on page 128 for more information, including an outline of the basic workflow for including effects and transitions in your digitally edited film.
The Cinema Tools Workflow

Cinema Tools fits easily into a film editing workflow.

The primary purpose of Cinema Tools is to create an accurate cut list based on edits made in Final Cut Pro. There are a few critical steps that are necessary for this to happen, but for the most part, the actual Cinema Tools workflow depends on the equipment you use, your video standard, and how you like to work.

**Basic Workflow Steps**

The typical Cinema Tools workflow looks like this:

1. Create the Cinema Tools database.
2. Capture the source clips with Final Cut Pro.
3. Connect the clips to the database.
4. Prepare the clips for editing.
5. Edit the clips in Final Cut Pro.
6. Create cut lists and other lists with Cinema Tools.

**Step 1: Create the Cinema Tools database**

The heart of Cinema Tools is its database, where the relationships between the elements of your movie (the film, video, and sound) are established and tracked. While there is no actual requirement that the database be created prior to editing, it can provide some useful tools to help with capturing clips and planning the edit.

**How the Database Works**

The database can contain one record or thousands of records, depending on how you decide to use Cinema Tools. These records are matched to the edits made in Final Cut Pro so that the cut list can be created. To be valid, a record must have values for the camera, daily, or lab roll, the edge code, and either have a clip connected to it or have video reel and video timecode (In point and duration) values.
When you export the cut list after editing the video in Final Cut Pro, Cinema Tools looks at each edit and tries to find the appropriate record in its database to determine the corresponding key numbers or ink numbers (edge code). Cinema Tools first looks for a record connected to the clip name used in the edit. If it is found, it then locates the clip file, a note is added to the cut list, and Cinema Tools moves on to the next edit.

If no record is found using an edit’s clip name, or the clip is not located, Cinema Tools looks at the video reel number to see if any of its records have the same number (001 is not the same as 0001). If so, it then looks to see if the edit’s In and Out points fall within the range of one of the records. If this condition is also met, the edit is added to the cut list, and Cinema Tools moves on to the next edit.

If a record cannot be found that uses an edit’s clip pathname or video reel number with suitable timecode records, “<missing >” appears in the cut list and a note is added to the missing elements list. If a record is found but is incomplete (missing the key number, for example), “<missing >” is placed in those fields and a note is added to the missing elements list.


A Detailed or Simple Database?
Cinema Tools’ design allows you to create a record for an entire camera roll, for each take, or somewhere in between, depending on how you like to work. Each record can contain

- scene, shot, and take numbers with descriptions
- the film’s camera roll number, edge code, and related video timecode and reel number
- the audio timecode and reel number
- a clip poster frame showing a representative frame from the clip
- basic settings such as film and timecode format

The records can be entered manually or imported from a telecine log. You can modify, delete, and add records to the database as required, even if it is based on the telecine log. You can also merge databases. For example, if you are working with dailies, you can create a new database for each session and merge them all together once the shoot is complete.

The telecine log from scene-and-take transfers, where only specified film takes are transferred to video, can provide the basic information for the database. You can add additional records, comments, and other information as needed.
The telecine log from camera-roll transfers typically provides information for a single record—the edge code and video timecode used at the start of the transfer. Assuming continuous film key numbers and video timecode throughout the transfer, that single record is sufficient for Cinema Tools to generate a cut list for that camera roll.

Importing Telecine Logs

You have a choice of importing the telecine log into Cinema Tools or using Final Cut Pro. You can choose either method according to your workflow.

The telecine logs that are supported by Cinema Tools are: ALE, FTL, FLX, and ATN.

If you import the telecine log into Cinema Tools via Final Cut Pro, offline clips from the telecine log are imported directly into Final Cut Pro.

To import a Cinema Tools telecine log via Final Cut Pro, do the following:

1. In Final Cut Pro, choose File > Import > Cinema Tools Telecine Log.
   The “Cinema Tools Import a Telecine Log” dialog then opens. Within the dialog is a field which displays the pathname of the database that will be used to import the log. You can change that pathname by clicking either the New Database or the Choose Database button.

2. Click the Choose Database button to select an existing database or click the New Database button to create a new one.
   If you click the New Database button, a second dialog launches to name and choose film format options for the new database. If you click Choose Database, a second dialog allows you to select an existing database.
   You can import the telecine log with the “add a camera letter” feature, if applicable. Just choose the appropriate letter from the pop up menu in the “Cinema Tools Import a Telecine Log” dialog before you choose the log.

3. In the “Cinema Tools Import a Telecine Log” dialog, select the telecine log you want to import, and then click Choose.
   A list of off-line clips appears in Final Cut Pro, ready for batch capturing.

To import a telecine log using Cinema Tools, do the following:

1. If you are not working with an existing database, choose Database > New Database (or type Shift + Command + N). Name the database in the dialog that appears.

2. Choose File > Import > Telecine Log (or type Command + L).
   Cinema Tools imports the log, and then places the clip information into the database.
   Note: If you are working from an existing database that is already open, skip the first step.

In Cinema Tools you can export a file that will create a list of offline clips for batch capturing in Final Cut Pro. Export either a standard batch list or an XML Batch List. XML contains additional information, such as film metadata, that is viewable in Final Cut Pro.
To export a list of offline clips for batch capturing in Final Cut Pro, do one of the following:

- In Cinema Tools, choose File > Export > XML Batch List.
- An XML batch capture list is exported. Import the batch list into Final Cut Pro to create offline clips for batch capturing.
- In Cinema Tools, choose File > Export > Batch Capture
- A standard batch capture list is exported. Import the batch list into Final Cut Pro to create offline clips for batch capturing.

To import a standard or XML batch list into Final Cut Pro, do one of the following:

- If you exported an XML batch list, choose File > Import > XML.

Offline clips are imported into Final Cut Pro. These clips will correspond with the database records.

- If you exported a standard batch list, choose File > Import > Batch List.

Offline clips are imported into Final Cut Pro. These clips will also correspond with the database records.

For more information about importing telecine logs and Final Cut Pro or Cinema Tools, see the document, "New Features in Cinema Tools."

Manually Entering Database Records

The most common reason to manually enter a record into the database is that there is no log available from the film-to-video transfer process. Some film-to-video transfer methods, such as film chains, do not provide logs.

You need a record for every clip that has noncontinuous timecode or key numbers. With scene-and-take transfers, each take requires its own record since film key numbers are skipped when jumping from take to take during the transfer.

With camera-roll transfers, since the film roll and video recorder run continuously from start to finish, you only require one record for the entire clip, even if you later break it into smaller clips (that retain the original timecode) and delete the unused portions. This is because Cinema Tools can use an edit’s video reel number and edit points to calculate the appropriate key numbers, as long as they are part of a record.

To manually enter database records, you need to know the key number and video timecode for a frame of the clip. This is easiest when the transfer has these values burned in to the video.

See Chapter 4, "Creating and Using a Cinema Tools Database," on page 61 for details on creating and managing Cinema Tools databases.
Step 2: Capture the source clips
You must capture the video and audio on your editing computer. How you do this depends in large part on the actual media used for the telecine transfer.

If you used an analog VTR, such as a Sony Betacam, the video and audio must be converted to digital format and compressed before they can be used. If you used a digital VTR, such as a Sony Digital Betacam, the video and audio are already digital, but must still be captured and compressed. In both cases, specialized hardware with the appropriate connections is usually required.

If you used a DV system, the video (and audio, depending on the transfer type) is already digital and compressed, and simply needs to be captured using FireWire.

*Important:* When using serial device control, be sure to calibrate its capture offset. See the Final Cut Pro documentation for more information. Also see “Setting Up Your Hardware to Capture Accurate Timecode” on page 97 for more information on capturing your clips.

In either case, you may decide to recompress the files to make them smaller and easier to work with. For example, taking advantage of the correct codec may allow you to edit on an older portable computer.
Capturing Tactics
There are several approaches to capturing your video and audio. Determining which is right for you depends on a number of factors, including whether you have device control of the source tape deck and the transfer type used (camera-roll or scene-and-take).

Device Control
A primary consideration when determining how to capture video and audio is whether Final Cut Pro supports device control for the deck you use. Device control allows you to capture precisely the video and audio you want in a way that can be exactly repeated, if necessary. You can even set up a “batch capture” that automates the process, freeing you to do other tasks.

Capturing without device control presents several challenges. Clips that are captured manually do not have precise start and end times. If you intend to match start and end times from a telecine log, you must trim the clips after capturing them. Additionally, without device control, a clip’s timecode does not match the timecode on the tape. Final Cut Pro has a provision for changing a clip’s timecode, but in order for that timecode to match the source tape you must have a visual reference (hole-punched or marked frame) with a known timecode.

For more information on device control, see the Final Cut Pro documentation.

About Compression
Compression, in terms of digital video, is a means of squeezing the content into smaller files so that they require less hard disk space and potentially less processor power to display. The tradeoff is lower quality images.

It’s important to remember that the edited video that results from Final Cut Pro when used with Cinema Tools is not typically going to be used for anything where high quality would be expected. The most common use of the edited video is to give the negative cutter a visual guide to go along with the cut list. This means that the quality of the video only needs to be good enough to make your edit decisions and read the window burn values. However, because your edit decisions are sometimes based on subtle visual cues, it’s best not to get too carried away with excess compression.
Camera-Roll Transfers
Camera-roll transfers require you either to capture the entire tape or to manually capture a clip for each take. As long as the tape uses continuous video timecode and film key numbers, Cinema Tools only requires a single database record showing the relationship between the two.

If Final Cut Pro has device control of your source deck, the best method for capturing the desired takes is to use its Log and Capture window and enter the In and Out points and reel number for each. You can then use batch capture to finish the process. It’s not necessary to create a database record for each clip, as long as you do not change the timecode.

Without device control, you must manually capture either the desired takes or the entire tape. For each take you capture manually, you may need to trim it and you will also have to manually set its timecode to match the source tape. An advantage to capturing the entire tape is that you only have to set the clip’s timecode once (assuming that the source tape had continuous timecode). The drawback is the amount of disk space required, although once captured, you can use Final Cut Pro to create subclips of the useful takes, then delete the unused material.


Scene-and-Take Transfers
Scene-and-take transfers generally result in the Cinema Tools database having records suitable for performing a batch capture. You can export a capture list from Cinema Tools and import it into Final Cut Pro’s Browser. Final Cut Pro can then perform a batch capture (assuming it can control the source device), creating clips as directed by the Cinema Tools list. These clips can then be easily linked to records in the Cinema Tools database.

Step 3: Connect the clips to the database
Once you have captured the source clips, you can connect them to the Cinema Tools database (also known as linking the clips the database). Connecting a clip to the database gives Cinema Tools the ability to access a record’s clip while creating the cut list, reducing the chance of timecode entry problems.

When creating a cut list, Cinema Tools starts by looking at the clip pathname used in the edit and matching it back to its database. Being able to work with the clip file in this way reduces the chances of a timecode error which can cause inaccurate records in the cut list. This is especially important when editing at 24 fps. See Appendix B, “How Cinema Tools Creates Film Lists,” on page 213 for more information on how Cinema Tools generates a cut list. Also see “Connecting Captured Source Clips to the Database” on page 102 for more information.
Step 4: Prepare the clips for editing (processing the clips)
Cinema Tools has two powerful features that can be used on your clips prior to editing them: the Reverse Telecine feature and the Conform feature.

Reverse Telecine
The Reverse Telecine feature (for NTSC transfers only) provides a means of removing the extra fields added during the 3:2 pull-down process of the telecine transfer. You need to do this when you intend to edit the video at 24 fps. See “Frame Rate Basics” on page 22 for information on what a 3:2 pull-down is and why you might want to reverse it. See “Reversing the Telecine Pull-Down” on page 113 for details on its use.

Conform
The Conform feature is useful both to correct errors in video clips and to change the frame rate (timebase) of a clip. Cinema Tools lets you select the frame rate you want to conform a clip to.

In order to understand the Conform feature, you need to know a bit about the nature of QuickTime video files. Each video frame within a QuickTime file has a duration setting that defines the length of time that a particular frame is displayed (normal NTSC or PAL-based QuickTime video has the same duration assigned to all frames). For example, the NTSC video rate has a value of 1/30 of a second (actually 1/29.97 of a second) assigned to each frame. The PAL video rate is 1/25 of a second.

Occasionally when capturing video clips, the duration of some frames is set to slightly different values. While the differences are not visible when playing the clip, they can cause problems when Cinema Tools creates the cut list or if you use the Reverse Telecine feature on it. In these cases, you would conform the clip to its current frame rate.

There are also times when you may want to change the frame rate of a clip. If you transferred 24 fps film to video by speeding it up (either to 30 fps for NTSC or to 25 fps for PAL—in each case ensuring a one-to-one relationship between the film and video frames), the action during playback will be faster than the original film, and the audio will need to have its playback speed adjusted to compensate. You can use the Conform feature to change the clip’s frame rate to 24 fps, making it play back at the original film rate and stay in sync with the audio. See “Using the Conform Feature” on page 111 for details on using the Conform feature.

Note: Be sure to use the Conform feature on a clip before editing it in Final Cut Pro. Also be sure the editing timebase in Final Cut Pro’s Sequence Preset Editor is set at the same rate you are conforming to.

See “Determining How to Prepare Source Clips for Editing” on page 109 for more information.
Step 5: Edit the clips in Final Cut Pro
You edit the clips in Final Cut Pro much as you would any video project, but there are a few important things to keep in mind. These considerations are described in Chapter 7, “Editing,” on page 127.

Step 6: Generate film lists and change lists with Cinema Tools
Once you have edited your clips and are satisfied with your digitally edited project, you are ready to use the Cinema Tools Film Lists dialog to generate film-related lists that describe how to cut the negative or workprint. The cut list provides a list of the edits and of titling information.

There are a number of other useful lists that can be generated at the same time. One film list file can contain any of the following:

- **missing elements list:** A list of any required information that could not be found in the database
- **dupe list:** A list of duplicate usages of the same source material
- **optical list:** A list for the effects printer, describing any transitions and motion effects
- **pull list:** A list to aid the lab in pulling the negative rolls they need
- **scene list:** A list of all the scenes used in your program and the shots used in the opticals

You can also export a change list, useful if your production process involves workprint screenings and modifications. The change list assumes a workprint has been cut to the specifications of a cut list (or prior change list) and it specifies further changes to make to the workprint, based on edits you have made to the sequence in Final Cut Pro. See “When Are Change Lists Used?” on page 152 for a flow chart of the workprint and change list process.

See Chapter 8, “Generating Film Lists and Change Lists,” on page 137 for more details on all the film-related lists that are available.

**Cinema Tools Workflow Examples**
This section details several Cinema Tools database workflow scenarios. Keep in mind that there are many variations to these, and you often do not have to follow the steps exactly in order. It’s also possible to have a situation that uses parts of several workflows. See “Basic Workflow Steps” on page 33 for details on specific steps.

The workflows are divided into two groups—those that use scene-and-take transfers and those that use camera-roll transfers. These are further divided depending on whether a telecine log is available and whether device control of your video player is available during the capture process.
If You Used Scene-and-Take Transfers

Since scene-and-take transfers require a database record for each take (due to noncontinuous key numbers), an important first decision is based on whether or not a telecine log is available.

Workflow for a Scene-and-Take Transfer With a Telecine Log

![Workflow Diagram]

1. Start a new database
2. Import telecine log into database
3. Device control?
   - Yes: Generate batch capture list with Cinema Tools
   - No: Key number burned in?
     - Yes: Use Final Cut Pro to manually capture each clip
     - No: Use Final Cut Pro to manually capture each clip
4. Import batch list into Final Cut Pro Browser and do a batch capture
5. Use the Cinema Tools Connect Clips command to connect clips to database
6. Trim clips to match database records
7. Connect clips to database

Indicates steps that use automated processes.

The blue boxes show the preferred workflow, which contains the most automated steps and produces the most accurate cut list.
Workflow for a Scene-and-Take Transfer Without a Telecine Log

If You Used Camera-Roll Transfers

The primary consideration when using camera-roll transfers is the film list generation method you intend to use. See Appendix B, "How Cinema Tools Creates Film Lists," on page 213 for an explanation of the two available methods. It is strongly suggested that you sync the audio to the video before you capture the clips.
Workflow for a Camera-Roll Transfer (Clip-Based Method)

1. **Start a new database**

2. **Telecine log?**
   - **Yes**
     - Import log into database (should generate one record per camera roll)
   - **No**
     - Enter at least one record for each camera roll, defining key number and timecode relationship

3. **Optional:** Enter additional records, one for each clip (recommended when you have device control)

4. **Device control?**
   - **Yes**
     - Generate batch capture list with Cinema Tools
     - Import batch list into Final Cut Pro Browser and do a batch capture
     - Use the Cinema Tools Connect Clips command to connect clips to database
   - **No**
     - Key number burned in?
       - **Yes**
         - Use Final Cut Pro to manually capture each clip
         - Trim clips to match database records
         - Connect clips to database
       - **No**
         - Use Final Cut Pro to manually capture each clip
         - Connect clips to database

*Indicates steps that use automated processes.

The blue boxes show the preferred workflow, which contains the most automated steps and produces the most accurate cut list.
Workflow for a Camera-Roll Transfer (Timecode-Based Method)

1. Start a new database
2. Telecine log?
   - Yes: Import log into database (should generate one record per camera roll)
   - No: Enter at least one record, defining key number and timecode relationship
3. Use Final Cut Pro to capture entire camera roll as a single clip or to capture desired takes as separate clips (Make sure the timecode does not change from the original)
The Cinema Tools Interface

Cinema Tools uses a variety of windows and dialogs to access its powerful features.

There are a number of windows and dialogs in Cinema Tools. Some are generic, such as file selection dialogs, while others are specialized with unique functions and settings. Most of the windows and dialogs are opened from within Cinema Tools; three related dialogs also open via Final Cut Pro.

Cinema Tools Windows and Dialogs
The following windows and dialogs open from within Cinema Tools.

New Database Dialog
You use the New Database dialog to set basic database settings whenever you create a new Cinema Tools database. These settings apply to any new database records you create. You can alter these settings in individual database records using the Detail View window.

To open the New Database dialog, do one of the following:
- Choose Database > New Database.
- Press Command-Shift-N.

Note: You cannot start a new database if one is currently open.

For information on choosing the default settings for your database, see “Settings in the New Database Dialog” on page 67.
**Detail View Window**

You use the Detail View window to view, enter, and change information in a database record. When you open an existing database, the Detail View window displays the first record. The specific numbers in the Detail View window (reels, rolls, and key and ink numbers) all describe values for the first frame of the source clip associated with the database record.

The Detail View window appears along with the List View window whenever you open a database.

**To view the Detail View window, do one of the following:**
- If necessary, drag the List View window to a different screen position.
- If necessary, click the Detail View window to bring it to the front, or press Command-2.
- Choose Window > Detail View.
Clicking the following buttons opens additional windows and dialogs:

- **Find:** Click the Find button to open the Find dialog.
- **Open Clip:** The Open Clip button (as shown above) changes depending on whether a clip is connected to the record. With a clip connected (as above), the button is labeled Open Clip. Click Open Clip to open the Clip window, which displays the connected clip.
- **Connect Clip:** If there is no clip connected to the database record, the Open Clip button is labeled Connect Clip. Click the Connect Clip button to open a file selection dialog. Once you locate and select the clip file, the Clip window opens to display it.

For more information on using the Detail View window, see “Entering Database Information Manually” on page 73.

**List View Window**

The List View window displays a list of database records in the open database. The List View and Detail View windows appear whenever you open a database.

To view the List View window, do one of the following:

- Drag the Detail View window to a different screen position.
- Click the List View window to bring it to the front, or press Command-1.
- Choose Window > List View.

The pop-up menu at the bottom of the window lets you choose the display mode, selecting the type of information to view:

- **Keycode:** Displays information about the film, including key numbers and rolls.
- **Video:** Displays timecode and reel information about the video.
- **Sound:** Displays timecode and reel information about the sound.
- **Ink Numbers:** Displays information about the workprint, including ink numbers and daily rolls.
Display Mode Columns
The following columns appear in all display modes:
- **Slate**: A combination of the Scene and Take fields, separated by a hyphen
- **Clip**: The name of the clip connected to each database record

The following columns appear in the Keycode display mode:
- **Lab Roll**: The value entered in the Lab Roll field (in the Detail View window)
- **Cam Roll**: The value entered in the Cam Roll field
- **Keycode**: The value entered in the Key field

The following columns appear in the Video display mode:
- **Reel**: The value entered in the Video Reel field
- **Timecode**: The value entered in the Video Timecode field

The following columns appear in the Sound display mode:
- **Roll**: The value entered in the Sound Roll field
- **Timecode**: The value entered in the Sound Timecode field

The following columns appear in the Ink Number display mode:
- **Daily Roll**: The value entered in the Daily Roll field
- **Ink Number**: The value entered in the Ink field

Sorting the Columns
By default, the columns are sorted by the Slate value, in ascending order. You can sort the data based on any displayed column by clicking the column's name. The name changes color to indicate it is controlling the sort, and an arrow appears to show the sort direction. An arrow pointing up indicates an ascending sort order, and an arrow pointing down indicates a descending order. Click the column's name to change the sort direction.

Locating records with missing items
Sorting the columns can make it easy to locate records with missing items. For example, selecting the Cam Roll column groups together all records without an entry in that field and places them at the top or bottom of the list, depending on the arrow's direction.

Finding specific records
You can locate a record using a specific key number or timecode by sorting the columns. For example, selecting the Keycode column puts the records in order based on their key numbers. You can then scroll through the list and locate a record using a specific film frame.
Selecting Records
To select a database record, do one of the following:

- Click any displayed record.
- Use the keyboard’s Up or Left Arrow key to select the record before the currently selected one.
- Use the keyboard’s Down or Right Arrow key to select the record after the currently selected one.
- Use the keyboard’s Home key to jump to the first database record.
- Use the keyboard’s End key to jump to the last database record.

Once you have selected a record, it stays selected as you change the display modes.

Changing the Displayed Data
You cannot change the settings in any of the records in the List View window. Use the Detail View window to make changes.

To display a record in the List View window in the Detail View window, do one of the following:

- Double-click the record.
- Select the record using the keyboard’s arrow keys, then press Return.

Find Dialog
You can select specific records to view in the List View window by creating a “found set.” For example, you can create a list of all records relating to a certain scene. You do this by using the Find dialog.

To open the Find dialog, do one of the following:

- Click Find in the Detail View window.
- Choose Database > Find.
- Press Command-F.

See “Finding and Opening Database Records” on page 91 for details on creating found sets.
Clip Window
You use the Clip window to play the selected clip, identify the timecode and key number of a specific frame, view general information about the clip, and process it with the Reverse Telecine and Conform features.

To open the Clip window, do one of the following:
- Click Open Clip in the Detail View window (if a clip is connected to the current record).
- Click Connect Clip in the Detail View window, then select a clip (if one has not already been connected to the record).
- Choose File > Open Clip, locate a clip, then click Choose.

Note: You can have multiple Clip windows open at one time. They are dynamically added to and removed from the Window menu as you open and close them. Check the Window menu for keyboard shortcuts that make open Clip windows active.

Most of the buttons along the right side of the window open additional dialogs:
- **Rev Telecine**: Opens the Reverse Telecine dialog.
- **Disconnect**: The Disconnect button (as shown above) changes depending on whether this clip is connected to the database. With a clip connected (as above), the button is labeled Disconnect. Click Disconnect to disconnect the clip from the database.
- **Enter in DB**: If this clip is not connected to the database, the Disconnect button is labeled Enter in DB. Click Enter in DB to open a dialog where you can select the scene and take to connect the clip to.
- **Poster Frame**: Assigns the currently displayed frame to the Detail View window’s thumbnail display.
- **Conform**: Opens the Conform Clip dialog.
- **Identify**: Opens the Identify window.
- **Clip Analysis**: Opens the Clip Analysis dialog.

**Reverse Telecine Dialog**

You use the Reverse Telecine dialog to convert NTSC 3:2 pull-down video or 2:3:3:2 pul-down video to 24 frames per second (fps).

**To open the Reverse Telecine dialog, do one of the following:**
- Click Rev Telecine in the Clip window.
- Choose Clip > Reverse Telecine (available only when the Clip window is open).

![Reverse Telecine Dialog](image)

See “Reversing the Telecine Pull-Down” on page 113 for details on using this function. There is also a simplified form of the Reverse Telecine dialog that appears if the clip or clips were captured from a DV camcorder that shoots 24P, such as the Panasonic AG-DVX100 camcorder. These clips have the pull-down cadence (pattern) information embedded in a way that Cinema Tools can read, so if it detects this cadence information, the automated reverse telecine dialog appears. See “Removing 2:3:3:2 or 2:3:2:3 Pull-Down With Cinema Tools” on page 190 for details.
**Conform Clip Dialog**

You use the Conform Clip dialog to set the duration of each frame of the current clip to a specified time. For example, choose 24.0 to set each frame’s duration to 1/24 of a second. You do this to change the frame rate of a captured clip or to ensure a clip’s frame rate is accurate and consistent throughout the clip.

To open the Conform Clip dialog, do one of the following:
- Click Conform in the Clip window.
- Choose Clip > Conform (available only when the Clip window is open).

See “Using the Conform Feature” on page 111 for details on using this function.

**Identify Window**

You use the Identify window to enter film and timecode information in the database or to get information about the frame that is currently displayed in the Clip window.

To open the Identify window, do one of the following:
- Click Identify in the Clip window.
- Choose Clip > Identify (available only when the Clip window is open).

If the Identify window is open, but not active because it is behind other windows, you can bring it forward by pressing Command-3.
Some features of this window:

- It updates to show the information of each frame as you move through a clip.
- The prior position of the Identify window on the screen is retained when it is reopened.
- When multiple Clip windows are opened, the Identity window reflects the frame information of the active window, updating as each window becomes active.

See “Using the Identify Feature to Enter and Calculate Database Information” on page 82 for details on using the Identify window.

**Clip Analysis Dialog**

The Clip Analysis dialog displays detailed information regarding the current clip. This information includes both file specifics (name and size, where it is located, and when it was created) and content specifics (duration, frame rate, frame size, and compression type used).

To open the Clip Analysis dialog, do one of the following:

- Click Clip Analysis in the Clip window.
- Choose Clip > Clip Analysis (available only when the Clip window is open).

**Change Reel Dialog**

The Change Reel dialog lets you make global changes to the video reel, sound roll, camera roll, or lab roll settings in the database records. For example, you may find that the number of leading zeros is different (001 versus 0001) between the video reel numbers of Final Cut Pro and those you entered in the Cinema Tools database. This dialog allows you to change all occurrences of a reel or roll number.
To open the Change Reel dialog:
- Choose Database > Change Reel.

Database Properties Dialog
The Database Properties dialog displays a wide variety of information about the current database, including its default settings and statistics about the records.

To open the Database Properties dialog, do one of the following:
- Choose Database > Database Properties.
- Press Command-I.

Dialogs in Final Cut Pro and Cinema Tools
The following list dialogs open from within Final Cut Pro and Cinema Tools.

Film Lists Dialog
You use the Film Lists dialog to define the type of information and lists to export, the most important being the cut list. Typically you use this dialog once you have finished editing the film's clips; however you can use it anytime you want to get a status of the edit.
To open the Film Lists dialog from within Final Cut Pro:
- In Final Cut Pro, choose File > Export > Cinema Tools Film Lists. (This command is available only when the Final Cut Pro Timeline is active, or when a sequence is selected in the Browser.)

To open the Film Lists dialog from within Cinema Tools:
- In Cinema Tools, choose File > Export > Film lists from 30 fps EDL. (The actual fps value is based on the frame rate of the last database opened in Cinema Tools, and must match the EDL’s frame rate.)

See Chapter 8, “Generating Film Lists and Change Lists,” on page 137 for details on this dialog’s settings.

See Chapter 10, “Working With External EDLs and ALE Files,” on page 167 for details on generating film lists from outside EDLs.

Change List Dialogs
You use the Change List dialog to make selections for exporting a list that describes the difference between two different versions of a sequence edited in Final Cut Pro. You can include a change pull list, which lists only the film that needs to be pulled in order to make the changes.
To open the Change List dialog from within Final Cut Pro:

- In Final Cut Pro, choose File > Export > Cinema Tools Change List. (This command is available only when the Final Cut Pro Timeline is active, or when a sequence is selected in the Browser.)

When you export a change list file from Final Cut Pro, you can also export a new cut list (and all the other lists available in the Film Lists dialog) for the sequence. These other lists provide information about the entire sequence, rather than just information about the changes.

To open the Change List dialog from within Cinema Tools:

- In Cinema Tools, choose File > Export > Change List.

See “Creating Change Lists” on page 151 for details on Change List dialog settings.
Export Audio EDL Dialog

Audio is often reedited at an audio postproduction facility, using high-quality capture hardware and software and high-end processing tools. Depending on how you edit, Final Cut Pro’s EDL output may not contain the reel number and timecode of the original production sound tapes. This information is often contained in the telecine log that you import into Cinema Tools, or it can be manually entered.

You generally open the Export Audio EDL dialog from within Final Cut Pro. You are also able to open it from within Cinema Tools if necessary, although additional steps are required, including the creation of a program file in the Film Lists dialog.

To open the Export Audio EDL dialog from within Final Cut Pro:

- In Final Cut Pro, choose File > Export > Cinema Tools Audio EDL. (This command is available only when the Final Cut Pro Timeline is active, or when you have selected a sequence in the Browser.)

To open the Export Audio EDL dialog from within Cinema Tools:

1. In Cinema Tools, choose File > Export > Audio EDL from Program DB.
2. In the dialog that appears, select the program file to use, then click Open. The Export Audio EDL dialog appears.

![Export Audio EDL Dialog](image)

See “Exporting an Audio EDL” on page 161 for details on exporting audio EDLs.
At the heart of Cinema Tools is its database, providing powerful organizational tools.

A Cinema Tools database is a database file you create in Cinema Tools, which contains records that
• describe your source clips
• track the relationship between the film rolls and edge code (key numbers, ink numbers, or both) and the video reels and timecode
• can also track other elements such as scenes, shots, and takes, and sound rolls and sound timecode

You create a database for each film project. This database is what makes it possible for you to export film lists that tell the negative cutter how to cut your original camera negative.

Beyond creating film lists, you may want to use the database as an organizational tool. It can function similarly to the code book traditionally used in the post production of film, tracking important elements such as the scene, shot, and take; the camera and lab rolls; the edge code numbers; the video reels and timecodes; the sound rolls and timecodes; and the source clips.

Depending on your situation, you may be able to simplify the database creation process by building it from a telecine log or by creating just one database record per camera roll.
Understanding the Basic Structure of a Cinema Tools Database

A database is made up of records and each record describes one source clip. There are three different types of source clips for which you might create a database record:

- **If you used a scene-and-take transfer**, you’ll have one database record for each take, where each source clip is one take.

- **If you used a camera-roll telecine transfer**, you’ll have one database record per camera roll, where each source clip is one camera roll (typically containing several takes).

- **If you have broken down source clips into groups of takes**, each database record is associated with one source clip that contains several takes.
Deciding How You Should Create the Database

The way you create the database depends on how you want to use it and whether or not you have a telecine log or Avid Log Exchange (ALE) file.

If you haven't done so yet, take a look at the “The Cinema Tools Workflow” on page 33. Use these examples to guide you in determining the basic steps you need to take to create your database and capture your clips. The steps you take, and the order of those steps, differ depending on a number of factors, most of which are summarized in the workflow examples.

Capturing Before You Create the Database

It is possible to capture your source clips before creating your database, and to build the Cinema Tools database by importing a batch capture list created in Final Cut Pro. This approach is not as easy as building a database from a telecine log or ALE file because you then need to manually add the key number and film roll information to each database record. See “Importing Database Information From a Final Cut Pro Batch Capture List” on page 71.

If You Have a Telecine Log or ALE File

A telecine log, sometimes referred to as a FLEX file, is a file created by the telecine technician during a telecine transfer. You can also use an Avid Log Exchange (ALE) file as you would use a telecine log. The telecine log records the key numbers of the original camera negative and the timecode of the video transfer, and tracks the relationship between them.

Advantages of Using a Telecine Log or ALE File

Creating your database from a log is ideal because it provides these advantages:

- **Time savings:** You can create database records from a telecine log. You don’t have to manually create and enter details in each record. You can then generate a batch capture list from the database, expediting the capture process.

- **Accuracy and completeness:** Assuming the log you use is accurate, you’ll instantly have an accurate database and you won’t have to worry about your own potential data entry errors. Using the database batch capture list also ensures that the source clip files you capture match your database information.
To build a database from an existing log:
1 Create a new empty database.
   See “Creating a New Database” on page 66.
2 Generate the database records from the log.
   See “Importing Database Information From a Telecine Log or ALE File” on page 70.

If You Do Not Have a Telecine Log or ALE File
Although it’s faster and more efficient to use a log, you can build a database without one.

To create a database without a log:
1 Start a new empty database.
   See “Creating a New Database” on page 66.
2 Enter database records manually.
   See “A Potential Database Shortcut for Camera-Roll Transfers” on page 65, and
   “Entering Database Information Manually” on page 73.

*Note:* Alternatively, you could capture your source clips before creating your database,
and then build the Cinema Tools database by importing a batch capture list created in
Final Cut Pro. See “Importing Database Information From a Final Cut Pro Batch Capture
List” on page 71.

**Is Your Edge Code Number-to-Timecode Relationship Continuous or Noncontinuous?**
The edge code number-to-timecode relationship in a camera roll is *continuous* if the
camera roll was transferred to video without stopping.

The edge code number-to-timecode relationship is *noncontinuous* if
- you used a scene-and-take telecine transfer, where the video recording was
  stopped and restarted in between takes
- the film roll was made up of takes that were spliced together before it was
  transferred to video

*Note:* Occasionally the edge code number-to-timecode relationship is broken if,
during filming, the camera crew opened up a camera to check, clean, or change parts
of the camera (often called *checking the gate*). When the camera is opened for such
purposes, the film is typically unthreaded and then rethreaded. When the film is
rethreaded, it may be on a different perforation number. This means that at the
telecine, the telecine technician needs to stop, reframe, and make an edit, thus
breaking the edge code number-to-timecode relationship in the camera roll. This
should be evident in the telecine log.
A Potential Database Shortcut for Camera-Roll Transfers

If you used a camera-roll transfer and need to manually create your database, you may be able to save time by creating one database record per camera roll, depending on whether or not the edge code number-to-timecode relationship is continuous for each camera-roll transfer.

If the edge code number-to-timecode relationship is continuous on each roll:

If the edge code number-to-timecode relationship is continuous on each camera roll, you can create one database record per camera roll, and Cinema Tools can use the timecode-based method of locating database records in order to create film lists. In this case, each camera roll acts as one source clip.

As long you create an accurate database record for the camera roll, Cinema Tools will be able to accurately create film lists. However, if you also connect the source clips to the database records, you are providing extra insurance that the match back will go smoothly even if there is a timecode error. See “Workflow for a Camera-Roll Transfer (Timecode-Based Method)” on page 45 and “How Cinema Tools Creates Film Lists” on page 213 for more information.

Important: There is an exception to the timecode-based method of locating database records for film lists. If you conform your clips from 25 fps to 24 fps, the timecode in the editing system is adjusted for the new frame rate, which means that Cinema Tools will not be able use the timecode-based method of film list generation. You will therefore need to create separate database records for each source clip and connect those clips to their records. (Note that the timecode-based method can be used after clips are reverse-telecined.)

Even if you have a continuous edge code number-to-timecode relationship, you may want to take the time to create database records for each source clip for your own organizational and tracking purposes. For example:

• A database can be used to cross-check which take is on which sound roll and which lab roll contains a negative you need.
• You may want to have records for each clip so that you can add notes about different clips.
• Database records provide a poster frame of each clip for quick visual reference, and you can access and play the whole clip from the database.

If the edge code number-to-timecode relationship is noncontinuous on each roll:

When the edge code number-to-timecode relationship is noncontinuous, you need to create separate database records for each clip and connect those clips to their records. Each database record must include the key number or ink number of the first frame of the associated source clip, so that Cinema Tools can adequately track the edge code number-to-timecode relationships throughout your sequence.
Additional Uses for the Database

Optionally, you may want to use the database for purposes beyond simply matching video back to film, and this can affect how you create databases:

- **Individual databases for dailies**: If you have daily shoots that you want to process and track separately, you can create new individual databases for each daily session. If you do create individual databases for dailies, consider naming each database file by the date of the daily. Eventually, you can merge them into a master database by importing all the databases into one database.

- **Creating an audio Edit Decision List (EDL)**: If you plan to give an audio EDL to the audio-finishing facility, make sure that the audio and video timecode information and sound roll information is entered in each database record. Creating the database by importing a telecine log is the easiest and most efficient way to make sure that all the necessary information is entered into the database.

Creating a New Database

When you start a new database, you make default selections for your project settings in the New Database dialog.

*Note:* When you import data from a telecine log, the film standard, video timecode rate, audio timecode rate, and telecine speed are typically included in the log, and are automatically set in Cinema Tools. Data from the telecine log takes precedence over the defaults, so even if your default settings are different from the telecine log data, Cinema Tools will use the settings in the telecine log.

To create a new database in Cinema Tools:

1. Open Cinema Tools, and click Cancel when the database selection dialog appears.
2. Choose Database > New Database.

*Note:* The New Database menu item is not available if there are any Cinema Tools databases open. Close any open databases in order to access the New Database menu.

4 In the “Create a new database” dialog, choose a location and enter a filename for the database.

An empty database is created and you are ready to enter information into it. To find out how, see “Entering Information in the Database” on page 70.

**Settings in the New Database Dialog**

When you make choices in the New Database dialog, keep the following points in mind:

- Choosing a default setting does not lock you into using that setting in the database records. Default settings are applied automatically to new database records, but you can change the film standard, video timecode rate, and audio timecode rate for each clip individually in the Detail View window.

- When you import data from a telecine log, the film standard, video timecode rate, audio timecode rate, and telecine speed are typically included in the log, and are automatically set in Cinema Tools. Data from the telecine log takes precedence over the defaults, so even if your default settings are different from the telecine log data, Cinema Tools will use the settings in the telecine log.

If you need to change default settings you already made, see “Changing the Default Project Settings” on page 87.

**Tip:** If you are combining existing databases or want to check information such as default settings, filenames, and modification dates for an existing database, choose Database > Database Properties. The Database Properties dialog displays the full pathname and size of the database file, as well as the creation and modification dates. You can see the default project settings for the film standard, video timecode rate, and audio timecode rate.

**Film Standard**

Cinema Tools supports 4-perf 35mm format and 16mm-20 formats. (See Appendix A, “Background Basics,” on page 201 for information on these standards.)

Normally you use the same film stock throughout a film, so the film standard doesn’t change. However, if you need to, you can set the film standard for each shot individually in the Detail View window. For example, if you have some clips that are reverse but most are normal, you can specify the reverse film standard in the Detail View window for those clips.
To choose a default film standard:
- Choose the standard film type used for your project from the Film Standard pop-up menu.

- **35mm 4p:** 35mm film, 4 perforations per frame
- **16mm 20:** 16mm film, 20 frames per key number

**Video TC Rate**
Cinema Tools supports four different video timecode rates. See Appendix A, “Background Basics,” on page 201 for information on timecodes. The film lab that transfers your film to video can tell you what kind of timecode is recorded on the videotape.

To choose a default video timecode rate:
- Choose the Video TC Rate recorded on the videotapes for your project from the Video Timecode pop-up menu.

- **30 NDF:** Non-drop frame NTSC timecode at 30 frames per second (fps)
- **30 DF:** Drop frame NTSC timecode at 30 fps
- **25 FPS:** PAL timecode at 25 fps
- **24 FPS:** Video timecode at 24 fps

**Sound TC Rate**
Usually, timecode is recorded along with the soundtracks on the production sound rolls. That timecode can be used to locate the audio that goes with any particular clip, and many systems can use that timecode to synchronize the audio with the video. The primary purpose for entering the sound rolls and sound timecode in the database is for matching audio back to an audio Edit Decision List (EDL), as described in “Exporting an Audio EDL” on page 161.
To choose a default sound timecode rate:

- Choose the type of timecode recorded on your production sound rolls from the Sound TC Rate pop-up menu.

  - 30 NDF: Non-drop frame NTSC timecode at 30 frames per second (fps)
  - 30 DF: Drop frame NTSC timecode at 30 fps
  - 25 FPS: PAL timecode at 25 fps
  - 24 FPS: Timecode at 24 fps

**TK Speed**

The TK Speed (telecine film speed) refers to the frame rate of the film in the telecine equipment during the transfer to video.

If you are working with NTSC video, you usually choose 24 fps as the TK Speed, though the actual rate of the telecine speed is approximately 23.98 fps. The TK Speed pop-up menu also allows you to choose a setting of 30 fps because it is possible to transfer film to NTSC video with the film running at a speed of 30 fps (actually 29.97 fps).

If you are working with PAL video, see “Frame Rate Basics” on page 22 for a discussion of the PAL frame rate choices.

If your film was transferred to video at a telecine speed of 24 fps, choose 24 fps as the TK Speed. If your film was transferred to video at a telecine film speed of 25 fps, choose 25 fps.

To choose a default telecine film speed:

- Choose the speed at which the film was transferred from the TK Speed pop-up menu.

  - 24: 24 frames per second (fps) telecine film speed
  - 25: 25 fps telecine film speed
  - 30: 30 fps telecine film speed
**Entering Information in the Database**

As described in “Deciding How You Should Create the Database” on page 63, there are two basic approaches to creating your project database:

- You can generate the database by importing a telecine log, ALE file, or Final Cut Pro batch capture list.
- You can enter information manually.

Even if you do generate a database with a telecine log, you may want to make modifications and additions to the database records at a later time. You can do this by using the Detail View window or the Clip window. (In the Clip window, you can only modify existing database records).

**Important:** Before you can enter information in the database, you need to have an existing database. To create a new, empty database, see “Creating a New Database” on page 66.

**Importing Database Information**

You can create a database by importing information from a telecine log or ALE file, a Final Cut Pro batch capture list, or an existing Cinema Tools database.

**Importing Database Information From a Telecine Log or ALE File**

You can enter information into the database by importing the telecine log from the film-to-video transfer.

Cinema Tools currently supports the following telecine logs:

- ATN log files from Aaton
- FLX log files from TLC (Time Logic Controller software)
- FTL log files from Evertz
- ALE (Avid Log Exchange) files (not technically telecine logs, but contain similar information for your database)

**To import database information from a telecine log:**


2. In the dialog that appears, select the telecine log or ALE file.
The data in the log is entered into the open database and each new record is displayed in the List View window.

When Cinema Tools is finished creating the records from a telecine log, it tells you how many events there were in the log and how many of those events were imported into the database. Sometimes events in a telecine log refer to edits in which no film was transferred. For those events, no record is created in the database.

Note: The source clips are not yet connected to database records. You still need to use the Connect Clips command to connect them. For more information, see “Using the Connect Clips Command to Connect Source Clips” on page 103.

**Importing Database Information From a Final Cut Pro Batch Capture List**

You may want to create database records by importing a Final Cut Pro batch capture list if

- you don’t have a telecine log or ALE file
- you have already batch captured the clips you want into Final Cut Pro and you want database records to be created for those source clips instead of the takes listed in your telecine log

Note: Creating database records from a Final Cut Pro batch capture list is not ideal because you lose the advantages of using a telecine log or Avid Log Exchange (ALE) file to build your database. For example, a Final Cut Pro batch capture list does not contain the key number and camera or lab roll information that would be imported from a telecine log. See also “Advantages of Using a Telecine Log or ALE File” on page 63.

To import database information from a Final Cut Pro batch capture list:

1. Make sure that the Cinema Tools database is open.

   ![Import Final Cut Pro Batch List](image)

3. In the dialog that appears, select the batch capture list you exported from Final Cut Pro. The data in the batch capture list is used to create database records.

   Note: The source clips are not yet connected to database records. You still need to use the Connect Clips command to connect them. For more information, see “Using the Connect Clips Command to Connect Source Clips” on page 103.
4 In each database record, enter the edge code number information and film roll identifier. (These items are required to create a cut list or change list.)

Note: Because a Final Cut Pro batch capture list includes everything in the Final Cut Pro Browser, it may include clips or sequences that you don’t want. For this reason, you should delete any database records you don’t need. See “Deleting a Database Record” on page 85.

Importing an Existing Cinema Tools Database
One Cinema Tools database can be imported into another Cinema Tools database. There are a few reasons why you might want to do this:
- You may want to create separate databases for organization and archiving purposes, and then bring them all together in a master database. For example, you might want to create separate databases for your dailies. If you want to manage your dailies by creating a date-named database for each of the dailies, you could import the telecine log for that daily session, export a batch capture list, capture the clips, and use the Cinema Tools Connect Clips command to connect all the clips to that date-named database file. Then, you could import that database file into a master database that contains all of the daily databases.
- You may need to correct a database that has incorrect project defaults. To do this, you create a new, empty database with the correct defaults, then import your original database file into the new one.

To import one database file into another:
1 Open the database into which you want to import another database file by choosing Database > Open Database, then selecting the database in the dialog.
2 Choose File > Import > Database.
3 In the dialog that appears, select the database you want to import.
Entering Database Information Manually
You can use the Detail View window to manually edit database records. Before you can edit information in a database, you need to create database records.

**Note:** If a database record has already been created for a clip, you can also use the Identify window to enter information. See “Using the Identify Feature to Enter and Calculate Database Information” on page 82 for more information.

Understanding the Relationship Between Scenes, Shots, and Takes
To enter scene, take, and shot information in the database, you first need to know how scenes, shots, and takes are understood by the database.

A motion picture production is composed of a series of scenes, and each scene is typically composed of a number of shots or angles. A shot is a continuous film recording that does not have any cuts. In shooting the film, there may be a number of takes for each shot, so a take is a version of shot. There can be many shots for each scene. The diagram below shows an example of the relationship between scenes, shots, and takes as they might exist in a Cinema Tools database.
Creating a New Database Record

To create a new database record:
1. Do one of the following:
   - Click New in the Detail View window.
   - Choose Database > New Record.

2. In the New Record dialog, either enter identifiers for the Scene and Take or leave them blank, then click New. See the sidebar below, “Using Scene, Shot, and Take Identifiers,” for more information.

Note: You don’t have to enter anything in the Scene or Take fields in order to use Cinema Tools to match your digital edits back to your original camera negative. You can leave these fields blank. Use them if you want to keep track of shots in the database.

The Detail View window appears after you click New.
Using Scene, Shot, and Take Identifiers

An identifier can be any combination of numbers and letters (up to 15 characters).

- **Take identifier:** If the source clip associated with a database record contains more than one take, you can think of the take identifier as a source clip identifier.

- **Scene identifier:** The identifier you enter in the Scene field actually identifies both the scene and the shot for the clip. For the Scene identifier, most people enter the number or letter combination that appears in the Scene field on the slate. The typical method for identifying scenes and shots is to use a number for the scene and add a letter to specify the shot in the scene. So when a slate says Scene 12B, it is referring to shot 12B in scene 12. You see this reflected in the Detail View window; the first number you enter in the Scene field appears next to the word Scene in the Detail View window. Next to the word Shot, both the number and the letter appear. For example, if you enter 1D in the Scene field, you see the following at the top-left corner of the Detail View window:
  - 1 next to the word Scene
  - 1D next to the word Shot

**Tip:** In the Scene field, you can enter a letter before the first number, and it will be part of the scene identifier. Adding a letter to the beginning of a scene identifier is a useful naming scheme when you need to add a scene in the middle of an existing order of scenes. For example, between scene 1D and scene 2D you could add a scene named A2D, so the new order would be scene 1D, scene A2D, scene 2D, scene 3D, and so on.
Entering Information in a Database Record

To enter information in a database record:

1. Make sure the record is displayed in the Detail View window. (If necessary, double-click the record in the List View window to open it in the Detail View window.)

2. Enter information and settings in the Detail View window.

   “Settings in the Detail View Window,” next, describes all the settings, and specifies which ones are required if you plan to use the database to generate cut list or change lists.

   You can press the Tab key to navigate from one field or setting to another.

   Tip: When you connect a clip to a database record and the record does not yet contain the clip timecode, reel, and timecode duration, Cinema Tools looks for this information in the clip file and automatically enters it in the database record.

   If you know the edge code number or timecode for another frame in a clip, the Identify feature can help you determine the correct timecode or edge code number for the first frame of a clip. See “Using the Identify Feature to Enter and Calculate Database Information” on page 82.

3. Click Save. Until you save, data in the Detail View window is not entered in the database.
Settings in the Detail View Window
The Detail View window includes a number of fields and buttons for creating a database record. Only a few of these settings are required for the purpose of using the database to create a cut list or change list.

Detail view settings required if you intend to generate a cut list or change list:
- lab, camera, or daily roll
- key number or ink number

Additionally, each source clip must be connected to a record, unless you can use the timecode-based method for cut list or change list generation (see “A Potential Database Shortcut for Camera-Roll Transfers” on page 65).

To use the timecode-based method for cut list or change list generation, these elements are also needed:
- video reel
- timecode and duration

Settings required if you intend to export an audio EDL:
- Each source clip must be connected to a record or each record must have the video reel and video timecode and duration entered.
- Each record must have the sound roll, sound timecode, and sound timecode rate (Sound TC Rate) entered.
The Detail View window contains the following fields and buttons:

- **Find button**: Click to display the Find dialog, which you use to locate and display a set of database records in the List View window. These records are referred to as the *found set*. See “Finding and Opening Database Records” on page 91 for details.

- **Previous and Next buttons (arrows)**: Click these buttons to move forward or backward through the database. As a shortcut, you can use the Left and Right Arrow keys on your keyboard.

- **Scene and Shot description fields**: You only need to enter this data once per scene. Once you enter it, it is added to all existing and new records for the same scene.
  - (Scene) **Description field**: Enter a description of the scene.
  - (Scene) **Page and To fields**: Enter the starting and ending script pages associated with the scene.
  - (Shot) **Description field**: Enter a description of the shot.
  - (Shot) **Page and To fields**: Enter the starting and ending script pages associated with the shot.

### About the Descriptive Scene and Shot Data

All the shots for a scene are related to that scene, and all the source clips for a shot are related to that shot. Because the database remembers these relationships, you only need to enter the descriptive data for each scene and shot once.

When you enter or change the descriptive data for a scene, that same data appears for all the other shots associated with that scene, both in existing database records and any records you create later that have the same scene identifier.

The descriptive information is automatically added to all other database records with the same scene identifier (8, in this example).
• **Scene field:** Use this field to enter or modify the identifier for the scene. See “Using Scene, Shot, and Take Identifiers” on page 75 for more information.

• **Take field:** Enter a take identifier here. Takes are usually identified as numbers, but you can enter whatever text you want to use to identify the take, up to 15 characters. If there are multiple takes in the source clip, think of the take identifier as a clip identifier.

• **Cam Roll field:** (If you intend to create a cut list or change list, one of the roll fields must be completed.) If editing material from camera rolls, enter the camera roll identifier given to the roll of film by the camera assistant during production. The camera roll identifier should be the same as that which appears on the slate for the take.

  **Note:** In many cases the camera roll and the lab roll are the same thing, and can be given the same identifier. You can choose to enter data into either one or both of these fields. You should, however, be consistent. When creating a cut list or change list, Cinema Tools gives you the choice of showing the camera roll, lab roll, or daily roll. Whichever one you choose, it must be present in every database record, or Cinema Tools will report an error when you export a film list.

• **Lab Roll field:** (If you intend to create a cut list or change list, one of the roll fields must be completed.) If editing material from lab rolls, enter the identifier given to the lab roll by the laboratory that processed the film. Or, enter an identifier for a roll created from select takes, for printing. (Sometimes such a roll is referred to as the A negative.) In many cases the lab roll and the camera roll are the same thing, and can be given the same identifier—see the note above.

• **Daily Roll field:** (If you intend to create a cut list or change list, one of the roll fields must be completed.) If editing material from daily rolls, enter the identifier given to the daily roll from which this source clip originated.

• **Key field:** (If you intend to create a cut list or change list, this field or the ink number field is required.) The first field should contain the key prefix that is constant throughout a roll of film. For example, for the key number KJ 291010 5867+07B, the key prefix is KJ291010. You can enter up to eight characters (including spaces) in this field. In the second field, enter the second part of the key number—the frame number—for the first frame of the clip. For example, for the key number KJ 291010 5867+07 B, the frame number is 5867+07. The frame number identifies each foot or half foot within the reel, plus the frame count number. If you know the key number for another part of the clip, the Identify feature can determine and enter the key number (Key field) for the first frame of your clip. See “Using the Identify Window to Enter Edge Code Numbers and Timecode Values in the Database” on page 83.

• **Ink field:** (If you intend to create a cut list or change list, this field or the key field is required.) In the first field enter the prefix number, and in the second field enter the frame number. For example, in the ink number 1 23 4567 +08, the prefix is “1 23” and the frame number is “4567+08”, indicating that the frame occurs at 4567 feet and 8 frames.
• **Length field:** This field is for the length of the clip, expressed as feet plus frame offsets. The value for this field can come from a telecine log. If you know the length of the clip from some other source, such as a production camera report, you can enter that data here. You can also find the value for this field by using the Identify feature. See “About Modifying Data in the Identify Window” on page 88. Cinema Tools uses this field when it exports scene lists, where it may be useful to know the length of a shot. If a clip starts at frame number 1234+05, and the last frame is 1250+10, the length would be 16+05. For a 16mm-20 clip, the length would be equivalent to 8 feet and 5 frames, because there are two footage numbers per foot.

• **TK Speed pop-up menu:** This pop-up menu gives you the option of individually specifying the telecine transfer film speed for each database record. If the database record was created from a telecine log, the setting in this menu should already be correct and there should be no need to change it. If you are creating the database manually, the setting in this menu should reflect the telecine film speed setting you chose when you set your project defaults. For more information, see “TK Speed” on page 69.

• **Film Standard pop-up menu:** This pop-up menu gives you the option of individually specifying the film standard for each database record. If the database record was created from a telecine log, the setting in this menu should already be correct and there should be no need to change it. If you are creating the database manually, the setting in this pop-up menu should reflect the setting you chose in the New Database dialog. For clips that are in reverse direction, you can specify a reverse direction for the film standard by choosing a menu item marked rev. Reverse direction film is film that has key numbers going in a descending rather than an ascending order. You’ll see this when, for example, film has been shot in reverse, or when a film roll was loaded into the camera “tails out,” so that the key numbers are in reverse order. For more information, see “Film Standard” on page 67.

• **Video Reel field:** (Unless all the clips you will be editing are connected to the database, this field is required if you intend to create a cut list or change list or audio EDL.) Enter the identifier of the video reel that contains this take. This field is essential for creating an accurate cut list or change list. When you connect a clip to a database record that does not yet contain the reel identifier, Cinema Tools looks for this information in the clip file and automatically enters it in the database record. Make sure you enter the exact, correct identifier here, so that the database record can be properly matched to the shot after you digitally edit your program. For example, 001 is not the same as 0001.
• **Video Timecode field:** (Unless all the clips you will be editing are connected to the database, this field is required if you intend to create a cut list or change list or audio EDL.) Enter the timecode number of the video frame that represents the first frame of the clip. The relationship between the key numbers and the timecode is established when the film is transferred to video, and this information is usually entered automatically when you create the database from a telecine log. When you connect a clip to a database record that does not yet contain the clip timecode, Cinema Tools looks for this information in the clip file and automatically enters it in the database record. You can also determine the timecode for this field by looking at the first frame of the clip, provided that both the key number and the timecode are burned in to the video.

**Tip:** If you enter the video reel and timecode in the Detail View window, you can use the database to locate source material on the videotape while you are editing. For example, if you are editing a clip and there is something in the clip that you are unsure about because you can’t see it clearly, you may want to view it on the videotape because the video is of higher quality. You can check the clip’s database record to find out the timecode location on the reel and which video reel contains the material.

• **Video Duration field:** (Unless all the clips you will be editing are connected to the database, this field is required if you intend to create a cut list or change list or audio EDL.) Enter the timecode duration of the source clip. The value for this field can come from a telecine log. If you connect a clip to a database record that does not yet contain the clip timecode duration, Cinema Tools looks for this information in the clip file and automatically enters it in the database record. Since duration is expressed as hours, minutes, seconds, and frames, you might find it more informative than the length of the film expressed as feet and frames. The timecode duration is significant if you intend to perform a batch capture, or if you will be creating a cut list or change list by matching the edited program back to the video reel and timecode.

• **Video TC Rate pop-up menu:** This pop-up menu displays the default video timecode rate that you selected when you created the database, or the format that was indicated by the telecine log you imported to create the database. The lab that transfers your film to video can tell you which kind of video timecode rate is recorded on the videotape. See “Video TC Rate” on page 68 for more information.

• **Sound Roll field:** (Required if you intend to create an audio EDL.) Enter the sound roll name.

• **Sound Timecode field:** (Required if you intend to create an audio EDL.) Enter the starting sound timecode for the clip. The sound timecode can be a standard different from the video timecode.

• **Sound TC Rate field:** (Required if you intend to create an audio EDL.) Enter the type of timecode rate used on your production sound rolls.
**Connect Clip/Open Clip button:** If a clip has not been connected to the database record, this button is labeled Connect Clip. If a clip has already been connected, the button is labeled Open Clip.

- Click Connect Clip to select a source clip to connect to this record. When you select a clip, it is connected to the database record and the first frame of the clip appears in the box below the Connect Clip/Open Clip button.
- Click Open Clip to open a Clip window for the connected clip. If the related clip is not found, a dialog opens so that you can select the correct clip.
- Press the Command key to change Open Clip to Disconnect Clip. Click Disconnect Clip to disconnect the clip from the database record.

**Notes field:** Enter any notes you want to include about the source clip.

**Telecine session notes:** Enter any notes you want to include about the telecine session.

**New button:** Click to create a new database record. In the dialog that appears, enter the scene and take identifiers for the new database record. See “Using Scene, Shot, and Take Identifiers” on page 75 for more information.

**Save button:** Click when you have added or modified data in the current database record. Your added or modified information is not recorded unless you click Save.

---

**Using the Identify Feature to Enter and Calculate Database Information**

You can use the Identify window to determine the key number, ink number, or timecode values for the database. The database requires these values for the first frame of the clip, but you might not have them if you aren’t creating database records from a telecine log or if your clips are lacking window burn.

To use the Identify feature to determine or verify edge code or timecode values:

- you need to know a key number, ink number, or timecode value for at least one frame in the clip
- the key needs to have a database record
- the key number-to-timecode relationship must be continuous. See “Is Your Edge Code Number-to-Timecode Relationship Continuous or Noncontinuous?” on page 64.

Keep in mind that in the Identify window, the Key, Ink, Video Timecode, and Audio Timecode fields should always reflect the values of the frame currently displayed in the Clip window, whereas in the Detail View window these fields are associated with the first frame of the clip. The Identify feature will, however, calculate and enter the first-frame values you see in the Detail View window.
Using the Identify Window to Enter Edge Code Numbers and Timecode Values in the Database

If you know the edge code (key number or ink number) and timecode value for any frame in a clip, you can use the Identify feature to determine these values for the first frame of the clip and that information is automatically entered in the database.

This feature is especially useful if you are working with video that does not have window burn, because without window burn you have to track the timecode and edge code by physically marking one frame in each clip. If the frame that is marked is not the very first frame of the clip, the Identify feature can calculate what the values are for the first frame, and those values are automatically entered in the database.

To enter the edge code and timecode values in the database:

1. If it isn’t already open, open the clip in the Clip window in one of the following ways:
   - Click Open Clip in the Detail View window of the clip’s database record.
   - Choose File > Open Clip and use the dialog to select the clip.

2. Locate the marked frame in the clip playback window.

   Tip: Use the arrow keys on your keyboard to move forward and backward frame-by-frame.

3. When your marked frame is displayed in the window, click Identify.

Note: The Identify window updates to show the information of each frame as you move through a clip, so you can also locate the marked frame after opening the window.
Enter the edge code and timecode values for the marked frame (the frame showing in the Clip window) in the appropriate fields.

*Note:* You may be using ink numbers instead of key numbers, or vice versa. If so, you can leave the field you aren’t using blank.

Note: If you decide you want to reset the values to what they were when you opened the Identify window, click Revert.

5 Click Apply.

The clip's database record is immediately updated with the values for the first frame of the clip.

Calculating and Entering Clip Timecode Duration in the Database

The correct timecode duration of a clip is essential if you intend to generate a batch capture list with Cinema Tools, or if you will be creating a cut list or change list by matching back to the video reel and timecode (instead of matching back by using the key numbers or ink numbers and clips). The value for this field can come from a telecine log, and if you connect a clip to a database record that does not yet contain the timecode duration, Cinema Tools looks for this information in the clip file and automatically enters it in the database record.

You can use the Identify feature to calculate a clip's timecode duration (length in timecode format) and this value is entered automatically in the database.

To calculate the timecode duration of a clip:

1 If it isn't already open, open the clip in the Clip window in one of the following ways:
   • Click Open Clip in the Detail View window of the clip's database record.
   • Choose File > Open Clip, then select the clip in the dialog.

2 Click the Identify button to open the Identify window.

3 Click Apply.

The clip's timecode duration is entered or updated in the clip's database record.
**Modifying Information in the Database**

You can modify any information in the database by editing settings in the Detail View window and the Identify window. Some of the calculations you make using the Identify feature update pre-existing information, modifying the database automatically. See “Using the Identify Feature to Enter and Calculate Database Information” on page 82 for more information.

**Deleting a Database Record**

*Note:* Be careful when you delete a database record, because there is no way to undo this command.

**To delete a database record:**

1. Open the database record in the Detail View window, or select it in the List View window.
2. Choose Database > Delete Record, or press Command-Delete.

*Note:* When you delete a database record that is connected to a source clip, you don’t actually delete the clip from your hard disk. You only delete the database record.

**Choosing a Different Poster Frame for a Clip**

By default, after a connected clip is opened in the Clip window, a small picture of the first frame of the clip appears in the Detail View window. This picture is called the *poster frame*. You can choose to display a different frame of the clip if the first frame of the clip is hard to recognize, as with black frames.

The default clip poster frame does not appear in the Detail View window until after

- the clip has been connected to a database record
- the clip has been opened in the Clip window
To choose a new poster frame for a clip:

1. If it isn't already open, open the clip in the Clip window in one of the following ways:
   - Click Open Clip in the Detail View window of the clip's database record.
   - Choose File > Open Clip, then select the clip in the dialog.

2. In the clip playback area, locate the frame you want to use as the poster frame.
   - **Tip:** Use the arrow keys on your keyboard to move forward and backward frame-by-frame.

3. Click Poster Frame when the window displays the frame you want to use.
   The new poster frame appears in the Detail View window of the clip.

   **Note:** Regardless of the poster frame you set, the Clip window always opens to the first frame of the clip.
Changing the Default Project Settings

To change the default settings for a project:
- Create a new database with the default settings you want, then import your original database into the new one. See “Importing an Existing Cinema Tools Database” on page 72.

Changing All Reel or Roll Identifiers

There may be times when you want to change all occurrences of a reel or roll identifier in a database. For example, you might need to change a reel identifier that is not EDL-compatible to one that is EDL-compatible. Or, you might need to change the reel or roll identifier in a database to match identifiers that are actually used in an EDL.

Note: If you will be exporting a batch capture list from the database, it’s best to make the reel or roll identifier changes before exporting the list.

To change all instances of a reel or roll name in a database:
1. Click the Find Button in the Detail View window, then click Find All to make sure that all of the database records are listed in the List View window.
2. Choose Database > Change Reel.
3. Make the following settings in the Change Reel dialog:
4. Choose the type of roll or reel.
5. In the From field, enter the identifier that you want to change. In the To field, enter the new identifier.
6. Click OK.

After you click OK, all records displayed in the List View window are searched, and each time the roll or reel identifier that you want to change is found, it is replaced by the new identifier.
About Modifying Data in the Identify Window

You can use the Identify window for a clip only if a database record has been created for that clip. The Identify window includes fields and pop-up menus for settings that also appear in the Detail View window. You can modify these settings in the Identify window, but keep the following important facts in mind:

- In the Identify window, the Key, Ink, Video Timecode, and Audio Timecode fields should always reflect the values of the frame currently displayed in the Clip window, whereas in the Detail View window these fields are values associated with the first frame of the clip. Therefore, what you see or enter in the Identify window could be different from what you see or enter in the Detail View window. See “Using the Identify Feature to Enter and Calculate Database Information” on page 82.

- In the Identify window, the key numbers can only be tracked if the key number-to-timecode relationship is continuous, as it is with most camera-roll transfers. See “Is Your Edge Code Number-to-Timecode Relationship Continuous or Noncontinuous?” on page 64.

If you changed the values in the window and want to go back to previous values, click Revert instead of Apply. After you click Apply, the database record is updated, and these changes are reflected in the Detail View window.

Verifying and Correcting Edge Code Numbers and Timecodes

Assuming you know the timecode, key number, or ink number values for another frame in a clip—either by a marked frame or by window burn—you can use the Identify feature to verify these values. Verification is important because your cut list or change list is only as accurate as these values.

Verifying values with the Identify feature is especially useful when

- you find a discrepancy between the timecode and ink numbers or key numbers in the window burn and those values in the Cinema Tools database or in Final Cut Pro
- you entered the values manually, and need to double-check your data entry work

**Important:** The Identify feature can only track edge code numbers if the edge code number-to-timecode relationship is continuous, as it is with most camera-roll transfers. See “Is Your Edge Code Number-to-Timecode Relationship Continuous or Noncontinuous?” on page 64. If the edge code number-to-timecode relationship is noncontinuous, you can verify and correct the edge code number and timecode values for the source clips by visually checking these values against the window burn and, if necessary, manually updating the edge code number and timecode in Cinema Tools and the timecode Final Cut Pro.
To verify and correct the edge code and timecode entered for a clip:

1. If it isn’t already open, open the clip in the Clip window in one of the following ways:
   - Click Open Clip in the Detail View window of the clip’s database record.
   - Choose File > Open Clip, then select the clip in the dialog.

2. In the clip playback area, locate a frame near the beginning of the clip for which you know the correct edge code number or timecode. This is easy if your video has window burn.

3. Click Identify.

   ![Frame with Correct Timecode and Edge Code](image)
4 Look at the Key, Ink, and Video Timecode fields in the Identify window to see if the numbers match the window burn of the frame in the Clip window. (You may be using ink numbers instead of key numbers, or vice versa. If so, you can leave the field you aren’t using blank.)

![Identify window](image)

See if the key number and/or ink number matches the frame in the Clip window.

5 If any of the Key, Ink, or Timecode fields are incorrect, enter the correct numbers in the fields.

6 In the clip playback area, locate a frame near the end of the clip and repeat steps 3 through 5.

- If the edge code number and timecode values are correct at the beginning of the clip, but not at the end of the clip: Frames may have been dropped during capture, in which case you should recapture the clip. See “Avoiding Dropped Frames” on page 96. It might also be because the clip doesn’t have a continuous edge code number-to-timecode relationship, in which case the Identify feature cannot help you confirm the edge code numbers and timecode because it works by a calculation based on a continuous edge code number-to-timecode relationship.

- If the timecode is incorrect: There is a good chance that the timecode is wrong in Final Cut Pro. Open the same frame in Final Cut Pro and see if the timecode is correct. If it isn’t, be sure to correct the timecode in Final Cut Pro. You can do this by using the Modify Timecode dialog. See the Final Cut Pro documentation for more information about how to modify the timecode.

If you used serial device control, the timecode mismatch may have happened because you didn’t set the appropriate timecode offset in Final Cut Pro for the specific deck you used. You need to make this setting once per deck, per computer. For more information, see the section on calibrating the timecode signal in the Final Cut Pro documentation.

7 If you entered new numbers in the fields, click Apply. Otherwise, if the values were already correct, close the window.
Working With the Database
To work with the database, you need to know about these basic tasks:
- opening an existing database
- finding and opening database records
- accessing information about a clip

Opening an Existing Database
To open an existing database:
- Choose Database > Open Database, then select the database in the dialog.
All the records in the open database are listed in the List View window.

Finding and Opening Database Records
You typically open database records from the List View window. The set of records displayed in the List View window is often referred to as the *found set*, because you use the Find command to specify which records are listed there.

To display a database record in the Detail View window:
- Double-click the record in the List View window.

To display specific records in the List View window:
- Use the Find dialog. See the section on using the Find command (below) for details.

To navigate through records within the Detail View window:
- Click the Previous and Next buttons or use the Left and Right Arrow keys on your keyboard.

To find a key number:
- In the List View window, choose Keycode from the pop-up menu, then click the Keycode column heading to sort by key number.
See “List View Window” on page 49 for more details.
To use the Find command to find records in the open database:

1 Open the Find dialog by doing one of the following:
   • Click the Find button in the Detail View window.
   • Choose Database > Find.
   • Press Command-F.

2 Choose one of the following from the pop-up menu:
   • Replace Existing: Found records replace the records displayed in the List View window.
   • Add to Existing: Found records are added to the set in the List View window.

Tip: The Add to Existing option is useful when you want to find records for more than one scene, but not for all scenes. For example, to see only the records for scenes 5 and 6, choose Replace Existing, enter 5 in the Scene field, then click Match. Then, choose Add to Existing, enter 6 in the Scene field, and click Match. Only the records for scenes 5 and 6 appear in the List View window.

3 Do one of the following:
   • To find all the records in the open database, leave the Scene and Take fields blank and click Find All.
   • To find all the records for a particular scene or shot, enter the identifier for that scene or shot in the Scene field, leave the Take field blank, then click the Match button. (The Take field is ignored unless you select the Exact checkbox.) For example, if you enter 1 in the Scene field, then click Match, Cinema Tools finds all records associated with scene 1, including the shots 1, 1A, 1B, 1C, and so on. If you enter 1A in the Scene field, only the records for scene 1A are found.
   • To find the record for a specific scene and take, enter the scene and take identifiers in the Scene and Take fields, select Exact, then click Match.

The found records appear in the List View window.
Accessing Information About a Source Clip

The Clip Analysis button in the Clip window gives you access to specific information about a source clip.

The Clip Analysis dialog displays the full path (location) and name of the file, along with its size and dates of creation and modification. You can also see the duration of the movie contained in the clip.

About Backing Up, Copying, Renaming, and Locking Databases

As is the case with all important data, it is wise to store backup copies of your Cinema Tools database files and to lock the database files if you want to make sure they are not modified or deleted. Do this by using any of the standard desktop methods for copying and locking files. You can back up your files on your computer’s hard disk or on separate removable media. If you are going to lock a database file, make sure that the database is closed before you lock it.

You can also use any standard desktop method to rename a database file. Changing a **database filename** (as opposed to a source clip filename) does not affect the content of the database or any of the database functions.

**Important:** Changing a **source clip filename** (by editing it in the Finder) is not recommended because it breaks the link between the source clip and the database. However, you can reconnect such links using the Reconnect command.
Information is also listed for each different track in a clip:

- For video tracks, you see the frame size and frame rate, the compressor used and the compression quality, the average data rate, and whether the data is self-contained or referenced from another file. See “The Difference Between Self-Contained and Referencing Clips” on page 126 for more information.
- For an audio track, you see the sample rate, sample size, whether it’s mono or stereo, and whether the data is self-contained or referenced from another file.
Capturing Source Clips and Connecting Them to the Database

Establishing the relationships between the source clips and the Cinema Tools database is key to a successful project.

Once you have created the project database, it’s time to capture your source clips with Final Cut Pro. *(Source clips are the media files you start with when you begin editing.)*

After capturing, you establish connections between the database records and the source clips.

*Tip:* Use the scenarios in “The Cinema Tools Workflow” on page 33 to guide you in determining the basic steps you need to take to capture your source clips and connect them to the database. The steps you need to take, and the order of those steps, differ depending on factors that are summarized in the workflow examples. For example, in some situations it is not necessary to connect the clips to the database.

**Preparing to Capture**

Detailed information about capturing clips is provided in the Final Cut Pro documentation. Before you capture, you need to pay attention to a few factors that can affect your project:

- avoiding dropped frames during the capture process
- how your hardware is set up for video capture
- considerations regarding the capture of audio
- how to prepare for batch capturing (if you have a video deck with device control)
- considerations for capturing source clips individually (if you do not have device control)
Avoiding Dropped Frames

If computer performance is impeded or if your scratch disk is not fast enough, frames may be dropped during the capture process, meaning one or more individual frames are not captured at all. When a frame is dropped during capture, the frame before it is repeated. As a result, a frame you see while editing may not be the frame you see when the film is cut. Dropped frames can cause timecode errors, which can result in an incorrect cut list and interfere with the reverse telecine process. You can prevent this problem in Final Cut Pro by setting the program to stop capturing and to notify you when a frame is dropped.

To set Final Cut Pro to stop capturing when frames are dropped:
1. In Final Cut Pro, choose Final Cut Pro > Preferences.
2. In the General tab, make sure “Abort capture on dropped frames” is selected.

When this option is selected, a message appears when frames are dropped during capture and the capture is stopped.

If dropped frames occur, first make sure that other programs are not open, so that performance is not slowed. Then, recapture the source clip.

If you attempt to use the Reverse Telecine feature for a source clip that contains dropped frames, a warning appears.

A Caution About Using OfflineRT Media With Cinema Tools

When you capture media with the OfflineRT Easy Setup in Final Cut Pro, your captured media is highly compressed, allowing you to capture more source clips to your hard disk—approximately two hours of video per gigabyte (GB) of hard disk space. However, it can be very difficult, if not impossible, to read the key number and timecode information in the window burn after capturing with OfflineRT compression. You typically need to see the window burn in order to verify and correct the key number and timecode values, and to use the Cinema Tools Reverse Telecine feature. For this reason, OfflineRT may not be ideal for Cinema Tools users.

For more information about OfflineRT, see the Final Cut Pro documentation.
Setting Up Your Hardware to Capture Accurate Timecode

Final Cut Pro’s ability to capture frame-accurate timecode for each clip is also dependent upon the proper setup of your capture hardware. When using DV decks, this is easy. In Final Cut Pro 3 and later, capturing video with a DV deck using FireWire for both device control and video and audio input will result in 100 percent accurate timecode. If you are instead capturing from a deck using serial device control—for example, a Digital Betacam or Beta SP deck—there are a couple of important steps you need to take during setup to ensure timecode accuracy.

What Is Device Control?
Device control makes it possible for Final Cut Pro to control your video camera or video deck. If your video camera or deck uses a protocol supported by Final Cut Pro, Final Cut Pro can exchange timecode and device control data with the camera or deck. If you have device control, you can cue and capture several source clips at once (called batch capturing). If you do not have device control, you need to capture source clips individually. See the Final Cut Pro documentation for supported device control protocols.

If You Are Capturing With a Serial Device Control Deck
Before you capture from a deck using serial device control, you need to take these steps to ensure all-important timecode accuracy:
• genlock your deck with your video capture interface
• calibrate the timecode offset

Genlocking the Deck and Video Capture Interface
In addition to connecting the serial device control cable from your deck to your computer (using a recommended serial interface adapter) and connecting the necessary video and audio connectors, you must also make sure that your deck is genlocked with your video capture interface. Genlocking refers to locking two video devices together using a blackburst generator.

If your deck and video capture device support genlock (also called external sync), connect them to a common signal generator (usually a blackburst generator which outputs a continuous black video signal). This is done using the genlock connectors found on your video deck and video capture interface (these may also be labeled reference video). Genlocking your deck with your video capture interface synchronizes these devices, ensuring timecode accuracy.

Important: If you are capturing from a deck using serial device control and your video capture interface cannot be genlocked with the deck, the accuracy of the timecode captured with your clips cannot be guaranteed.
Capturing Source Clips and Connecting Them to the Database

Calibrating the Timecode Offset
Even when your deck and video capture interface are genlocked together, if you are going to use serial device control instead of FireWire device control to capture, it is still essential to calibrate the capture offset (found in Final Cut Pro’s Device Control Preset tab) prior to capture. To use serial device control, you need to make this setting once per deck, per computer. For more information, see the section on calibrating the timecode signal in the Final Cut Pro documentation.

Considerations Before Capturing Audio
Before you capture your audio with Final Cut Pro, you need to take into account the following:

- If you have an audio deck that can adjust the audio speed to sync to your editing frame rate when necessary, use the audio deck to do this before you capture the audio into your computer. See “Determining How to Prepare Source Clips for Editing” on page 109 to find out how you might need to adjust your audio speed.
  
  **Note:** If you don’t have an audio deck, there are other ways you can adjust the audio after capturing. See “Making Adjustments to Audio Speed” on page 123.

- If you will be editing at 24 fps (the same frame rate at which the film was recorded), capture the audio at the speed at which it was recorded.

- Before capturing an audio clip that you plan to sync to a video clip, make sure your device-controllable audio deck is genlocked to a video capture interface installed in your computer. (See the Final Cut Pro documentation for more information about genlocking your audio deck to a video capture interface.) Also, in Final Cut Pro, select the “Sync audio capture to video source if present” option in the General tab of the User Preferences window.
Generating a Batch Capture List From Cinema Tools

If you have a video deck with device control, such as a DV-format camera with FireWire or a high-end video deck or camera, batch capture is the most convenient way to bring media into your computer. With batch capture, you connect a video deck to your computer and, based on a Cinema Tools–generated list of the source clips, Final Cut Pro copies all of the source clips from the tape to your computer. In other words, when you use batch capture, you do not need to use your video deck to manually locate each source clip before you capture it with Final Cut Pro.

To set up a batch capture, you specify the clips you want to capture (after your Cinema Tools database has been created) and Cinema Tools generates a list based on the information in the database. After you import this batch capture list into Final Cut Pro, those source clips appear in the Browser as offline clips, meaning they are logged and ready to be batch captured. When your source media is on multiple tapes, you can still use batch capture. When you begin the batch capture, you see a list of all the video reels needed. When all the clips from one reel are captured, you are prompted to select another reel.

Note: You do not have to create a batch capture list from a Cinema Tools database because you can first batch capture your clips with Final Cut Pro and then generate a database from your Final Cut Pro batch capture list. However, this is not ideal because you lose some of the advantages of building your database from a telecine log or Avid Log Exchange (ALE) file. Most importantly, the key number and camera roll information is not added to each database record so you have to enter that information manually. See “Importing Database Information From a Final Cut Pro Batch Capture List” on page 71 for more information.
To generate a batch capture list from Cinema Tools and import it into Final Cut Pro:

1. Make sure that the List View window displays the database records of the clips you want to capture.

To display all of the records in the database, click Find All in the Find dialog. See “Finding and Opening Database Records” on page 91 for details.

Important: The batch capture list will only include database records that have a video reel, timecode start, and timecode duration. Also, any database records that are already connected to a clip do not appear in the batch capture list.

2. Choose File > Export > Batch Capture.

3. In the Export dialog, choose what you want to capture, then click OK:
   - **Final Cut Pro Video:** Choose this option to capture all video and audio contained in the source clips. When you choose this option, the batch log includes the video reel and video timecode entered in this clip’s database record.
   - **Final Cut Pro Audio:** Choose this option to capture only the audio from the source clips. When you choose this option, the batch log includes the sound roll and sound timecode entered in this clip’s database record.

4. In the dialog that appears, select a location and enter a name for the batch capture list.

Tip: You can edit the batch capture list in a text editor. However, make sure that you do not delete or overwrite the Tab characters that separate the fields in each line. You can delete lines for clips you don’t want to capture.

5. In Final Cut Pro, choose File > Import > Batch List.

6. In the Final Cut Pro Batch List dialog, select the batch capture list you exported from Cinema Tools, then click Open.

The clips appear in the Browser as offline clips, ready to be batch captured. See the Final Cut Pro documentation for details on batch capturing.

Important: If your video is non-drop frame timecode, make sure that Non-Drop Frame is chosen from the Default Timecode pop-up menu in the Final Cut Pro Device Control Presets tab before you begin capturing.
Chapter 5  Capturing Source Clips and Connecting Them to the Database

Considerations Before Capturing Clips Individually

Clips can also be captured individually with Final Cut Pro, without using device control. (See the Final Cut Pro documentation for details on capturing clips individually.)

When you capture your clips, remember these points:

- If you don’t use device control, Final Cut Pro cannot receive the correct timecode for the clips during capture. This means you need to correct the timecode for each and every source clip in Final Cut Pro. To do this, open each clip in the Viewer and note the timecode that appears in the window burn of the first frame of the clip. Then, choose Modify > Timecode and enter the value from the window burn into the Source field, selecting the Drop Frame checkbox if appropriate. Finally, be sure to update the key number information for the clip in the Cinema Tools database by using the Identify feature, as described in “Verifying and Correcting Edge Code Numbers and Timecodes” on page 88.

- You don’t want to drop any frames while capturing because that can result in an incorrect cut list and will interfere with the reverse telecine process.

How Cinema Tools Names Batch-Captured Clips

If you capture clips with a batch capture list, and if there is both a scene and a take identifier in the database record, Cinema Tools creates a clip name using the scene and take, separated by a hyphen. For example, the clip for scene 10, take 1 would be named 10-1. If there are no scene and take identifiers, Cinema Tools creates a clip name based on the video reel and timecode. For example, a clip from reel 001 that begins at timecode 01:35:30:15 would be named 001-01.35.30.15.

When naming the clips, Cinema Tools makes sure that none of the clips have the same name. For example, clips from different cameras may have had the same scene and take identifiers. When this happens, the clip names are distinguished by adding the roll or reel identifiers. For example, the clips for scene 4, take 4 in roll “1A” and roll “1B” would be named “4-4” and “4-4B,” respectively. If there were no roll or reel identifiers found, those clips would be named “4-4” and “4-4_1.”

Note: Before exporting a batch capture list from Cinema Tools, it’s best to sort by Slate in the List View window to see if any clips have the same Slate column descriptions. If any clips have the exact same information in the Slate column, modify the Scene or Take fields in those database records so that they are not the same. This will help ensure that none of the clips in the batch capture list have the same name.

Important: In order to make the clip-connecting process as automated as possible, do not change the filenames that Cinema Tools creates for the source clips when they are captured.
If your video is non-drop frame timecode, make sure that Non-Drop Frame is chosen from the Default Timecode pop-up menu in the Final Cut Pro Device Control Presets tab. A quick way to do this is to choose DV-NDF in the Easy Setup dialog in Final Cut Pro. (Refer to the Final Cut Pro documentation for more details on using Easy Setups.)

The naming of the source clips is important because you will need to connect clips to database records. In order to make the connection process as smooth as possible, use an easy naming scheme with the scene and take identifiers. For example, the clip for scene 33, take 1 could be named 33-1. Hyphens are fine in a clip name, but do not use a slash or colon.

Connecting Captured Source Clips to the Database
Since source clips and database records are created by different means at different times, you need to establish the link between a source and its record after they both exist. This process is called connecting a clip to a record. How you connect clips to the database depends on how you captured your clips.

If you captured your source clips by using a batch capture list: Use the Connect Clips command to automatically connect all your source clips to the database. See “Using the Connect Clips Command to Connect Source Clips” on page 103.

If you did not capture your source clips by using a batch capture list: You need to individually connect source clips to database records by using either the Detail View window or the Clip window. These two methods are equally easy and accessible, so the one you choose may depend on which window happens to be open. The Clip window is most convenient if you’re interested in selecting a new poster frame for each clip as you go, or if you want to use the Conform or Reverse Telecine feature on each clip immediately after you connect it to the database.

Keep in mind these basic rules for connecting clips:

- Each database record can have a maximum of one clip connected to it, and each clip can be connected to a maximum of one database record. In other words, you can’t have two clips connected to one database record, and you can’t have one clip connected to two different database records. Also, a database record does not have to have a clip connected to it.
- You can connect source clips to database records any time between the time you capture the clips and export lists.
- If you are working with camera-roll transfer video that has a continuous key number-to-timecode relationship, you can use the timecode-based method of film list generation so you don’t have to connect your source clips to database records. For more information, see “A Potential Database Shortcut for Camera-Roll Transfers” on page 65 and Appendix B, “How Cinema Tools Creates Film Lists,” on page 213.
Using the Connect Clips Command to Connect Source Clips

If you captured clips using a batch capture list, the Connect Clips command can connect your captured source clip files to the appropriate database records.

**Note:** The Connect Clips command doesn’t work on any source clips that are renamed after they are captured or on database records that already have a clip connected. If the database record is not connected to the right clip, use the Reconnect Clip command to fix it.

**To use the Connect Clips command to connect clips to the database:**

1. Make sure that the List View window displays the records to which you want to connect clips.

   To display all of the records in the database, click Find All in the Find dialog. See “Finding and Opening Database Records” on page 91 for details.

2. Choose Database > Connect Clips.

3. In the dialog that appears, navigate to select any source clip file in the folder where the clips are located. When the folder is selected, click Choose.

   For every database record that does not have a connected clip, Cinema Tools looks in the selected folder for a clip with a matching name. Each time Cinema Tools finds a matching clip, it connects the clip to the correct database record.

Avoid Moving or Renaming Your Source Clips in the Finder

Once a source clip is connected to the database, that link must be intact when you generate any film lists. If the link is broken, the lists will be incomplete. A clip-to-database link is broken if

- the source clip filename is changed
- the source clip file is moved or deleted

To fix broken links, see “Fixing Broken Clip-to-Database Links” on page 107.
104 Chapter 5
Capturing Source Clips and Connecting Them to the Database

Note: The poster frame for each connected clip does not appear in the Detail View window until you open that clip in the Clip window. In the Detail View window, click the Open Clip button to open the Clip window and make the poster frame appear.

Using the Detail View Window to Connect and Disconnect Source Clips
In the Detail View window, you can tell whether a database record is connected to a clip by looking at the button above the clip poster frame.

If the button is labeled Open Clip, the current database record has a clip connected to it. If the button is labeled Connect Clip, there is no clip connected to the database record.

To use the Detail View window to connect a clip to a database record:

1. Open the database record in the Detail View window.
   See “Finding and Opening Database Records” on page 91 for details.

2. Click the Connect Clip button.
   Note: If the button is labeled Open Clip, the database record already has a clip connected to it.
3 In the dialog that appears, select a clip to connect to the current database record.
When you select the clip, three things happen:
• The clip is connected to the database.
• A poster frame of the first frame of the clip appears in the Detail View window, and
  below the poster frame you see the name of the clip.

Tip: You can click the name or poster frame to open a Clip Analysis dialog that displays
more clip information.
• A Clip window opens for the clip. If you want a different frame to represent the clip
  in the database, go to that frame, then click the Poster Frame button. For more
  information about the Clip window, see “Clip Window” on page 52.

Note: If you don't want the Clip window to open after you connect a clip, press the
Command key when you click the Connect Clip button.

To use the Detail View window to disconnect a captured clip:
1 Open the database record in the Detail View window and press the Command key.
The Open Clip button changes to Disconnect Clip.
2 Click Disconnect Clip.

Note: Clicking this button breaks the link between the source clip and the record so
that they are no longer connected. It does not delete the clip from your hard disk.
Using the Clip Window to Enter or Disconnect Source Clips

When a clip has not been connected to a database record, the second button from the top in the Clip window is labeled Enter in DB. If a clip is already connected, the button is labeled Disconnect Clip.

The Enter in DB command offers you a way to create a database record for an individual source clip and connect it to the database at the same time.

To use the Clip window to enter a source clip in the database:

1. Choose File > Open Clip to open the clip in the Clip window, then select the clip in the dialog.
2. Click the Enter in DB button.
3. Enter a scene and take identifier for the source clip in the dialog that appears.
   
   See “Using Scene, Shot, and Take Identifiers” on page 75 for more information.
4. Click OK to connect this clip to the existing record in the database that corresponds to the scene and take you entered in the dialog. If no record exists for that scene and take, click the New button, and a new record is created.

In either case, the source clip in the Clip window is connected to the record, so the relationship is established in the database. A source clip can be connected to a record in more than one database, but within one database it can only be connected or related to one record. If the source clip is moved or renamed, the relationship should be re-created.

To use the Clip window to disconnect a captured clip:

1. Open the clip in the Clip window.
2. Click Disconnect Clip.

   Note: Clicking this button breaks the link between the source clip and the record so that they are no longer connected. It does not delete the clip from your hard disk.
Fixing Broken Clip-to-Database Links

When a source clip that has been connected to the database is renamed or moved, the link between the clip and the database breaks and the clip needs to be reconnected. For individual clips, clicking the Open Clip button in the Detail View window opens a dialog that lets you reconnect the clip to the database record. If a group (folder) of source clips has been moved, you can use the Reconnect Clips command in the Database menu to update any broken links to clips that are in the same folder as a clip you select (you only have to select one clip per folder).

Reconnecting Individual Clips That Have Been Renamed or Moved

To reconnect a source clip that has been renamed or moved:
1 Open the database record in the Detail View window.
   See “Finding and Opening Database Records” on page 91 for details.
2 Click Open Clip.
3 In the dialog that appears, click Reconnect, then select the clip.
   The clip is connected to the database record.

Locating Broken Links and Reconnecting Groups of Clips That Have Been Moved

For clips that have been moved (but not renamed), the Reconnect Clips command in the Database menu makes it easy to locate and fix the broken links for several clips in one folder. This command updates any broken links to clips that are in the same folder as the first selected clip, so you only have to select one clip per folder.

Note: When a disk volume containing clips is unmounted, Cinema Tools cannot find the clips until the volume is mounted again. You don't need to use the Reconnect Clips command to fix this kind of temporarily broken link. To reestablish such connections, simply mount the disk volume that contains the missing clips.
To locate and fix links that are broken because source clips have been moved:

1. Make sure that the List View window displays the set of records that you want to search for broken links.

   To display all of the records in the database, click Find All in the Find dialog. See “Finding and Opening Database Records” on page 91 for details.

2. Choose Database > Reconnect Clips.

   The set of records displayed in the List View window is searched. If a broken link is found, a dialog asks you to select the clip.

3. In the dialog, select the correct clip for the current record.

   Cinema Tools changes the link to reflect the new location of the clip, and also fixes any broken links to other clips that are in the same folder as the selected clip. As long as the clips have not been renamed, you only have to select one clip per folder.
Preparing the Source Clips for Editing

Spending some time with your source clips before you start editing can make the editing experience smoother.

Once the Cinema Tools database has been created and your source clips have been captured, there are a few key steps to take before you begin editing. See “Determining How to Prepare Source Clips for Editing,” next, for information on these processes.

If your audio and video were captured separately, see “Synchronizing Separately Captured Audio and Video” on page 123.

Also, in the interest of efficient use of disk space, you may want to eliminate some of the content you captured before you begin editing. See “Dividing or Deleting Sections of Source Clips Before Editing” on page 125 for information.

Determining How to Prepare Source Clips for Editing

The steps you need to take to prepare your clips for editing depend on the telecine speed, whether you have NTSC or PAL video, and which frame rate you plan to use for editing.

Your main goals are to

- set the video frame rate to match the frame rate at which you want to edit
- maintain or restore audio/video sync

*Note:* For information about working with 24P video, see Chapter 11, “Working With 24P Video and 24 fps EDLs,” on page 177.

Choosing an Editing Frame Rate

In general, it's a good idea to edit at the frame rate at which the picture was originally filmed and recorded. For example, if you film, record, and edit at 24 fps, then the audio, video, and the original sound and picture are at the same rate. When you edit at the same speed at which you filmed and recorded, you can digitize directly from the original sound recordings because the picture and sound are in sync. No adjustments need to be made for synchronization purposes.
There is an exception to this recommendation: In an NTSC environment, where you need to use NTSC equipment and output to NTSC tapes, you may prefer to edit at 23.98 fps because then you can take advantage of the Real-Time Effects pull-down feature in Final Cut Pro that lets you easily output your 23.98 fps video as 29.97 fps. This output conversion feature does not work on video that is 24 fps.

Keep in mind that if you record at 24 fps and then convert to 23.98 fps, your video is running at a speed slightly slower than that of the original recording. Because it is slower, it is called pulled down. When video is pulled down, the digitized sound also needs to be pulled down either by slightly slowing down the playback of the original sound tape or disk while digitizing (for example, in the telecine transfer process), or by adjusting the speed of the clip to 99.9 percent after capturing.

Ways You Can Prepare the Source Clips

There are a few different options to adjust your source clips to the frame rate at which you want to edit.

- **Use specialized hardware to capture at your chosen frame rate:** If you have the right equipment, you can use it to convert the frame rate in real time while the clips are captured and adjust the audio speed to match. Once you do this, the clips are already in sync do not require the Cinema Tools Reverse Telecine or Conform features for frame rate conversion.

- **Use the Reverse Telecine Feature:** If your clips are in the NTSC standard of 29.97 fps, you can use the Reverse Telecine feature to reverse the 3:2 pull-down that was used convert the clips to 29.97 fps, thus removing the extra fields created by the pull-down and converting the clips to 23.98 fps or 24 fps. When clips contain both audio and video, the Reverse Telecine feature also adjusts the audio speed so that the audio and video remain in sync after the frame rate is changed.

- **Use the Conform Feature:** If your clips are in the PAL standard of 25 fps, you can use the Conform feature to convert them to the frame rate at which you want to edit. When clips contain both audio and video, the Conform feature also adjusts the audio speed so that the audio and video remain in sync after the frame rate is changed.

**Note:** If the audio is separate and not contained in the source clips, you also need to sync audio and video clips and merge them together as one clip in Final Cut Pro. See “Synchronizing Separately Captured Audio and Video” on page 123.
Using the Conform Feature

Conforming a clip to a frame rate means that each frame in the clip is given an equal duration in seconds based on a frame rate you specify. For example, if you conform a clip with 360 frames to 24 frames per second, each frame becomes $1/24$ of a second, and the total duration of the clip is $360/24$ seconds, or 15.0 seconds. Use the Conform feature to change the frame rate of a clip to the frame rate at which you want to edit. If the clip contains audio and video, the Conform feature will also adjust the audio rate so that the audio and video remain in sync.

For help in deciding whether or not you should use the Conform feature, refer to “Determining How to Prepare Source Clips for Editing” on page 109.

Conforming One Clip at a Time

To conform a clip:

1. Choose File > Open Clip, then select the clip in the dialog.
2. In the Clip window, click the Conform button.
3. In the Conform Clip dialog, choose a new frame rate from the “Conform to” pop-up menu, then click Conform.

Important: Once the frame rate of clips are changed from 25 fps to 24 fps, Cinema Tools needs to use the clip-based method for generating film lists because the clips have new timecode for their new frame rate, making the timecode-based method unreliable. So, if you need to export any lists, make sure that there are database records for each source clip, and that the source clips are connected to the records. See Appendix B, “How Cinema Tools Creates Film Lists,” on page 213 for information on the two different methods.
Batch Conforming Several Clips at a Time
As an alternative to conforming the frame rate of each clip individually, you can use the Batch Conform feature to conform the frame rates of all the clips in a selected folder.

To batch conform:
1. Make sure all the clips you want to conform are in the same folder.
2. Choose File > Batch Conform.
3. In the dialog that appears, select any clip file in the folder that contains the clips you want to conform, then click Choose.
   Note: You only need to select one clip file. All the clips in the folder will be conformed.
4. In the Batch Conform dialog, choose a frame rate from the “Conform to” pop-up menu, then click Conform.

After the batch conform process is completed, the following occur:
- The clips are conformed to the chosen frame rate and placed in a Cinema Tools–created subfolder named Conformed [frame rate], where frame rate is the new frame rate for the clips. A folder might be named Conformed 24.0, for example.
- If Cinema Tools is unable to complete the conform process for a clip, that clip is moved into a Cinema Tools–created subfolder named Skipped. (A clip is not processed if it doesn’t contain a video track, if the frame rate is not supported, or if no codec is found for the video track.)
- A text file named conform.log appears at the top level of the folder. This log gives the date and time that the process started and ended, for each clip. If any problems were encountered, such as running out of disk space or memory, an error message describing the problem also appears in the log.
Reversing the Telecine Pull-Down

When you use a telecine to transfer your 24 fps film to 30 fps NTSC video, the typical way the 24 frames are distributed into 30 frames is by the 3:2 pull-down method. The 3:2 pull-down method, as described in “Frame Rate Basics” on page 22, inserts extra fields of video. The reverse telecine process removes the extra fields (as shown in the illustration below), returning the video to its original 24 fps frame rate. In other words, the reverse telecine process reverses the 3:2 pull-down. Reversing (or removing) the 3:2 pull-down provides a one-to-one relationship between the video and film frames so that your cut lists are accurate.

![Illustration of reverse telecine process]

**Important:** If your source clips originated from a special type of DV camcorder that shoots 24P, such as the Panasonic AG-DVX100 camcorder, a simpler form of the Reverse Telecine dialog appears. See “Removing 2:3:2 or 2:3:2:3 Pull-Down With Cinema Tools” on page 190 for instructions on reversing the pull-down for clips that originated from a 24P-capable DV camera.

**Tips for Using Reverse Telecine**

- Reverse telecine works best if the captured video does not have any dropped frames. If you attempt to use the Reverse Telecine feature on a clip that has dropped frames, a warning appears. See “Avoiding Dropped Frames” on page 96 for more information.
- If you have to reverse the pull-down for several clips, you might want to use the Batch Reverse Telecine feature instead, because it allows several clips to be processed at once. See “Using Batch Reverse Telecine” on page 119.
- Reversing the 3:2 pull-down with software is a time-consuming process; you’ll need to allow waiting time while your computer does its work. Hardware reverse telecine, performed by a third-party capture card while the video is captured into your computer, is a speedier option.
Determining the Field Capture Information

You need to enter field capture information in the Reverse Telecine dialog. Typically, all of your clips are generated with the same hardware and settings, so you only need to look at a few frames of one clip to determine the field capture mode. A clip can be captured as one field or both fields, with field 1 or field 2 dominance.

Look at the key number and timecode window burn on the video frames to determine the frame sequence and verify whether the video has one or two fields. The key number window burn usually includes the A, B, C, and D frame type indicators. (Also, the timecode often has the number “1” at the end to indicate field 1, and “2” to indicate field 2.) In the Clip window, use the arrow keys on your keyboard to step through a few frames of a clip and observe the sequence of film frame numbers. Refer to the table below to find out your field information.

<table>
<thead>
<tr>
<th>If the repeating frame sequence is</th>
<th>Then your video contains</th>
<th>In the Reverse Telecine dialog, select as Capture Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>AA, BB, BC, CD, DD or A1A2, B1B2, B3C1, C2D1, D2D3</td>
<td>Both fields, with field 1 dominance</td>
<td>F1 - F2</td>
</tr>
<tr>
<td>AB, BB, CC, DD, DA, or A2B1, B2B3, C1C2, D1D2, D3A1</td>
<td>Both fields, with field 2 dominance</td>
<td>F2 - F1</td>
</tr>
<tr>
<td>A, B, C, D or A1, B1, B3, C2, D1</td>
<td>One field, with field 1 dominance</td>
<td>Field 1 Only</td>
</tr>
<tr>
<td>A, B, C, D, D or A2, B2, C1, D1, D3</td>
<td>One field, with field 2 dominance</td>
<td>Field 2 Only</td>
</tr>
</tbody>
</table>
Using Reverse Telecine on a Single Source Clip

Use single-clip reverse telecine to perform reverse telecine on one clip.

**Note:** In most cases, you need window burn to use the Reverse Telecine feature because you need to examine the key numbers or timecode in the clip itself to make reverse telecine settings. However, if your source clips originated from a certain type of camcorder that shoots 24P, such as the Panasonic AG-DVX100 camcorder, you do not need window burn in order to reverse the pull-down. See “Removing 2:3:3:2 or 2:3:2:3 Pull-Down With Cinema Tools” on page 190 for specific information.

**To use the single-clip reverse telecine feature on a clip:**

1. Choose File > Open Clip, then select the clip in the dialog.
2. In the Clip window, position the playhead so that a still frame with clearly readable window burn is displayed.
   You need to see the window burn in order to identify the frame’s frame type for the Reverse Telecine dialog. Often the first frame will do, but any frame in the clip can be displayed. (Reverse telecine will be applied to the entire clip, regardless of which frame is displayed.)
3. In the Clip window, Click Rev Telecine.
4. In the dialog that appears:

---

### What Is Field Dominance?

The field dominance of a captured clip is determined by the telecine hardware, and is usually not configurable by the user. Video frames are composed of two fields; one field consists of all the even lines of the video, and the other field consists of all the odd lines. At the telecine, two fields are scanned at different times, which means that the film frame can advance between the time that the first field is scanned and the time that the second field is scanned:

- **When only one field is captured**, field 1 dominance means that only field 1 is captured, and field 2 dominance means that only field 2 is captured.
- **When both fields are captured**, field 1 dominance means that each captured frame is digitized from two video fields, but field 1 occurs earlier.

**Note:** With field 1 dominance, the two video fields digitized into each captured frame should have the same timecode address, because SMPTE timecode is specified as beginning on field 1. Field 2 dominance, when both fields are captured, means that field 2 occurs earlier, and that the captured frame contains video fields with two different timecodes.
5 Select the capture mode that indicates the correct field capture for the clip.
   • Field 1 Only: Select this option if the video contains only field 1.
   • Field 2 Only: Select this option if the video contains only field 2.
   • F1 - F2: Select this option if the video contains both fields, and field 1 is the dominant field (the first field to appear).
   • F2 - F1: Select this option if the video contains both fields, and field 2 is the dominant field.

See “Determining the Field Capture Information” on page 114 for more information.

Note: If Cinema Tools finds pull-down information embedded in the source clips, a simpler version of this dialog appears. See “Removing 2:3:3:2 or 2:3:2:3 Pull-Down With Cinema Tools” on page 190.

6 Select the item along the bottom that indicates the type of frame currently displayed in the Clip window.

Your frame type choices vary depending on the field capture mode you selected.

---

Choose the frame type that corresponds to the frame showing in the Clip window.

If you want to see the choices as letters and numbers (for example, A2, B2, C1, and so on), choose Style 2 from the pop-up menu.

Different choices are available when a different field capture mode is selected.
7 Select “New (smaller)” or “Same (faster)” to specify the kind of file you want the Reverse Telecine feature to create:

- **New (smaller):** Creates a new clip file that does not contain the extra frames introduced by the 3:2 pull-down. The new file is about 20 percent smaller, but this method is slower. Regardless of whether the original file was referencing or self-contained, this method creates a self-contained file. See “The Difference Between Self-Contained and Referencing Clips” on page 126 for more information.

- **Same (faster):** Modifies the current clip file so that the extra frames are not visible to the editing system, but the data is not removed from the file. This process is faster, but does not reduce the size of the file. The resulting file is self-contained if it was originally self-contained, or referencing if it was originally referencing.

**Note:** This “Same (faster)” method is only available when the clip has been captured or recompressed to have only one field per frame. This is because reversing the 3:2 pull-down for a clip with two fields per frame requires deinterlacing two different frames, removing one field from each of those two frames, and then making a new frame out of the other two fields. When new frames are being created, a new movie file must be created.

**Tip:** If you choose the “New (smaller)” method, the original file is no longer needed, but it is not automatically deleted. A dialog suggests the name of the new file to be the name of the original with the extension .rev. To delete the original file by replacing it with the new one, remove the .rev extension in the dialog so that the new file has the same name as the original.

8 From the “Conform to” pop-up menu, choose the frame rate that allows you to maintain or restore audio/video sync.
• 23.98: This frame rate is useful if you want to later use the Final Cut Pro pull-down feature that lets you output 23.98 fps video as 29.97 fps video. (See “Pull-Down Patterns You Can Apply to 23.98 fps Video” on page 194 for more information.)

• 24.0: You may want to conform and edit the clips at this rate if you plan to include them in a project that contains other clips that are exactly 24 fps.

Note: If the audio and video are contained in the same clip, and you choose 24.0 from this pop-up menu, the Reverse Telecine feature increases the audio speed by a very small percentage so that it is in sync with 24 fps instead of 23.98 fps.

9 Leave the “Standard upper/lower” checkbox checked.

The “Standard upper/lower” checkbox should be checked unless you find that the reverse telecine process does not produce the correct results. It is only relevant when both video fields are captured, and has no effect if only one field was captured. For more information, see “Checking Your Reverse Telecine Results” on page 119.

10 Click OK to start the reverse telecine process.

If you selected the “New (smaller)” file option, you are asked to give the new reversed clip a name and location. If the original clip was connected to a database record, the new reversed clip replaces its connection to the record (regardless of whether or not the new clip overwrites the old clip).

Note: Occasionally there are clips with average frame durations that are longer than they should be. This situation can cause the Reverse Telecine feature to report one or more dropped frames, when in fact there are not any. If you see this message, try using the Conform feature, described in “Using the Conform Feature” on page 111, to conform the clip to 29.97 fps before starting the reverse telecine process again. The Conform feature ensures that all the frames are the same length.
Using Batch Reverse Telecine
If you need to reverse the telecine 3:2 pull-down of several clips, you can use the Batch Reverse Telecine command to process several clips at once.

Note: If your source clips originated from a certain type of DV camcorder that shoots 24P, such as the Panasonic AG-DVX100 camcorder, see “Removing 2:3:3:2 or 2:3:2:3 Pull-Down With Cinema Tools” on page 190.

Preparing to Use Batch Reverse Telecine
There are a couple of things you should do before using batch reverse telecine.

- Before you start a batch reverse telecine process, use the single-clip reverse telecine process on one of your clips and check the results to make sure the settings you plan to use work correctly. For instructions, see “Using Reverse Telecine on a Single Source Clip” on page 115.

- If you are working with video that contains two fields, make sure that all your clips have the same field dominance. For help, see “Determining the Field Capture Information” on page 114. Some digitizing hardware may switch unpredictably between F1 - F2 and F2 - F1 field dominances. If you find that some of your clips have one and some have the other, you can separate your clips into two field dominance batches and batch process them separately.

Checking Your Reverse Telecine Results
After a telecine 3:2 pull-down transfer, the upper field is typically field 1 and the lower field is field 2, except when using DV. Normally, when the “Standard upper/lower” checkbox is checked, Cinema Tools determines what needs to be done and the clips are processed correctly. However, on rare occasions, video is captured or processed in such a way that field orders are switched, and this can result in flawed reverse telecine results.

To check your results, look at the frames of a clip that has been processed by reverse telecine. As you look at each frame in the clip, you should see the sequence of A, B, C, and D frames repeat and each letter should be clearly legible. You should not see any inter-field flicker. The film frame numbers should increase sequentially and those digits should also be clearly legible. If not, try using the reverse telecine process again, but without selecting the “Standard upper/lower” checkbox.
About “A” Frames

If your video has window burn, the easiest way to locate an A frame is to look at the key number in the video frame, which typically has a letter after it indicating the frame type. This letter is called the frame type indicator. “A” frames include any frame with a frame type indicator that begins with A, including an AA (also known as A1A2), AB (also known as A2B1), A1, or A2 frame. When viewing the video a frame at a time, the frame type indicator for an A frame shows an A while the frame number is solid (not flickering between two frames).

If you are using non-drop frame timecode and your source clips have not yet been edited, there is a reliable five-frame pattern where an A frame occurs every five frames. Usually, any timecode number ending in 0 or 5 is an A frame, for example, 1:23:14:10 and 1:23:14:15.

During batch reverse telecine, if a clip starts on a timecode number that is not evenly divisible by five (that is, timecode numbers ending in 5 or 0), Cinema Tools trims frames from the beginning of the clip so that the clip starts on the next timecode that ends in 0 or 5. This is done to make sure that all source clips start on an A frame. Clips that are trimmed are noted in the batch reverse telecine log file, which is named reverse.log.

When key numbers are not burned in to the video, finding an A frame is much more difficult. If there is a lot of motion in the video, you might be able to distinguish one of the original film frames from the next in the video. In that case, look for a video frame made up of two fields from the same original film frame, which has different film frames before and after it. Such a frame would be an A frame.
Using Batch Reverse Telecine for Multiple Source Clips

Before you use batch reverse telecine to process multiple source clips, be sure to read “Preparing to Use Batch Reverse Telecine” on page 119.

To use batch reverse telecine:

1. Place all the clips that you want to process into one folder.
2. Choose File > Batch Reverse Telecine.
3. In the dialog that appears, select any source clip file in the folder that contains the source clips, then click Choose.
4. In the Batch Reverse Telecine dialog that appears, select the Capture Mode that indicates the correct field capture for the clip.

- **Field 1 Only**: Select this option if the video contains only field 1.
- **Field 2 Only**: Select this option if the video contains only field 2.
- **F1 - F2**: Select this option if the video contains both fields, and field 1 is the dominant field (the first field to appear).
- **F2 - F1**: Select this option if the video contains both fields, and field 2 is the dominant field.

See “Determining the Field Capture Information” on page 114 for more information.
Note: If Cinema Tools finds pull-down information embedded in the source clips, a simpler version of this dialog appears. See “Removing 2:3:3:2 or 2:3:2:3 Pull-Down With Cinema Tools” on page 190.

5 From the “Conform to” pop-up menu, choose the frame rate that allows you to maintain or restore audio/video sync.

- 23.98: This frame rate is useful if you want to later use the Final Cut Pro pull-down feature that lets you output 23.98 fps video as 29.97 fps video. (See “Pull-Down Patterns You Can Apply to 23.98 fps Video” on page 194 for more information.)
- 24.0: You may want to conform and edit the clips at this rate if you plan to include them in a project that contains other clips that are exactly 24 fps.

Note: If the audio and video are contained in the same clip, and you choose 24.0 from this pop-up menu, the Reverse Telecine feature increases the audio speed by a very small percentage so that it is in sync with 24 fps instead of 23.98 fps.

6 Leave the “Standard upper/lower” checkbox checked.

The “Standard upper/lower” checkbox should be checked unless you find that the batch reverse telecine process does not produce the correct results. For more information, see “Checking Your Reverse Telecine Results” on page 119.

7 To save the original clips in a separate folder, leave the Keep Originals checkbox selected. If you don’t want to save the original clips, deselect it. (When you deselect it, the original clips are deleted as each new clip is created.)

8 Click OK to start the batch reverse telecine process.

After the process is complete, the following occur:

- For each clip in the folder, a new clip with the same name is created and placed in a Cinema Tools–created subfolder named Reversed.
- If you selected “Keep Originals,” the original files are placed in a Cinema Tools–created subfolder named Originals.
- If Cinema Tools is unable to complete the reverse telecine process for a clip, that clip is moved into a Cinema Tools–created subfolder named Skipped. A clip is not processed if it doesn’t contain a video track, if the frame rate is not supported, or if no codec is found for the video track.
- A text file appears at the top level of the folder you started with, named reverse.log. This log gives the date and time that the process started and ended, as well as a start time for each clip. If any problems were encountered, such as running out of disk space or memory, an error message describing the problem also appears in the log.
Making Adjustments to Audio Speed

If you need to make audio speed adjustments in order to re-establish synchronization with the video, there are various ways you can do this.

Note: The reverse telecine and conform processes automatically adjust the audio speed in a clip to match changes made to the video frame rate of the same clip.

- You can adjust the speed with the Final Cut Pro Speed command. First, unlink the audio and the video clips. Select the audio clip in the Timeline, then choose Modify > Speed and enter a new speed percentage. For example, to slow down an audio clip by 0.1 percent, enter 99.9. Relink the audio and video clips when you are finished modifying the speed of the audio clips.

- Some audio recorders and playback equipment can have the speed of their playback adjusted to sync with the video. When using such equipment, you can capture the audio with the correct speed for synchronization.

- You can use specialized equipment, such as that available from Aaton, designed to control and adjust the audio for proper sync with any video rate. You use this equipment before capturing the audio into your computer.

- If you don't need the audio speed adjusted for editing, but you do need it adjusted for the finished project, you can have the audio finished at an audio postproduction facility that can adjust the speed.

Synchronizing Separately Captured Audio and Video

If your sound and picture were not synchronized onto videotape, but were instead captured separately, you can synchronize them in Final Cut Pro.

In Final Cut Pro 4, a new feature called merged clips lets you link one or more source media files together so that they become one clip. First you synchronize them, and then you merge them into one clip.

The clapper boards (also called slates) in your shots provide the audible and visible cues on which to sync your audio and video clips. There are a couple of different techniques you can use to synchronize clips before merging them, depending on how you shot your footage.
If the timecode of your video and audio clips isn't identical, and you slated all your shots at the beginning with a clapper board, you can use In points to line up all the clips you want to merge. When you do this, the beginning of the resulting merged clip corresponds to the In point you used, and all the clips line up at that point. The end of this merged clip corresponds to the end of the clip with the latest timecode value.

If the timecode of your video and audio clips isn't identical, and you have one or more shots that you tail-slated at the end, you can use Out points to line up all the clips you want to merge. When you do this, the end of the resulting merged clip corresponds to the Out point you used, and all clips line up at that point. The beginning of this merged clip corresponds to the beginning of the clip with the earliest timecode value.

For details on how to synchronize and merge clips in Final Cut Pro, see the section in the Final Cut Pro documentation that describes working with merged clips.
Dividing or Deleting Sections of Source Clips Before Editing

Before you edit your media in Final Cut Pro, you have the option of further dividing or eliminating parts of source clips. If you used a batch capture list and device control for capturing, you may have captured your source clip files exactly as you want them. On the other hand, you may feel that the captured source clips need to be broken down into individual takes, or you may want to eliminate some of the content you captured before you begin editing in order to make efficient use of available disk space.

Strategies for Breaking Down Source Clips Before Editing

Before you begin, if the edge code number-to-timecode relationship is not continuous throughout the camera roll from which a source clip came, be aware that there are a couple important things you need to do after you break down source clips:

1. Create a new database record for the new source clip that is created when you break down a clip, and make sure the new source clip is connected to the database record.

2. Update the clip’s database record so that the edge code number information is correct for the clip’s new first frame. (This is only necessary if you delete material from the beginning of a clip.)

Note: See “Is Your Edge Code Number-to-Timecode Relationship Continuous or Noncontinuous?” on page 64 for more information.

There are variety of ways to break down source clips before editing:

- An easy way to break source clip files into smaller source clips is to use Final Cut Pro. First, make one or more subclips from the clip in the Browser. You can then use the Media Manager to delete any part of the clip that you did not select as a subclip. See the section on creating and working with subclips in the Final Cut Pro documentation for more information.

- Another way to select and save portions of a clip is to use QuickTime Pro. If you use QuickTime Pro for this purpose, be sure to choose “Make movie self-contained” in the “Save as” dialog. See “The Difference Between Self-Contained and Referencing Clips” on page 126.

- If you are using hole-punched or otherwise marked frames (rather than window burn) to identify the key numbers for each of your source clips, make sure you do not trim off any of the marked frames.

- If the telecine transfer involved the 3:2 pull-down method, it’s a good idea to start each source clip on an “A” frame. After the 3:2 pull-down, A frames are the only film frames that are not divided into two video frames. Because of this and because the A frame is the start of the video five-frame pattern, it is preferable to have one as the first frame in all video clips. See “About “A” Frames” on page 120.
The Difference Between Self-Contained and Referencing Clips

There are two basic video and audio file types that you need to be aware of, especially if you are breaking a clip into smaller ones using QuickTime Pro. Since video files tend to be large, the type of clip you create can have a large impact on your hard disk space.

- Self-contained clips: A self-contained clip is complete; you can delete the original clip and its duplicate will still play on its own. For that reason, self-contained clips are typically large files. It's a good idea to save your clips as self-contained if you intend not to use large portions of the original, and then delete the original once you have saved the bits you want.

- Referencing clips: A referencing clip is a clip with dependencies on the original clip. Referencing clips do not contain any actual media content—they only contain pointers to a specific part of the original clip. The files for these clips are small. If you delete, move, or rename the original clip, any clips that reference it will no longer play, since they cannot locate the original.

One way to tell if a clip is self-contained or referencing is to open it in the Cinema Tools Clip window and click the Info button. The Info dialog displays this information. Another way to tell is to look at its file size—clips with dependencies have small (20 kilobyte or so) file sizes while self-contained clips, even short ones, can have file sizes up to hundreds of megabytes or more.

Deleting a Source Clip File

To eliminate an unwanted source clip before you start editing, drag the clip to the Trash. Then, if there is a record for that clip in the Cinema Tools database, delete that database record. Refer to “Deleting a Database Record” on page 85 for more information.
Editing film-based source clips in Final Cut Pro presents some unique issues.

Once your source clips have been captured and prepared, you can edit them in Final Cut Pro. Before you begin editing material that originated on film, you need to be aware of the following:

- the Easy Setups provided for Cinema Tools users, and the need to set the editing timebase
- restrictions for using multiple audio and video tracks
- the process for creating effects and transitions for film
- how to track duplicate uses of your source material

About Easy Setups and Setting the Editing Timebase

Cinema Tools installs Easy Setups that were created to make setting up Final Cut Pro convenient for Cinema Tools users. When you select an Easy Setup in Final Cut Pro, your sequence presets, capture presets, device control presets, and external video presets are all set for you so that you don’t have to select them individually. Cinema Tools users may want to take advantage of these Easy Setups:

- **23.98fps from DV PAL**: Choose this Easy Setup to capture PAL video and to set the editing timebase to 23.98 fps.
- **24fps from DV PAL**: Choose this option to capture PAL video and to set the editing timebase to 24 fps.
- **23.98fps from DV NTSC**: Choose this option to capture NTSC video (in the non-drop frame timecode format) and to set the editing timebase to 23.98 fps.
- **24fps from DV NTSC**: Choose this option to capture NTSC video (in the non-drop frame timecode format) and to set the editing timebase to 24 fps.
- **DV-NDF**: Choose this option to capture NTSC video (in the non-drop frame timecode format) and to set the editing timebase to 29.97 fps.

Refer to the Final Cut Pro documentation for details on accessing and working with Easy Setups.
Important: If you don’t use an Easy Setup, you still need to set the editing timebase, before you begin editing, to the frame rate of your source clips. This ensures that new sequences you create in Final Cut Pro are set for the frame rate at which you want to edit. See the Final Cut Pro documentation for details on setting the editing timebase in the Sequence Preset Editor.

All Easy Setups designed specifically for Cinema Tools users have the name Cinema Tools in the title. For example, “Cinema Tools - 23.98fps from DV NTSC.”

By default, the Easy Setups for Cinema Tools users do not appear in the pop-up menu in the Choose Setup dialog. To see all the Easy Setups in the pop-up menu, including the ones for Cinema Tools, select the Show All checkbox in the dialog.

Or, to add specific Easy Setups to the pop-up menu, you can add an asterisk (*) to the end of the setup file name. For example, you would edit the “Cinema Tools - 23.98fps from DV NTSC” file name to look like this: Cinema Tools - 23.98fps from DV NTSC*

The Easy Setup files are found in the following location: /Library/Application Support/Final Cut Pro System Support/Custom Settings/.

Restrictions for Using Multiple Tracks
Final Cut Pro allows you to edit on multiple video tracks and multiple audio tracks. While there are advantages to using numerous tracks, there are some restrictions when you are using Cinema Tools:

• In the Final Cut Pro Timeline:
  • Anything you place on any video track other than tracks 1 and 2 will be ignored by Cinema Tools, and will not appear in the film list.
  • All your video edits and transitions have to be on video track 1.
  • All superimposed effects or titles have to be on video track 2.
• If you are going to export an audio Edit Decision List (EDL), you need to limit the audio to the first eight tracks in the Final Cut Pro Timeline. See “Exporting an Audio EDL” on page 161 for more information.

Using Effects and Transitions
Final Cut Pro provides extensive effects capabilities for video, including common film effects such as dissolves, wipes, motion effects, and titles. When you are planning to finish on film, remember that these effects need to be re-created on film, but you can still use Final Cut Pro in the creative process to determine and demonstrate the effects you want.
Effects and transitions are usually created for digitally edited film in the following ways. Due to the changing and diverse nature of the industry, your actual experience may vary.

- **Basic transitions, titles, and motion effects:** These effects are typically re-created by a facility specializing in optical or contact printing, which uses the instructions given in a Cinema Tools–generated film list. Certain types of transitions can be created through contact printing (sometimes called A/B roll printing), where the emulsion sides of the original camera negative and the print stock are in contact as the original film is projected onto the print stock. Transitions, titles, and motion effects can be made through optical printing, where effects are created via a process of manipulating and projecting the original camera negative onto print stock through the lens on an optical printer. This process is often called creating opticals. Some factors in choosing whether to use optical printing or contact printing are discussed in “Contact Printing vs. Optical Printing” on page 132.

- **Complex effects that involve compositing:** Effects such as bluescreening, animation, and motion can be re-created digitally at high resolution with a high-end digital film workstation and then output back to film using a digital film recorder. This is sometimes called the film-digital-film method. First, the original camera negative is scanned digitally, then the scanned digital copy is imported into a digital film workstation and your special effects are created there before being recorded back to film. There are digital effects labs that offer this service, using your film list as a guide in determining the location and duration of motion effects and of superimposed compositing effects such as bluescreens. While the film-digital-film method can produce wonderful effects, be aware that it can be much more expensive than optical printing.

  **Note:** Digital film restoration and artifact removal are other types of digital manipulation that commonly occur with the film-digital-film method. This kind of digital manipulation is not tracked by a cut list, but sourced out to a lab.

**What About Color Correction and Filters?**
Final Cut Pro offers many color correction and filter capabilities, but these are not effects that can be tracked by a cut list. Any color correction or filter-like effects in your finished film are created by a specialist at a film-printing facility or via the film-digital-film method. You can work directly with a color specialist (often known as a color timer) to include color correction in your film.
Including Titles, Supers, and Transitions
The following workflow shows you how effects, supers, and transitions might be added
to a film that is edited in Final Cut Pro. This is a very basic workflow, containing steps
for including both opticals and contact-printed effects in your film, though you may
have only one or the other.

*Important:* With the fast-changing, diverse nature of the industry, your best workflow
may be different from the one described here. Make sure you consult your lab for the
most accurate instructions and options for your unique situation.

**Step 1: Confirm support and needs with the lab**
Depending on your budget, before you edit you should check with the lab (the optical
house or other facility that will print your effects) in order to find out what they can
offer. Often they’ll have standard effects for you to choose from—custom effects may
cost substantially more or not be available at all. They can also educate you about what
exactly they will need from you.

**Step 2: Create effects and transitions in Final Cut Pro**
*Important:* Make sure you place all titles and superimposed images or frames on video
track 2 in the Timeline, so that they will be properly recorded in the list you export.

It’s helpful to experiment with styles and durations in Final Cut Pro. That way you’ll be
confident in communicating what you need to your lab.

**Step 3: Export a film list**
When you’re done editing your program, export a film list, as described in Chapter 8,
“Generating Film Lists and Change Lists.” The film list can contain a number of different
types of lists. The optical list includes descriptions of transitions and motion effects. The
foreground layer cut list describes the titles and supers you need. If you are going to
have all of your transitions contact printed instead of having opticals created, choose
“All are cuts” from the Transitions pop-up menu. See also “Dividing Transitions Between
a Contact and Optical Printer” on page 134.

**Step 4: (Optical printing) Give the film list and any appropriate footage to the lab**
If you are having effects and transitions created as opticals, your lab uses the
specifications and descriptions in your film list as a guide for creating the opticals. They
need relevant film footage from which to create the opticals. Your optical lab may want
you to have *interpositives* printed for them, or they may print the interpositives
themselves. They may also like a videotape of your movie to use as a reference. If
you’ve made a workprint, you can let them refer to the workprint, or you can give the
lab a color copy (*dupe*) of the parts of the workprint that contain the opticals. Discuss
the options with your lab.
About Interpositives
Because the original footage is negative, the whole film must be printed from negative images in order to result in a normal, positive film image. This means you want your opticals to be negative when they are spliced into your original camera negative. The optical lab typically uses a low-contrast film print (of the relevant parts of the original camera negative) called an interpositive as the raw source footage from which to assemble the opticals. After the opticals are assembled from the interpositive, they are printed as optical negatives that can be spliced into the original camera negative.

Usually, before the final interpositive is created, one or more trial prints are made with the guidance of a color specialist in order to find the proper combination of exposure and color balance.

Note: In some cases, when opticals need a very stable image (as with images behind text), a registration interpositive is required. Registration interpositive printing minimizes unwanted lateral film motion in the optical printer gate. The optical lab will tell you when a registration interpositive is needed.

Step 5: (Optical printing) Transfer the opticals using a telecine, add them to the database, capture them into your sequence, and export a cut list
If you are having opticals created for your film, this step is ideal because it provides a cut list that most accurately documents the opticals, and because it allows you to preview the opticals in your sequence and see if you like the way they work.

Alternatively, if you have a workprint, the negative cutter may be able to use it as a guide for cutting the opticals into your film so that you don’t need to transfer them to video and create a new cut list. Be sure to check with your negative cutter to find out what they require.

Step 6: (Optical printing) Give the optical negative to the negative cutter
Assuming you have screened the opticals and are happy with them, give the optical negative, along with the original camera negative and your entire film list, to the negative cutter. With the film list (and the workprint if there is one) as a guide, the negative cutter will cut and splice the effects into your film.

Step 7: (Contact printing) Give the film list to the contact printer
When the conformed negative is ready to be printed at the contact printer, make sure the contact printer is given a film list that includes information about your titles and supers and any transitions you want them to print into the film.

Note: The negative cutter makes a list of printer cues, including transition needs, and this list is given to the printer with the cut original camera negative.
Contact Printing vs. Optical Printing

Choosing between contact printing and optical printing depends on several factors. The good news is you can have some effects created one way and others another way. Here are factors you may want to weigh:

- **Saving original footage:** Contact printing requires the original camera negative to be cut and spliced. Optical printing essentially results in a new negative being made, so the original footage can be used again elsewhere.

- **Previewing:** If your transitions are printed on a contact printer, you don’t have the option of seeing the finished transition before the negative is cut, but if they are printed optically, you do. After they are printed, transitions and motion effects may not appear exactly as they did within your digital editing system. If you want to know exactly how a transition is going to appear in the finished film, have it made optically before finalizing the cut. Then, transfer the optical to video. You can edit the transferred optical into your digital program to see how it will look.

- **Cost:** If you have standard length transitions and there are a lot of them, it will probably cost less to have them printed on a contact printer. In addition, with opticals it’s ideal to have them transferred to video, which is another expense, so you can capture them and create a new cut list. It’s a good idea to compare quotes for having your transitions printed in different ways.

- **Length:** Contact printing requires that the length of the transition be one of a set of standard lengths, while optical printing does not. Cinema Tools identifies the set of standard lengths for 24 fps or 23.98 fps media as 16, 24, 32, 48, 64, and 96 frames in duration. Cinema Tools identifies the set of standard lengths for 29.97 fps or 30 fps media as 20, 30, 40, 60, 80, and 120 frames in duration. (Be sure to check with your contact printer about the standard lengths they require for different frame rates.)
Comparing Quotes
To ask for quotes, export different film lists to give to the printers:
1 In the Film Lists dialog, choose “All are cuts” from the Transitions pop-up menu to export a film list for a contact printing quote.
2 After exporting that list, choose “All are opticals” from the Transitions pop-up menu to export a film list for an optical printing quote.
Dividing Transitions Between a Contact and Optical Printer

You can have standard length transitions created by a contact printer and the rest of the transitions created as opticals.

You do this by exporting a film list in which standard-length transitions are listed as cuts for printing on a contact printer, and nonstandard-length transitions are listed as opticals.

- In the Film Lists dialog, choose “Std are cuts” from the Transitions pop-up menu.

For more information about generating a film list, see “Exporting Film Lists” on page 145.

Tracking Duplicate Uses of Source Material

Cinema Tools makes it possible to track multiple uses of the same source material in your edited sequence. There are two basic reasons to do this:

- If you want to use the same source material more than once in your project, you can export a duplicate list (dupe list) and give it to your lab as a part of a duplicate negative order.
- If you don't want to spend the money required to create a duplicate negative, you need to be careful not to edit in a way that uses the same source material more than once since there is only one original camera negative. When editing digitally, it's so easy to use the same material twice that you may not even realize that you've done it, but Cinema Tools lets you check for duplicate usages on a regular basis.
In determining whether or not any frames have been used more than once, Cinema Tools assumes, due to typical A and B roll film splicing (also called checkerboarding), that there is at least one half of a frame lost at both the In point and the Out point of each cut of film. In Cinema Tools, these frames are called cut handles. Some negative cutters may want to use more than a half-frame on each side of a cut. In the Film Lists dialog, you can specify up to five and one-half frames of cut handles. If you inadvertently include, in a sequence, frames that are needed as cut handles, Cinema Tools reports them as duplicate usages in the dupe list and the double usage warnings.

It’s important to check for duplicate usages before you lock the picture and prepare to have the original camera negative cut. To find out how to export a dupe list and include duplicate usage information in a film list, see Chapter 8, “Generating Film Lists and Change Lists,” on page 137.

**Using Nested Sequences When Checking for Duplicate Uses**

If you are editing your project as multiple sequences (for example, one sequence for each reel), it’s best to place all the sequences together before exporting a dupe list. This way Cinema Tools will be able to find duplicate usages across the entire feature. An easy approach is to place all the sequences into a nested sequence before generating a dupe list.

However, when you intend to export a film list, do not nest part of one sequence into another sequence. Only whole-sequence nesting is supported when you export a Cinema Tools list. See the Final Cut Pro documentation for information on creating a nested sequence.
Ensuring Cut List Accuracy While Editing 3:2 Pull-Down or 24&1 Video

With 3:2 pull-down NTSC video or 24&1 PAL video, a film frame that is matched back from your edits may turn out to be the one before or the one after your original edit point. (This is explained in “Frame Rate Basics” on page 22.)

With 3:2 pull-down NTSC video, you can avoid such match-back inaccuracies by using the Cinema Tools Reverse Telecine feature or third-party hardware reverse telecine to reverse the 3:2 telecine pull-down before you begin editing.

If you did not reverse the 3:2 pull-down in NTSC video (or if you are working with 24&1 PAL video), you can still avoid cut list inaccuracies through careful editing. Your goal for each clip is to make sure that the frame showing the slate, or the last frame of the previous shot, doesn’t end up in the final film:

- When setting edit points for a clip, be careful not to place the In point at the first good frame in the clip, or the Out point at the last frame. In other words, set the In point at least one frame after your shot starts and the Out point at least one frame before the last frame in the shot.
- If you must edit on the first or last frame of a shot, make a note of the key number from the window burn, and review the cut list later to confirm that the key number is the same in the cut list.
- Avoid putting In or Out points at frames with two fields that contain two different frames from the film. For example, don’t place an edit at a BC or CD frame.
Generating Film Lists and Change Lists

Cinema Tools can create a variety of lists from your edited project.

When you're done editing and ready either to have the original camera negative cut or to conform a workprint, it's time to export a film list. Using the information in the database, Cinema Tools translates the edits made in Final Cut Pro into information a negative cutter can use as a guide. This information is provided in the form of a cut list. A number of other lists that are useful for film can be exported with the cut list. All of these lists, including the cut list, are called film lists.

One film list file can contain several related lists, including any of the following:

- **cut list**: A list of edits and titling information (also known as an assemble list)
- **missing elements list**: A list of any required information that could not be found in the database
- **dupe list**: A list of duplicate usages of the same source material
- **optical list**: A list for the effects printer, describing any transitions and motion effects
- **pull list**: A list to aid the lab in pulling the negative rolls they need
- **scene list**: A list of all the scenes used in your program and the shots used in the opticals

You can generate another type of list, called a change list, after an initial cut list has been created. The change list assumes a workprint has been cut to the specifications of a cut list (or prior change list) and it specifies further changes to make to the workprint, based on edits you have made to the sequence in Final Cut Pro. See “Creating Change Lists” on page 151 for information about creating change lists.
Lists You Can Create With the Film Lists Dialog

You can export a number of useful lists by using the Film Lists dialog. When you export a film list, one film list file is generated, and that file contains all the lists you selected in the Film Lists dialog. Any lists that you did not specifically select will not be included in the exported film list file.

Cut List

The first list you can select to export is the cut list. The cut list you export from Final Cut Pro is the list that contains the instructions for cutting the original camera negative or workprint to match the digitally edited program. Cut lists are also known as assemble lists.

If there are any titles (including any “supers”—superimposed images or frames) in your sequence, you actually get two different types of cut lists when you export a cut list:

- The first list contains the basic edits for cutting the film—the edits on video track 1. It is called the cut list, and it looks like the cut list shown above.
- The other list is called the foreground layer. This list records any titles and supers that appear on video track 2. It’s called the foreground layer because it overlays the first video track. (It does not contain any transition information, however. It shows only where the titles and supers occur.)

Note: A cut list is produced even if some elements are missing. When there is a picture element for which there is no corresponding information in the database, “<missing >” appears in the fields for the film roll and edge code information in the cut list.

See “Using Effects and Transitions” on page 128 for more information.
**Missing Elements List**

The missing elements list lists all of the clips in a sequence for which a corresponding database record either was not found or did not contain all of the necessary information. It is important that you export and examine a missing elements list to make sure that there are no elements missing before the negative cutter begins conforming the negative.

For each clip listed in the missing elements list, the element that is missing is specified. The shot number where that clip appears in the cut list is called out on a separate line.

If any of the following are missing, they are listed in the missing elements list:

- lab, camera, or daily roll
- key number or ink number

Additionally, each source clip must be connected to a record, unless you can use the timecode-based method for cut list generation (see “A Potential Database Shortcut for Camera-Roll Transfers” on page 65). To use the timecode-based method for cut list generation, each record must also include these elements:

- video reel
- timecode and duration
Resolving Missing Elements

Resolving a missing element means finding the corresponding database record, if it exists, and filling in the missing information, or creating a new database record if none exists. To locate the database record, there are two basic approaches.

If the name of the clip is in the missing elements list:
You can use the clip name to look for the clip in the List View window. In the List View window, click Clip to sort the records by clip name. Or, if the clip name includes its Scene identifier, you can use the Find command to search for it by the Scene identifier. If no database record is found for the clip, create one and connect the clip to it. Use the Identify feature in the Clip window to enter the required information.

If the video reel and timecode appear in the missing elements list:
You can use the reel and timecode to look for an existing database record for the clip. In the List View window, choose Video from the pop-up menu at the bottom of the window. Click Reel or Timecode to sort the records by the video reel or timecode. Look for the missing video reel or timecode (or similar timecode). Keep in mind that the timecode given in the missing elements list is not likely to match the database record exactly because the timecode in the database corresponds to the first frame of the clip. You know it’s a match if the timecode in the missing elements list occurs before the end of the timecode duration specified in the database record.

Note: Remember that the video reel name must appear exactly as it appears in the missing elements list. For example, reel “001” will not match reel “0001.”

- If you find the timecode, but the video reel name doesn’t match the one listed in the missing elements list, update the reel name in the database record or change it in Final Cut Pro.
- If the reel name matches one or more records in the database, but the missing elements list tells you that the database record is missing, the timecode is incorrect. The best way to resolve this is to create a new database record and connect the source clip to it. Then you can use the Identify feature to determine and enter the edge code and timecode information for the clip. If you create a new database record, delete the incorrect one that it replaces. Alternatively, you can update the Video Timecode or the Video Duration field in the database record, but then you also have to update the Key and Ink fields.
Dupe List and Double Usage Warnings

When editing digitally, it's easy to include a clip or part of a clip more than once in the edited program. When this happens, you either have to create a duplicate negative or reedit the program to remove the duplicate (dupe) usages, because the footage exists only once on the original camera negative. But first, you have to know where the duplicate usages are, and that is the purpose of the dupe list and double usage warnings.

Dupe List

The dupe list is what you give to your lab if you want them to pull specific shots from your negative rolls and make duplicate negatives for you. It documents every shot for which there is one or more duplicate usages.

Note: Content that is part of an optical is not counted as a duplicate usage. However, if a dissolve transition is placed between two clips that have no other source footage available between them (such as two clips that were originally one clip), it results in a duplicate usage.

Double Usage Warnings

If you choose Warn from the Duplicates pop-up menu in the Film Lists dialog, a warning message appears where duplicate usages occur in the cut list. The message tells you exactly which frames have been used more than once, and exactly where in your editing project they are used. All of these messages also appear in a double usage warning list.
**Optical List**

The optical list serves as a master list for transition and motion effects. It can refer to transition effects, motion effects, or both. If there is a series of connected transition and motion effects, the optical list combines them and describes them as a single optical. You give the optical list to the optical house to outline how the effects shots are to be assembled.

**Note:** Titles, which are another kind of optical, are displayed in the foreground layer of the cut list, so they are not part of the optical list.

See “Using Effects and Transitions” on page 128 for more information.

**Important:** Be sure to view and print the optical list using a monospaced font such as Monaco. Otherwise, the information in the list will not display correctly.

When you export an optical list, you also get a motion effects list if there are any motion effects, and a transition effects list if there are any transitions.
Transition Effects List
The transition effects list contains a graphical representation of fades, dissolves, and other transitions from your edited program. Transitions can be treated as cuts or as opticals, based on what you choose from the Transitions pop-up menu in the Film Lists dialog. If you choose to treat all transitions as cuts, the transition effects list will be empty, and the transitions will be listed as cuts in the cut list.

Motion Effects List
Anytime there is a shot that has a speed other than the normal forward speed of 24 fps, an entry is made in the motion effects list, and the optical list refers to the motion effects list for that shot.

A digital editing system can assign almost any arbitrary speed to a clip to create a motion effect digitally, but neither videotape nor film can perfectly reproduce every speed that the digital editing system can assign. Therefore, be aware that the optical negative that is made is not necessarily going to look exactly the way the motion effect looked in the editing system.
Important: Because of the frame rate changes involved in motion effects, key numbers that are reported in the motion effects list are not guaranteed to be accurate. If you have a window burn of the key numbers, you should check to make sure that the key numbers in the motion effects list are accurate, and correct them when necessary.

Pull List
The pull list is the same as the cut list, except that the shots appear in the order in which they can be found on the negative rolls. The lab can refer to the pull list when going through your negative rolls to find the shots that will be cut into the film. Each item in the pull list displays the shot number from the cut list.

Scene List
The scene list lists all of the shots that are used in the cut list, with each shot listed only once. You can use the scene list to order prints of the shots in your program so that you can conform a workprint before the negative is cut.

Optical Scene List
If you select “Optical list” and “Scene list” in the Film Lists dialog, an optical scene list is generated along with the scene list. The optical scene list is a list of all the shots used in all the opticals and motion effects, with each shot listed only once. The lab can use this list to pull the footage needed to make the opticals.
Exporting Film Lists

You use the Film Lists dialog to export any of the lists described earlier. One film list file is generated and that file contains all the lists you selected in the Film Lists dialog.

**Note:** If you want to create a change list you need to use the Change List dialog. See “Creating Change Lists” on page 151 for more information.

**To export a film list file**

1. In Final Cut Pro, open and select the sequence for which you want to create a list.
2. Choose File > Export > Cinema Tools Film Lists.

   The Film Lists dialog appears.

   ![Export Film Lists dialog](image)

3. Configure the settings in the Film Lists dialog, then click OK.

   See “Settings in the Film Lists Dialog” on page 146 for settings information.

   If you expect to make changes to this Final Cut Pro sequence and want to export a change list later, be sure to select “Save a Cinema Tools program file.” You’ll need that program file to export a change list that compares this sequence to another version.

4. If you selected “Save a Cinema Tools program file,” enter a filename and location for it in the dialog that appears.

5. In the next dialog that appears, enter a filename for the film list, choose a location, and click Save.

   **Important:** Give the program file a name that clearly identifies the sequence and the version for you, so that you can easily locate it later when you need to export a change list that compares this sequence to a newer version.
In the dialog that appears, select the database file that Cinema Tools should use to produce the lists that you have selected. (Select the database you created for source media used in this sequence.)

A film list is generated as a file that contains all of the lists you have selected. If Cinema Tools is unable to complete any list, messages appear in the file that indicate the problem and guide you to a solution. See also “Solutions to Common Problems” on page 217.

**Tip:** If the text in the film list wraps in a way that is difficult to read, drag to expand the window horizontally.

After exporting a film list, you should compare the edge code (key numbers or ink numbers) in the film list to the edge code in the window burn at the In point frame of each edit. While it can be time consuming to go through all of the edits and compare the edge code numbers, it prevents the loss of time and money due to incorrect cuts. It’s particularly important to check the edge code numbers if you are not conforming a workprint before cutting your negative.

**Settings in the Film Lists Dialog**
The Film Lists dialog contains the following settings for selecting and configuring lists:
• **Title for this list:** Enter a name for the film list file you are going to export.

• **Film Standard:** Choose the film standard that matches the type of film you are using. This should be the same as the film standard setting you used when you created the project database. Cinema Tools uses the film standard that you choose here to calculate footage counts in the cut list. If any of the database records have a different film standard, a warning message appears in the cut list.

• **Telecine Speed:** Select the speed at which the film was transferred.
  - If you are working with NTSC video, you would typically choose 24 frames per second (fps), though the actual speed of the film in the telecine was approximately 23.98 fps.
  - If you edited NTSC video that was transferred at 29.97 fps, choose 30 fps.
  - If your film was transferred to video at 24 fps, choose 24 fps.
  - If your film was transferred to video at 25 fps, choose 25 fps.

• **Duplicates:** Choose whether you want to be notified when duplicate usage of source material is found. If you choose Warn, a warning message appears in the cut list every time a duplicate usage occurs. The message tells you exactly which frames have been used more than once, and exactly where in your editing project they are used. All of these messages also appear in a double usage warning list. If you choose Ignore, these double usage warnings do not appear.

• **Transitions:** Choose how transitions should be listed in the film list. See “Contact Printing vs. Optical Printing” on page 132 for more information. There are three choices:
  - **All are cuts:** All transitions are represented by a cut in the middle of the transition, regardless of whether or not the transitions are of standard length. Choose this option if you are exporting a list for use in conforming a workprint. Cinema Tools also inserts notes to indicate where the start and end of the transition should be for both the outgoing and incoming clips. These notes can be used as a guide in marking the transitions on the conformed workprint.
  - **Std are cuts:** Those transitions that are of standard length are listed as cuts, and those that are nonstandard length are described as opticals. This is the option that you choose if you’re going to have your transitions printed on a contact printer. If you select this option, standard length transitions appear in the cut list, not the optical list, and are shown as a cut in the middle of the transition. The starting and ending points of the transition also appear in the cut list as three lines for a dissolve and two lines for a fade. The cut list contains all of the information that the negative cutter requires to prepare the A and B rolls for these transitions.
  - **All are opticals:** All clips that are part of a fade or dissolve are listed in the optical list. Choose this option if you want all of your fades and dissolves to be printed optically, regardless of their length.
How Cinema Tools Defines Standard-Length Transitions
Cinema Tools identifies the set of standard lengths for 24 fps or 23.98 fps media as 16, 24, 32, 48, 64, and 96 frames in duration. Cinema Tools identifies the set of standard lengths for 29.97 fps or 30 fps media as 20, 30, 40, 60, 80, and 120 frames in duration. (Be sure to check with your contact printer about the standard lengths they require for different frame rates.)

- **Transition handles:** Your negative cutter or optical printer may want to have some spare frames on either side of a transition. These extra frames are called *transition handles*. Enter a number between 0 and 32. When checking to see if there are any frames used more than once, Cinema Tools adds this number of frames plus one-half to the head of the incoming shot and the tail of the outgoing shot for each transition. (The setting you choose for cut handles does not apply to transitions.)

- **Show:** Choose a measurement format for the list.
  - **Feet & frames:** The format is in the feet and frame format that corresponds to the film standard you selected in the Film Lists dialog, for example, 5400+05. (Having a feet and frames count format means that you can place your cut workprint or negative on a synchronizer block and use the numbers from the synchronizer block to verify that your footage is properly cut. You do this by setting the frame counter disc on the synchronizer block to 1 at the first frame, and the footage counter to 0, then cranking the film through the wheels. The synchronizer footage counter displays the film length.)
  - **Time:** The format is in timecode, for example, 01:00:00:00. You can use timecode to keep track of the running time, and compare the cut list with the times shown in the Final Cut Pro Timeline, or in the EDL. Note that the timecode that is shown in the cut list may not perfectly match the corresponding timecode shown in the Timeline because it must be calculated from the film frame number.
  - **Count:** The format is in frame count numbers, indicating how many frames into the roll the frame occurs, for example, 450. This format may be preferred for optical printing. If you want to know how many frames are used between one point in the cut list and another point in the cut list, subtract one frame number count from the other.
  - **Starting at:** Enter a starting location for the list in the same type of measurement that you selected from the Show pop-up menu.
Cut handles: In determining whether or not any frames have been used more than once, Cinema Tools assumes that there is at least one half of a frame destroyed at both the In point and the Out point of each cut. Some negative cutters may want to use more than a half-frame on each side of a cut. You can specify up to five and one-half frames of cut handles. If you inadvertently include, in a sequence, frames that are needed as cut handles, Cinema Tools reports them as duplicate usages in the dupe list and the double usage warnings.

Show Scene & take or Clip name: Choose to have the film list show the scene and take or the clip name for each shot. Showing the scene and take makes it easier to relate the film list to the Cinema Tools database when the database contains scene and take information. Showing the clip name makes it easier to relate the film list to the Final Cut Pro Timeline and the EDL.

Show Camera Roll, Lab Roll, or Daily Roll: Choose which type of roll to display. This choice depends on how your film is stored. When the negative (or workprint) cutter or the lab wants to find a shot, they have to go to a box or roll containing that shot. You want the film list to have the same roll identifier as the one used by the negative cutter or lab.

Tips for Entering the “Starting at” Point
If you are generating a cut list for conforming the negative, you typically want to start at zero, and choose “Feet & frames” from the Show pop-up menu.

If you are editing your film by scene or by reel, you may want to enter a starting point in the “Starting footage or time” field that is the same as the ending point of the preceding scene or reel. This field is automatically filled in with the program starting point you have set in the Final Cut Pro Timeline.

If you want to generate a cut list with timecode so that you can compare events in the list with edits in Final Cut Pro or in the EDL, start the cut list at the same time as the Timeline or EDL start time. Then choose Time from the Show pop-up menu in the Film Lists dialog.

Note: By default, 0000+00 appears as the starting point for Feet & frames, 0000 appears for Count, and the sequence’s starting timecode in the Final Cut Pro Timeline appears for Time.

- Cut handles: In determining whether or not any frames have been used more than once, Cinema Tools assumes that there is at least one half of a frame destroyed at both the In point and the Out point of each cut. Some negative cutters may want to use more than a half-frame on each side of a cut. You can specify up to five and one-half frames of cut handles. If you inadvertently include, in a sequence, frames that are needed as cut handles, Cinema Tools reports them as duplicate usages in the dupe list and the double usage warnings.
- Show Scene & take or Clip name: Choose to have the film list show the scene and take or the clip name for each shot. Showing the scene and take makes it easier to relate the film list to the Cinema Tools database when the database contains scene and take information. Showing the clip name makes it easier to relate the film list to the Final Cut Pro Timeline and the EDL.
- Show Camera Roll, Lab Roll, or Daily Roll: Choose which type of roll to display. This choice depends on how your film is stored. When the negative (or workprint) cutter or the lab wants to find a shot, they have to go to a box or roll containing that shot. You want the film list to have the same roll identifier as the one used by the negative cutter or lab.
• **Show Keycode or Ink Numbers:** Choose to have key numbers or ink numbers displayed in the lists.

  **Important:** Ink numbers are only supported in film lists if the film standard is 4-perf 35mm.

• **Cut list:** Select to include a cut list. Cut lists are described in “Cut List” on page 138.

• **Dupe list:** Select to include a dupe list. Dupe lists are described in “Dupe List and Double Usage Warnings” on page 141.

• **Optical list:** Select to include an optical list. Optical lists are described in “Optical List” on page 142.

• **Pull list:** Select to include a pull list. Pull lists are described in “Pull List” on page 144.

• **Scene list:** Select to include a scene list. Scene lists are described in “Scene List” on page 144.

• **Missing elements list:** Select to include a missing elements list. Missing elements lists are described in “Missing Elements List” on page 139.

• **Save a Cinema Tools program file:** A program file is essential if you want to later create a change list for this sequence, which will reflect any edits you make after this point. A program file is also needed if you want to export an audio EDL from Cinema Tools. Exporting an audio EDL from Final Cut Pro is more automated and does not require a Cinema Tools program file. See “Exporting an Audio EDL” on page 161 for more information.

• **Start with 8 seconds of leader:** Choose whether or not to start the cut list with eight seconds of leader. Eight seconds is the standard length of Academy or SMPTE leader. If you select this option, eight seconds of leader is inserted at the beginning of the cut list. If you have already included a leader clip at the beginning of the sequence, do not select this checkbox. (It’s better to use a leader clip in your sequence instead of selecting this option in the cut list because the timecode in the digital sequence will not match the timecode in the cut list unless a leader clip actually exists in the sequence.)

• **Open in text editor:** When this is selected, the film list opens in the specified text editor immediately after it is exported.

  **Tip:** It’s easier to view the film list and Final Cut Pro windows at the same time if you select Final Cut Pro as the text editor. The list will then open in a Final Cut Pro window, and not disappear behind Final Cut Pro when Final Cut Pro is active. However, you can’t print the list if it’s displayed in Final Cut Pro.
Creating Change Lists

A change list reports the differences between two different versions of a sequence edited in Final Cut Pro. Its purpose is to describe the changes that need to be made to the workprint or negative since it was last conformed to a prior version of the sequence.

When you export a change list file you can also export a new cut list (and other film lists) for the sequence. You can also generate a change pull list, which lists film rolls in the order in which they need to be pulled to add any new film to the workprint. And, you can include a discard list, which lists any sections that need to be removed.
When Are Change Lists Used?
Change lists are typically used in a cyclical workflow that involves both digital editing and workprints.

First, a workprint is made from the original camera negative, ink numbers are applied to the edge of the workprint, and a telecine transfer video is made of the workprint. Then, the workprint video is edited in a digital editing system and a cut list (usually based on ink numbers) is exported and used as a guide to conform the workprint. Next:

1. The cut workprint is projected for screenings, and decisions to cut or add to the film result from the screenings.
2. The changes are made to the movie in the digital editing system.
3. Another change list is exported, providing instructions for modifying the workprint to conform to the new version of the movie.
4. With the change list as a guide, the film assistant conforms the workprint to match the new version of the movie.

These four steps are repeated until it is decided that the picture is locked. Finally, the original camera negative is cut to match the final workprint and cut list.
Exporting Change Lists

Exporting a change list is similar to exporting a cut list. Take note of the following before you start:

- **Only the first video tracks are compared**: A change list describes the difference between the first video track (V1) of one sequence and the first video track (V1) of another sequence. It does not describe any other video or audio tracks.

- **Only 4-perf 35mm is supported for change lists**.

- **Avoid modifying the Cinema Tools database between exporting change lists**: When a database is altered after the previous list was exported, the new change list may not be reliable. However, if you did alter the database after you exported the previous list, you can prevent this risk by exporting a new cut list for the previous sequence and saving a new program file. Then, use that program file when you export the change list.

- **If you have each reel in a separate sequence in Final Cut Pro, and you want to do some reel balancing**, perform the reel balancing edits after any other changes. See “If You Need to Reel Balance” on page 155 for more information.

About Change Lists, Effects, Gaps, and Soundtracks

If you add motion effects to a program, an optical will have to be made, and the length of that section of film will change, affecting the sync. The film assistant who conforms the workprint needs to know where to put in *slug* (fill leader or substitute footage) in order to preserve synchronization while the optical is being made. For this reason, in the change list, Cinema Tools lists motion effects similarly to the way it displays leader information. For motion effects, in the “Do This” column, “Insert Leader” appears, and under the “First/Last Key” column, “Effect” is displayed. Gaps in a sequence are also described as leaders in change lists.

A change list does not provide information about transitions, superimposed effects titles (*supers*), filters, or soundtracks. However, to see whether or not any transitions or supers were changed or added, you can export a cut list and an optical list for each of the sequences and compare the lists. Or, if you are marking the transitions on the workprint, you can export a cut list with the change list and run the conformed workprint through the synchronizer, noting where the transitions start or end at different places in the cut list.
To export a change list:

1. In Final Cut Pro, select the new version of the sequence, then choose File > Export > Cinema Tools Change List.

2. In the dialog that appears, select the program (.pgm) file that you saved when you exported a list for the previous version of the sequence. (It contains needed information about the previous sequence.)

3. In the Change List dialog that appears, configure the settings, then click OK.

See “Settings in the Change List Dialog” on page 156 for details.

When you select the lists in the “Include the following” area in the Change List dialog, the change list file will include (in addition to the selected Change List Options) the same content you would get if you were exporting those lists from the Film Lists dialog.

Note: Keep in mind that the following settings should be the same for the two sequences you are comparing: Film Standard, Telecine Speed, Show Key Code or Ink Number, and “Start with 8 seconds of leader.” The two sequences also need to have the same editing timebase (set in Final Cut Pro).

4. In the dialog that appears, enter a filename and choose a location, then click Save.
5 If you selected “Save a Cinema Tools program file,” enter a filename and location for it in the dialog that appears.

Give the program file a name that clearly identifies the sequence and the version for you, so that you can easily locate it later if you need to export another change list.

6 In the next dialog that appears, select the Cinema Tools database associated with the clips in the sequences you are comparing. (Make sure you select the same database that was used when the previous list was exported.)

A change list file is generated, which contains all the lists you selected in the Change List dialog.

**Tip:** If the text in the change list wraps in a way that is difficult to read, drag to expand the window horizontally.

### If You Need to Reel Balance

In **reel balancing**, heads and tails of reels are reapportioned to make sure the length of each reel is in the right range.

If you want to do any reel balancing in Final Cut Pro, perform the reel balancing edits separately from any other changes. For instance, to move a scene from the head of one reel to the tail of another, first conform the two reels to the change lists exported from their associated sequences. Then, in Final Cut Pro, cut the scene from the head of the sequence for reel 1 and paste it at the tail of the sequence for reel 2. Finally, export new change and cuts lists for both sequences and then use those lists as a guide for balancing the two reels. Note that shots deleted from one reel should be exactly the same length as the shots added to the other reel.
Settings in the Change List Dialog

The Change List dialog that you access from within Final Cut Pro contains the same settings as the Film Lists dialog (described in “Settings in the Film Lists Dialog” on page 146), with the following exceptions and additions, described below.

- **Transitions**: The only choice for handling transitions when you export a change list is “All are cuts,” in which transitions are represented by a cut in the middle of the transition, regardless of whether or not the transitions are of standard length. Cinema Tools inserts notes in the cut list (exported with the change list) to indicate where the start and end of the transition should be for both the outgoing and incoming clips. These notes can be used as a guide in marking the transitions on the conformed workprint.

- **Change List Options**: The following options are available for change lists:
  - **Include Pull list**: Select to include a change pull list, which lists any film that needs to be newly added to the workprint.
  - **Include a Discard list**: Select to include a discard list, which lists only clips that need to be removed from the workprint.
  - **Show only changes**: If selected, the change list displays entries for new edits only. Unchanged footage is not listed. (However, if the Cut list checkbox is selected, a cut list is included in the change list file and it lists all the footage in the sequence, including the unchanged footage.)
  - **Combine deletions**: If selected, footage deletions that are contiguous are listed as one deletion rather than individual deletions. This instructs the film assistant to cut them as a *lift*, a series of pieces removed as one piece and stored intact, rather than as individual pieces. Film assistants tend to prefer seeing and performing the series as one deletion because it saves time and effort.
Using the Export Change List Feature From Within Cinema Tools

If the most recent version of a sequence is not available or conveniently accessible, or is damaged, you can still create a change list as long as you have the exported program (.pgm) files for the two sequences you need to compare. You can export the change list from Cinema Tools using the program files, instead of exporting it from Final Cut Pro (where you need to select a sequence).

When you export a change list from within Cinema Tools, you cannot include a cut list or any of the other film lists that you can export from the Film Lists dialog; you can only export lists and information specific to change lists.

To open the Export Change List dialog in Cinema Tools:

- Choose File > Export > Change List.

You are prompted to enter the program file locations, and a name and location for the change list. For details about the settings you see in this dialog, refer to “Settings in the Change List Dialog” on page 156.
Export Considerations and Creating Audio EDLs

Once you've edited your project, you may want to export a videotape, the audio, or an audio EDL based on the edited project.

Cinema Tools' primary purpose is to generate an accurate cut list. For most projects, you may also want to create other helpful items from your edited program:

- **a videotape of the program**: This may be useful so that you can show the program to others or provide a visual guide to the negative cutter. There are a number of considerations to take into account, such as the editing frame rate and any required specialized hardware. See “Considerations When Exporting to Videotape,” next, for details.

- **a file containing the program's audio**: You usually create this file if you want to use the program's audio, but finish it using specialized sound software or at an audio postproduction facility. There are a couple of approaches you can take to do this, and several issues you must be aware of. See “Considerations When Exporting Audio” on page 160 for details.

- **an audio EDL**: This is required when you intend to recapture the audio using specialized equipment, and reedit it using the audio timecode from the edited program. See “Exporting an Audio EDL” on page 161 for details.

**Considerations When Exporting to Videotape**

You may want to make a videotape of your edited program, either to make it easier to view the program, or to provide a visual reference for the negative cutter. There are a few different ways to create a videotape from an edited sequence, and these methods are explained in the Final Cut Pro documentation. However, if you edited video at 24 fps and you want to create a PAL or NTSC videotape, there are additional considerations explained here.
When you make a videotape from a 24 fps sequence, some video output devices create an NTSC or PAL signal by inserting extra fields as needed to go from 24 fps to 25 fps or 29.97 fps. Such a tape is generally fine for viewing, but not as accurate as it should be if it is to be used as a visual reference in cutting the negative. Be sure to let your negative cutter know if there are issues with the videotape (such as the video occasionally displaying the wrong frame).

**Considerations When Exporting Audio**

Depending on your project's needs, you may be able to use the edited audio from Final Cut Pro directly in the film's release print. More often you will want to finish the edited audio using a specialized application or a facility specializing in audio finishing. This is typically where sound effects, music, and any dialogue issues are added or enhanced. There are a number of items that impact this process:

- **the type of audio file required**: You can export an OMF (Open Media Framework) or AIFF (Audio Interchange File Format) file.
- **the audio speed**: Depending on how the video was transferred, you may have slightly altered the speed of the audio to maintain synchronization.

You may also decide to recapture and reedit the audio at an audio postproduction facility. In this case, see “Exporting an Audio EDL” on page 161 for details.

**Exported Audio File Formats**

There are two common formats used to export audio from a Final Cut Pro project: OMF files and AIFF files.

**OMF Files**

An OMF file contains not only the audio, but also a description of the audio edits. Digital Audio Workstations (DAWs) that can import OMF files can take advantage of having the edit In and Out points along with other information, such as cross fades, enabling them to make small changes. OMF files typically contain all of the audio tracks used in the program (other export formats have limits).

Another advantage of OMF files is that they can contain the audio and edit information from non-timecode sources, such as audio CDs. (Audio EDLs describe only edits using timecode-based sources, and do not include any references to sources such as audio CDs.)

See the Final Cut Pro documentation for information on exporting OMF files.
**AIFF Files**

An AIFF file contains only the audio, and cannot be easily changed. You must export a separate file for each audio track. As with OMF files, AIFF files can contain the audio from non-timecode sources, such as audio CDs. (Audio EDLs describe only edits using timecode-based sources.)

See the Final Cut Pro documentation for information on exporting multiple tracks as AIFF files.

**Audio Speed**

Often the play speed of the edited audio is slightly different from what it was when it was originally recorded (its natural speed). This compensates for film speed changes made during the telecine transfer. Anytime you are editing at 29.97 fps or 23.98 fps, the audio is running 0.1 percent slower than its natural speed. If you are editing at 25 fps and the telecine transfer film rate was 25 fps, then the audio is 4 percent faster.

This speed difference is maintained when you export an AIFF or OMF file. Be sure to find out the requirements of your audio postproduction facility with regards to audio speed issues before you export the files.

**Exporting an Audio EDL**

Just as the final edited video from Final Cut Pro is not generally used when conforming the negative, the edited audio might not be used. If you intend to recapture and reedit your audio at an audio postproduction facility, you need an audio Edit Decision List (EDL) indicating how the audio clips are used in the edit.

While Final Cut Pro's EDL contains both video and audio information, it may not contain references to the timecode and reel numbers from the original production audio tapes, depending on how the clips were captured and how the video was synced to the audio. A Cinema Tools database makes it possible to generate an audio EDL with the original production audio timecode and reel numbers.

**Where’s the Audio Timecode?**

Film productions use a double system (separate camera and audio deck) for capturing the pictures and sound. You must sync the two of them together, either during the telecine transfer or before capturing the clips with Final Cut Pro.

If your audio is synced during the telecine transfer and recorded onto the audio tracks of the videotape, then the timecode and reel number of the original audio source tape is no longer part of the clip and all edits within Final Cut Pro refer only to the video timecode and reel number. Fortunately, the telecine log created during the transfer usually contains the audio information, and adds it to the database when you import the log into Cinema Tools. You can also manually enter the audio information if no telecine log is available.
Using Cinema Tools to Export an Audio EDL

Cinema Tools can export an audio EDL as long as its database contains accurate sound information (an audio timecode number that corresponds to the first video frame of the clip and the audio reel number) in each record. Due to the way audio is recorded during the production (using a double system—a separate audio recorder that is started and stopped independently of the camera), the Cinema Tools audio EDL Export function is only applicable when its database has a record for each take (as with scene-and-take transfers).

It is critical that the sound timecode field correspond directly to the first video frame of the clip. This is typically the case when you import the sound information from a telecine log. Use the Clip window’s Identify feature to enter (or verify) the sound timecode for a known point in the clip (most often at slate close). Based on this value, Cinema Tools calculates the timecode for the first frame. See “Using the Identify Feature to Enter and Calculate Database Information” on page 82 for information on using the Identify feature in this way.

Once you have finished editing and have added the sound timecode and reel number information to the database, you are ready to export the audio EDL.

To export an audio EDL:

1. In Final Cut Pro, select the sequence from which you want to export an audio EDL in the Timeline or Browser.

2. Choose File > Export > Cinema Tools Audio EDL.

Cinema Tools opens and its Export Audio EDL dialog appears.
3 Enter and select settings in the Export Audio EDL dialog, then click OK. See “Settings in the Export Audio EDL Dialog,” next, for settings information.

4 In the dialog that now appears, select the Cinema Tools database file to use, then click Choose. Once you select the database, Cinema Tools starts matching events in the sequence to it:

- For each edit involving a track enabled in the Export Audio EDL dialog, Cinema Tools searches the database to see if that edit’s video clip is connected to any database records. If not, it tries to locate a record using the edit’s video reel number that includes its timecode In and Out points.
- If Cinema Tools finds a suitable record, it checks whether that record includes sound information (timecode and reel number). If so, an entry is made to the EDL and Cinema Tools moves on to the next edit.
- Cinema Tools may not be able to match all audio edits within the sequence. This may be due to incomplete database records or the use of audio from sources other than the logged sound rolls. For those edits that cannot be matched back to the database, an entry is added to the EDL using the reel and timecode from the sequence, with an asterisk placed by the reel name. A comment stating that no matching database record was found is also added to the EDL entry.

Cinema Tools creates two files during the export: a CMX 3600 EDL format file and a text file containing information on the EDL export:

- The CMX 3600 EDL format is widely used as a standard for EDL interchange, and should be acceptable at virtually all facilities.
- The text file created along with the EDL file uses the EDL’s filename with a “.txt” extension. The file contains information regarding the sequence used and all the settings of the Export Audio EDL dialog, including the number of tracks and their mapping. It also lists any errors that occurred during the export.

**Settings in the Export Audio EDL Dialog**

Cinema Tools uses information from the sequence to fill in several fields in the top part of the Export Audio EDL dialog:
• **File:** This is only used when exporting an audio EDL directly from Cinema Tools, and contains the name of the Cinema Tools program file just opened. See “Using the Audio EDL Export Feature From Within Cinema Tools” on page 165 for more information.

• **Audio Tracks:** The number of audio tracks used in the edit

• **Project name:** The name of the Final Cut Pro sequence the file is based on

• **Project timebase:** The frame rate of the sequence in the Timeline

• **Start time:** The sequence start time as assigned in the Final Cut Pro Audio/Video Settings window

• **EDL Title:** The name of the EDL. By default, it is the same as the project name from the sequence.

• **EDL start time and timecode type:** The starting time for the EDL and the type of timecode to be used. By default, it is the same as the start time from the sequence. This should not be changed unless your audio postproduction facility has a specific requirement.

The rest of the dialog contains fields and controls used to configure the audio EDL:

- **Audio Mapping:** Use to assign each of the eight possible sequence audio tracks to the four audio EDL tracks (the maximum supported by audio EDLs). See “Audio Track Usage,” next, for details on configuring these settings.

- **Include clip comments:** When checked, the audio EDL includes the name of the clip file (if known) as a comment for each event in the list.

- **Include scene and take comments:** When checked, the audio EDL includes the scene and take numbers as comments for each event in the list.

- **Open in text editor:** When checked, the exported audio EDL opens in the text editor specified in the “Open in text editor” pop-up menu. Since the audio EDL is actually a text file, the TextEdit application is typically used.
Audio Track Usage

While Final Cut Pro supports many audio tracks, Cinema Tools Audio EDL Export feature includes only the first eight, and audio EDLs support a maximum of four. The Audio EDL Export dialog provides settings for each of the eight possible audio tracks, allowing you to map them to the four EDL tracks.

The track configuration selections are active for those tracks included in the sequence—all others are unavailable. While it is possible to map multiple tracks to a single EDL track, this frequently results in errors and confusion in the resulting EDL.

Since there is no way to fit the eight tracks into the four EDL tracks, you must export two EDLs—one EDL with tracks 1 through 4 enabled (and the others off), and the other EDL with tracks 5 through 8 enabled. Be aware that some sound editors may prefer a single track per EDL, requiring you to export multiple audio EDLs. Be sure to consult with your sound editor before you export the audio EDL.

Using the Audio EDL Export Feature From Within Cinema Tools

You will most often use the Cinema Tools Audio EDL Export feature from within Final Cut Pro. You can use this feature from within Cinema Tools, but since Cinema Tools does not have the edited sequence directly available, an additional step is required to create a Cinema Tools program file.

Final Cut Pro creates a Cinema Tools program file whenever you select “Save a Cinema Tools program file” while setting up the Film Lists dialog. A Cinema Tools program file contains information about the edit sequence in a format that can be used by Cinema Tools to create the audio EDL. Other settings within the Film Lists dialog, such as whether or not the various available lists are included, have no effect on the program file.
You can use Cinema Tools to work on projects started on other systems.

On occasion you may find that you want to create film lists, including a cut list, based on edits from an editing system other than Final Cut Pro. For this reason, Cinema Tools lets you generate film lists based on Edit Decision Lists (EDLs) created with other systems.

Cinema Tools also lets you import and export Avid Log Exchange (ALE) files. These files contain most of the film, video, and audio information in a Cinema Tools database, in a format supported by most film-based editing systems. They do not contain any edit-based information (as is found in an EDL).

Creating EDL-Based Film Lists
The same considerations you have to take into account when creating film lists from within Final Cut Pro apply to other video editing applications. You must

- have a complete and accurate Cinema Tools database that includes the film and timecode information
- have video timecode and reel numbers in the EDL that match exactly those in the Cinema Tools database
- be prepared to deal with audio speed issues that may affect synchronization with the picture

All of the considerations related to the telecine transfer, including whether the scene-and-take or camera-roll method was used, apply as well. The telecine log from a scene-and-take transfer is still the best way to build your Cinema Tools database. See Chapter 4, "Creating and Using a Cinema Tools Database," on page 61 for information on building a Cinema Tools database.

Important: When you export a film list from an EDL, Cinema Tools has to use the timecode-based method of film list creation. For this reason, you must be careful to have accurate video timecode values in the database, since they alone, and not the actual clips, provide the edit information for generating the lists.
Generating Film Lists

There are two approaches you can take to generate film lists from an EDL:

- **Use the Cinema Tools Export command:** This is the easiest approach. See “Using the Cinema Tools Export Command,” next.
- **Import the EDL into a Final Cut Pro sequence:** This method requires a bit more effort but displays the edit points in a timeline fashion (with no video or audio if the clips are not available). If the clips are available, it is possible to actually play and modify the sequence before you export the lists. For information on this approach, see the Final Cut Pro documentation for details on importing an EDL. See Chapter 8, “Generating Film Lists and Change Lists,” on page 137 in this manual for details on generating film lists from within Final Cut Pro.

Using the Cinema Tools Export Command

In addition to the Cinema Tools database, a suitable EDL is required to create film lists from within Cinema Tools.

EDL requirements

Cinema Tools supports EDLs that comply with the CMX 3600 format. As a general rule, any options to include “pre-read” or “B-reels” should be disabled, since these apply directly to tape-based editing. If necessary, Cinema Tools can work with pre-read events, but the name of the pre-read reel must be PREREAD. Be sure that comments are included, since these can display the clip, transition, and effects names. They will be recognized by Cinema Tools and included in the cut list comments.

The reel names that appear in the EDL must match those used in the Cinema Tools database. Even a slight difference, such as an added space or an extra leading “0” (001 instead of 0001) can cause problems.

Be aware that some editing systems modify the reel names when exporting an EDL. The CMX 3600 format allows a maximum of eight characters with only numbers and uppercase letters (no spaces). Often there is a “reel conversion list” appended to the end of the EDL to make it easier to locate any naming issues that occur.

You can use the Cinema Tools Change Reel command to change all occurrences of a particular reel name in the database to match the EDL (for example, you can change all instances of reel Tape 004 to TAPE004). See “Changing All Reel or Roll Identifiers” on page 87 for more information.


**EDL video standards**

EDLs are built on references to video timecode points. This means that EDLs have a frame rate, typically either 30 fps (NTSC), 25 fps (PAL), or 24 fps (based on either the film rate or the 24P video rate). Additionally, NTSC EDLs must contain a line near the beginning that starts with FCM. This comment specifies whether the timecode is drop frame or non-drop frame. PAL and 24 fps timecode are always non-drop frame, and do not require the FCM line (although it may appear as non-drop frame).

Unfortunately, an EDL does not usually contain a line stating its frame rate. Cinema Tools assumes the EDL is the same frame rate as the last database that was opened. For this reason, it's a good idea to open the database the EDL is to be used with before you export film lists. The current frame rate appears in the film list generation command, for example, Film List from 30 fps EDL. It's up to you to know the frame rate of the EDL and verify that it matches this setting and the database it is to be used with.

**To generate film lists using the Cinema Tools Export command:**

1. Open the Cinema Tools database that pertains to the EDL you will use to create the film lists. This ensures that the frame rate of the list and the database will match.
2. Choose File > Export > Film lists from 30 fps EDL. (The FPS value displayed is based on the last database opened.)
3. Choose the EDL file in the dialog that appears, then click Choose.
4. Choose a location and name for the list file to be created, then click Save.

*Note:* If Cinema Tools has any problems processing the EDL file, a “parsing error” message appears that includes the line number that caused the problem. See "What Actually Happens to the EDL" on page 170 for more information.
In the Cinema Tools Film Lists dialog, choose your settings and click OK. See Chapter 8, “Generating Film Lists and Change Lists,” on page 137 for details on the settings in this dialog.

If you chose to have a Cinema Tools program file created in the Film Lists dialog, choose a location and name for the file, then click OK.

Select the Cinema Tools database to use for the list export, then click Choose.

The film list is generated and displayed (if you selected the “Open in text editor” option in the Film Lists dialog).

What Actually Happens to the EDL
Once you start the film list export, Cinema Tools first processes the EDL file and creates a version for its own internal use. During this processing, Cinema Tools looks for errors that would make the EDL unsuitable to create a film list. If it encounters nonstandard or unexpected text, the export is halted and an error message appears listing the line number where the processing failed. This is referred to as a parsing error.

Problems in an EDL can often be repaired by manually editing its contents. Since EDLs are actually plain text files, they can be opened in TextEdit. Be careful: often the line number listed may not be the actual problem; the real issue may be with the line before. Experiment with deleting lines and comparing them to similar ones that occur previously in the EDL to help determine the problem. See “Using TextEdit to Make Changes to an EDL,” next, for more information.
Cinema Tools also looks for conflicts within the EDL, such as when two edits overlap (known as a dirty list). Cinema Tools cleans these edits, removing any portions that would be over-recorded by any edits that follow. Any transitions or supers that are completely overlapped by a following edit are removed. If the transition or super is only partly overlapped by a following edit, it is flagged as a conflict, the later edit is removed, and an entry is added to the cut list indicating this was done.

When Cinema Tools successfully processes an EDL, it places an entry at the beginning of the film list showing a summary of events that it processed. This entry lists how many of each type of event occurred (cut, dissolve, wipe, and key). The number of events in the list should match the number of events in the EDL.

**Using TextEdit to Make Changes to an EDL**

By default, TextEdit saves files in the Rich Text Format (RTF), but the EDL needs to be a plain text file. Follow these steps to edit an EDL in TextEdit and save it in a plain text format.

**Warning:** Use great care when editing an EDL file—some items that appear meaningless can be very important. Make sure you have a backup copy available in case you alter your working copy beyond usability.

**To edit an EDL file in TextEdit:**

1. Open TextEdit.
2. Choose File > Open, then locate the EDL file and click Open.
3. Choose Format > Make Plain Text, then click OK in the warning that appears.
   The font changes to Monaco, a nonproportional font that ensures the text columns line up properly. The name changes to Untitled.
4. Make your text edits, then choose File > Save.
   By default, the name is Untitled, and a ".txt" extension is appended to it.
5. Enter the desired name for the file and replace the ".txt" extension with ".edl" (or whatever was used in the original file), then click Save.
6. A dialog appears asking if you want to have ".txt" appended to the end of your filename. Click “Don’t append.”

If you often find yourself editing plain text files, you may want to configure TextEdit’s preferences to make it easier.

**Note:** Double-clicking a filename with an ".edl" extension opens it in a read-only window in Final Cut Pro.
Working With ALE Files

The Avid Log Exchange (ALE) file format was created so that the contents of film-based databases could be transferred between systems. Cinema Tools supports importing and exporting ALE files, making it possible to share databases with other systems.

As with EDL files, ALE files are plain text files that can be opened and edited with any text editor. A difference is that they are tab-delimited, making them a bit more difficult to read. Also, while it is possible to edit the contents with a text editor, you must use great care to avoid corrupting the file by accidentally deleting a tab character.

Supported ALE Fields

Each line in an ALE file corresponds to one database record. Cinema Tools supports the following ALE fields:

- **Name**: When exporting, contains the filename of the connected clip (if there is one), or a Cinema Tools–created name combining the scene and take numbers (if they have been connected), or as a last resort, the video reel and timecode values separated by a hyphen.

**Film-Related Fields**

- **Camroll**: Contains the number used for the Cam Roll field.
- **Labroll**: Contains the number used for the Lab Roll field.
- **Daily roll**: Contains the number used for the Daily Roll field.
- **Ink number**: Contains the Ink field values.
- **KN Start**: Contains the Key field values.

**Video-Related Fields**

- **Tape**: Contains the Video Reel field value.
- **Start**: Contains the Video Timecode field value.
- **End**: Within Cinema Tools, this is a calculated value created by adding the Duration field to the Video Timecode field.
- **Duration**: Contains the contents of the Video Duration field. (Note that some systems compare the Duration value to the KN Duration value to ensure they are the same length — use the Cinema Tools Identify feature to ensure the two durations match.)

**Audio-Related Fields**

- **Tracks**: Cinema Tools inserts “VA1” into this field during export.
- **Soundroll**: Contains the contents of the Sound Roll field.
- **Sound TC**: Contains the contents of the Sound Timecode field, representing the timecode of the first frame.
General Fields
- Scene: Contains the Scene field contents.
- Take: Contains the Take field contents.
- Notes: Contains any notes you may have included in the database record.

Importing an ALE File
You import an ALE file with the Import Telecine Log command. You can import an ALE file into an existing Cinema Tools database or into its own new database. It's recommended that you import into a new database—you can always import that database into another one later.

To import an ALE file:
1. In Cinema Tools, choose File > Import > Telecine Log.
2. In the dialog that appears, locate the file and click Choose.

The file is imported into the database. See “Importing Database Information From a Telecine Log or ALE File” on page 70 for more information on importing ALE and telecine log files into Cinema Tools.

Exporting an ALE File
Cinema Tools exports an ALE file based on the current found set. To avoid problems, be sure all of the records are complete and accurate prior to exporting.

To export an ALE file:
1. Create a found set that contains the records you want to export. (See “Finding and Opening Database Records” on page 91 for details on creating a found set.)
3. Enter a name and location for the new file. It's recommended that you add an “.ale” extension to the filename.
4. Click Save to export the file.
Part II: Working With 24P

Using Cinema Tools while editing high definition video projects.

Chapter 11  Working With 24P Video and 24 fps EDLs
Working With 24P Video and 24 fps EDLs

Cinema Tools provides several tools that are useful when editing 24P video.

The proliferation of high definition video standards and the desire for worldwide distribution has created a demand for a video standard that can be easily converted to all other standards. Additionally, a format that translates well to film, providing an easy, high-quality method of originating and editing on video and finishing on film, is needed.

The 24P video standard provides all this. It uses the same 24 fps rate as film, making it possible to take advantage of existing conversion schemes to create NTSC and PAL versions of your project. It uses a progressive scanning scheme and a high definition image (1920 pixels per line, 1080 lines per frame) to create an output well suited to being projected on large screens and converted to film.

Additionally, the 24P standard makes it possible to produce high-quality 24 fps telecine transfers from film. These are very useful when you intend to broadcast the final product in multiple standards.

Note: Several of the features mentioned here are included with Final Cut Pro and do not require Cinema Tools; however these features are described here because they relate to working with 24P, which is of specific interest to many filmmakers.
Considerations When Originating on Film

When editing 24P material that originated on film, you need to be aware of a number of special circumstances:

- If you intend to conform the film to match the edited video, you must have its edge code tracked by a Cinema Tools database. (See “Film Edge Code” on page 203 for details on edge code.)

- The film must be transferred to video using a telecine. Typically the offline telecine video output contains burned-in video and audio timecode, as well as key numbers. These burned-in values (known as window burn) are invaluable when you intend to later conform the film. Unfortunately, their visibility is a problem if you also intend to use the 24P video to produce a video version of the program. For this reason, if you intend to produce both a conformed film and an edited video version of the project, you might have the telecine run on two decks simultaneously, one with the window burn and the other without.

- Whether shooting film or a 24P production, sound is almost always recorded separately from the picture, with a separate sound recorder. This is often referred to as shooting double system sound. While 24P productions can record the sound on the 24P video recorder, providing synced sound that is easily captured with Final Cut Pro, film productions do not have the option of recording sound on the film, so the sound must be synced to the picture at some point later in the process. The preferred workflow is to synchronize the sound during the telecine transfer. This makes it easy to capture the audio along with the video clips for editing with Final Cut Pro. The Cinema Tools database can track the original sound reel numbers and timecode and generate an audio EDL that can be used to recapture and edit the sound at a sound postproduction facility.

See “Transferring Film to Video” on page 19 for information on telecine transfers. See “Exporting an Audio EDL” on page 161 for information on exporting audio EDLs.
Editing 24P Video With Final Cut Pro

The excellent quality of 24P video presents a challenge when it comes to editing—the bandwidth and storage space it requires. Editing minimally compressed 24P video directly in Final Cut Pro requires that you have a system with a large, fast hard disk and specialized capture hardware. Even with a properly configured system, you may only be able to capture the video you actually intend to use, not the typical 20 to 100 hours you may have shot.

The typical approach to editing 24P video with Final Cut Pro involves two steps: an offline edit, using compressed 24P clips or downconverted (to standard definition NTSC) and compressed clips, followed by an online edit with recaptured, uncompressed clips.

What Is Downconverted Video?

It is often necessary to use high definition video, such as 24P, in systems designed for standard definition NTSC. The process of converting high definition video to standard definition video is called downconverting. Most high definition VTRs have an option that provides standard definition video outputs. Several specialized hardware downconverters are also available. See “About the 24P Aspect Ratio” on page 184 for information on dealing with the aspect ratio differences between the standards when downconverting.

Using One Final Cut Pro System for Both 24P Offline and Online Editing

Ideally you could use the same Final Cut Pro system for both offline and online editing. This makes the process as simple and error-free as possible. The workflow when using the same system for both purposes looks like this:

1. Capture your 24P video as compressed clips.
2. Perform an offline edit of the clips.
3. Use the Media Manager to create a duplicate of the project that uses only the clips and sections of clips you need.
4. Delete the original clips.
5. Recapture the material in your duplicate project as uncompressed 24P video.

Even if your Final Cut Pro system is not configured to edit uncompressed 24P video, it can serve as an offline editor and export a 24 fps EDL to be used by a 24P online editing system. Even better, if your 24P online editing system uses Final Cut Pro, you can simply copy the project from the offline system, allowing you to preserve far more information about the edit than with an EDL alone.
See “Using Final Cut Pro as a 24P Online Editor” on page 180 and “Using Final Cut Pro as a 24P Offline Editor” on page 183 for more information on each.

Using 24P Video With Final Cut Pro and Cinema Tools

Final Cut Pro and Cinema Tools give you the ability to handle various situations related to editing 24P video:

- **Importing 24 fps EDLs**: Use for performing an online edit of 24P material that has been offline on another system. See “Using Final Cut Pro as a 24P Online Editor,” next.
- **Exporting 24 fps EDLs**: Use for performing an offline edit of 24P material with a 24 fps editing timebase. See “Using Final Cut Pro as a 24P Offline Editor” on page 183.
- **Converting an EDL to or from 24 fps**: Use for performing an offline edit of 24P material using an NTSC editing timebase or for doing an online edit of 24P material that has been offline on an NTSC system. See “Using Final Cut Pro as a 24P Offline Editor” on page 183.
- **Removing 2:3:3:2 or 2:3:2:3 pull-down**: Use if you are capturing your source clips from a digital video camcorder that applied 2:3:3:2 or 2:3:2:3 pull-down to 24P video. This feature cleanly eliminates the redundant frame fields created by the pull-down, without any recompression, so you can edit at 24 fps. See “Working With 2:3:3:2 Pull-Down” on page 188.
- **Adding pull-down**: Use to output 23.98 fps video in a format that you can play on an NTSC device, such as an NTSC monitor, and to record it as 29.97 fps video. This feature lets you output 23.98 fps video via FireWire at the NTSC standard of 29.97 fps video. See “Pull-Down Patterns You Can Apply to 23.98 fps Video” on page 194.
- **Creating an audio EDL when using double system sound**: Use if you intend to recapture the audio elsewhere for final processing. See “Using Audio EDLs for Double System Sound” on page 196.

Using Final Cut Pro as a 24P Online Editor

An important consideration when using Final Cut Pro as your online editor is how to import the offline edit information. When using a separate system as the offline editor, there are three methods you can use to get edit information from the offline system (presented in order of preference):

- **copy the project**: Can be used when a separate Final Cut Pro system is the offline system, and it used a 24 fps editing timebase
- **import a 24 fps EDL**: Useful when your offline system supports exporting 24 fps EDLs
- **import an NTSC EDL**: Useful when your offline system can only edit downconverted NTSC versions of the 24P video, and export an NTSC EDL
Copying the Project
Copying the project from an offline Final Cut Pro system to the online Final Cut Pro system provides not only the edit In and Out point information, but also all other information related to the project, such as filter and effects usage. To use this method, you must have edited using a 24 fps timebase on the offline system.

Importing EDLs
When using non-Final Cut Pro offline systems (or a Final Cut Pro system editing downconverted NTSC versions of the 24P video), you must import an EDL. Final Cut Pro provides both 24 fps EDL Import and NTSC-to-24 fps EDL conversion.

Important: Before importing any EDL into Final Cut Pro, make sure that the editing timebase for the sequence is the same frame rate as the EDL. If the frame rate of the EDL is different from the editing timebase of the sequence, the EDL will not be imported correctly.

Importing 24 fps EDLs
Whenever the offline editor is not Final Cut Pro, the best way to import information about the offline edit is to provide an EDL. EDLs contain only the basic information about an editing project: the In and Out edit points for the first two video tracks and the first four audio tracks, information for simple transitions, and any notes you have added.

To import a 24 fps EDL in Final Cut Pro:
1 Open an existing Final Cut Pro project or create a new one.
2 Choose File > Import > EDL.
3 Configure the Import Options dialog, then click OK.
   Note: If the dialog does not allow you to choose 24 fps as the editing timebase, it’s probably because the Easy Setups included with Cinema Tools are not installed. If they are not installed, reinstall Cinema Tools.
4 Choose the name and location of the EDL file, then click Choose.
A new sequence opens in the project, containing the edits of the EDL, all indicating the media is offline. The Browser contains a list of the media used in the edit. You can then use Final Cut Pro’s Media Manager to capture the clips for the online edit. See the Final Cut Pro documentation for details on capturing clips, importing EDLs, and configuring the Import Options dialog.

**Importing NTSC EDLs**

To import an NTSC EDL for use with a 24P project, you first need to convert the NTSC 30 fps EDL to 24 fps. This makes it possible for you to perform an offline edit of your downconverted 24P video on an NTSC system and export an EDL that can be converted and used by an online Final Cut Pro system.

*Note:* Cinema Tools does not support converting PAL EDLs to 24 fps.

To convert an NTSC EDL to 24 fps, you need the EDL file to be converted in the CMX 3600 format. You do not need a Cinema Tools database.

**To convert an NTSC EDL to 24 fps:**

1. In Cinema Tools, choose File > Export > Converted EDL > 24 FPS from 30 FPS.

2. In the dialog that appears, locate and choose the EDL file to convert.

3. In the next dialog, choose the name and location of the new file to be created, then click Save.

The new EDL file is identical to the original, with the exception of the timecode values and effects durations which have been converted to match the new frame rate.

*Important:* 24P timecode is always non-drop frame, and the NTSC timecode to be converted must also be non-drop frame. Cinema Tools does not prevent you from converting an NTSC drop frame-based EDL, but instead treats it as if it were non-drop frame. The exported 24 fps EDL will contain errors, and Cinema Tools inserts a warning message into the EDL.

You can now import the 24 fps EDL into Final Cut Pro using the process described in “Importing 24 fps EDLs” on page 181.
Using Final Cut Pro as a 24P Offline Editor

Editing 24P HD video generally requires that you first edit it with an offline system. This allows you to choose the actual footage you want to use while working with downconverted or compressed versions of the 24P video.

When the online system also uses Final Cut Pro, it is highly recommended that you perform an offline edit using a 24 fps timebase. This allows you to open the project with the online system and maintain all special settings, effects, and filters—things that are not included in an EDL.

With online systems other than Final Cut Pro, you need to provide a 24 fps EDL from the project.

Cinema Tools provides several tools that make it easier to use Final Cut Pro for 24P offline editing:

- *Reverse Telecine and Conform features:* Useful when you have captured downconverted versions of the 24P video and want to convert them back to 24 fps.
- *24 fps EDL export:* Useful when you edit with a 24 fps timebase and require a 24 fps EDL for the online system.
- *NTSC-to-24 fps EDL conversion:* Useful when you must edit using an NTSC 30 fps timebase but need a 24 fps EDL.

For offline editing, it is preferred that the 24P video be compressed and captured directly, with no frame rate conversions. This removes the possibility of errors during video and timecode rate conversions, and eliminates the need to convert the video’s aspect ratio. However, this requires specialized hardware, so the following alternatives using standard downconverted versions of the 24P video have been developed.
About the 24P Aspect Ratio

When capturing NTSC or PAL video from 24P sources, you typically choose how to handle the differences in their aspect ratios.

Standard definition (SD) video (NTSC or PAL) has a 4:3 aspect ratio. This means the picture is 75 percent as tall as it is wide. 24P video uses a 16:9 aspect ratio that is closer to the common film aspect ratios, and is the same as the widescreen broadcast high definition (HD) formats.

Most 24P videotape recorders (VTRs) can be equipped to output standard definition NTSC and PAL video. Final Cut Pro systems not capable of capturing 24P video directly can capture one of these SD video outputs for editing. A setting in the VTR determines how the 16:9 video is formatted to fit the NTSC or PAL 4:3 aspect:

- **Letterbox:** Displays the entire 16:9 frame, placing black bars at the unused top and bottom parts of the frame. This is the preferred method since you can see the entire frame without the distortion of the anamorphic method. Timecode is generally burned in along the bottom black bar so that it does not cover any of the active picture.

- **Anamorphic:** Displays the entire 16:9 frame by distorting the image (objects look tall and skinny) to fill the 4:3 frame. The image displays correctly when used with a monitor that supports 16:9 video.

- **Pan and scan:** This mode displays a portion of the 16:9 frame as undistorted video filling the 4:3 frame. The “pan” part refers to being able to choose the part of the 16:9 frame to display by panning across the frame. This sort of panning is not supported by the VTR however, and you end up using only the center part of the frame (also known as center crop). Pan and scan is not usually used for editing since you cannot see the entire frame, and risk using unsuitable footage.
Using the Reverse Telecine and Conform Features

24P video is often downconverted to make it easier to use with standard video equipment. Cinema Tools provides tools to convert NTSC or PAL captured clips back to their original 24 fps video, enabling you to edit using a 24 fps timebase.

- **NTSC**: Converting 24P video to NTSC requires using a pull-down method that adds redundant fields, maintaining the action’s original speed (one second of 24P video equals one second of NTSC video). The Reverse Telecine feature removes the pull-down by removing the extra fields and restores the original 24 fps rate. See “Reversing the Telecine Pull-Down” on page 113 for information on using the Reverse Telecine feature. If your source clips originated from a special type of DV camcorder that shoots 24P, such as the Panasonic AG-DVX100 camcorder, a simpler form of the Reverse Telecine dialog appears. See “Removing 2:3:3:2 or 2:3:2:3 Pull-Down With Cinema Tools” on page 190 for instructions on reversing the pull-down for clips that originated from a 24P-capable digital video camcorder.

- **PAL**: There are several methods of converting 24P video to PAL. The most common is to play the tape four percent faster, providing a one-to-one relationship between the 24P and PAL frames, but speeding up the action by four percent. Cinema Tools provides a Conform feature that you can use to restore the video back to 24 fps in order to edit it at 24 fps in Final Cut Pro. See “Frame Rate Basics” on page 22 for information on frame rate issues.

Exporting 24 fps EDLs

Whenever the 24P online editor is not Final Cut Pro, the best way to provide it with the project’s edit information is to export an EDL from Final Cut Pro, which you can then import into the online editor. EDLs contain only the basic information about an editing project: the In and Out edit points for the first two video tracks and the first four audio tracks, information for simple transitions, and any notes you have added. Cinema Tools provides Final Cut Pro with the ability to export 24 fps EDLs.

**To export a 24 fps EDL from Final Cut Pro:**

1. Select the sequence you want to export an EDL from in the Final Cut Pro Timeline.
2. Choose File > Export > EDL.
3. Configure the EDL Export Options dialog as required, then click OK.
4. Choose the name and location for the EDL file, then click Save.

See the Final Cut Pro documentation for details on exporting EDLs and configuring the EDL Export Options dialog.
Converting NTSC EDLs to 24 fps

You may decide to edit the downconverted NTSC version of the 24P video using a standard NTSC 30 fps timebase; however, most 24P online editing systems require a 24 fps EDL.

Cinema Tools includes a feature that allows you to convert NTSC 30 fps EDLs to 24 fps. This makes it possible for you to perform an offline edit of your downconverted 24P video on an NTSC system and export an EDL that can be converted and used by an online system.

Note: Cinema Tools does not support converting PAL EDLs to 24 fps.

To convert an NTSC EDL to 24 fps, you need the EDL file to be converted in a CMX 3600 format. You do not need a Cinema Tools database.

To convert an NTSC EDL to 24 fps:

1. In Cinema Tools, choose File > Export > Converted EDL > 24 FPS from 30 FPS.

2. In the dialog that appears, locate and choose the EDL file to convert.

3. In the next dialog, choose the name and location for the new file to be created, then click Save.

The new EDL file is identical to the original, with the exception of the timecode values and effects durations, which have been converted to match the new frame rate.

Important: 24P timecode is always non-drop frame, and the NTSC timecode to be converted must also be non-drop frame. Cinema Tools does not prevent you from converting an NTSC drop frame-based EDL, but instead treats it as if it were non-drop frame. The exported 24 fps EDL will contain errors, and Cinema Tools inserts a warning message into the EDL.

You can now import the 24 fps EDL into Final Cut Pro using the process described in “Importing 24 fps EDLs” on page 181.
Adding and Removing Pull-Down in 24P Clips

Cinema Tools and Final Cut Pro have pull-down removal and addition features that address issues specific to working with 24P video. Pull-down, as first mentioned in “Frame Rate Basics” on page 22, is a process that adds redundant fields to video in order to distribute 24 frames per second into the NTSC standard of 29.97 frames per second. Some camcorders, such as the Panasonic AG-DVX100, are designed to shoot in progressive mode at 24 fps (literally 23.98 fps), and then record the video to tape as a 60-field interlaced signal by applying a special kind of pull-down called advanced 2:3:3:2 pull-down. With Final Cut Pro or Cinema Tools, you can remove the redundant fields created by the camera’s pull-down, so that you can edit at 24 fps.

When you edit 23.98 fps video, you may need to output it to an NTSC monitor, record it to an NTSC videotape, or send it to another type of NTSC device. Because the NTSC standard specifies a frame rate of 29.97 fps, Final Cut Pro gives you a way to add pull-down back into the video as you output it. To accommodate various circumstances, Final Cut Pro provides a few different types of pull-down patterns for outputting your 23.98 fps video as 29.97 fps video: 3:2 pull-down, 2:3:3:2 pull-down, and 2:2:2:4 pull-down. (These pull-down patterns are described in “Pull-Down Patterns You Can Apply to 23.98 fps Video” on page 194.)

There are a number of ways, described in the sections that follow, that you can use Final Cut Pro or Cinema Tools to remove advanced 2:3:3:2 pull-down or 2:3:2:3 pull-down from digital video clips. You can

- use Final Cut Pro to remove 2:3:3:2 pull-down while capturing, or after capturing
- use Cinema Tools to remove 2:3:3:2 or 2:3:2:3 pull-down on one clip at a time
- use Cinema Tools to remove 2:3:3:2 or 2:3:2:3 pull-down on several clips at a time

What Is 2:3:2:3 Pull-Down?

A 2:3:2:3 pull-down pattern is exactly the same as a 3:2 pull-down pattern, except that it is applied by a digital video camcorder (as opposed to any other type of equipment that could apply the same pattern of pull-down). This manual uses the term “2:3:2:3” when referring to the pull-down that comes from a 24P digital video camcorder; this type of pull-down can be removed using the automated form of reverse telecine, described in “Removing 2:3:3:2 or 2:3:2:3 Pull-Down With Cinema Tools” on page 190.
Working With 2:3:3:2 Pull-Down

Some camcorders, such as the Panasonic AG-DVX100, are designed to shoot in progressive mode at 24 fps (literally 23.98 fps), and then record the video to a tape as a 60-field interlaced signal by applying 2:3:3:2 pull-down to it. The 2:3:3:2 pull-down is similar in concept to 3:2 pull-down, but has a different pattern of field repetition, as illustrated below.
There are some advantages to shooting with, and then removing, 2:3:3:2 pull-down instead of working with 3:2 pull-down.

- Final Cut Pro can easily remove the 2:3:3:2 pull-down while you are capturing, so that you can edit 24 (actually 23.98) fps progressive video.
- Unlike 3:2 pull-down removal, removing a 2:3:3:2 pull-down does not require the recompression and re-creation of any frames, so it results in a better picture quality. Final Cut Pro eliminates the redundant fields by simply pulling out the frames containing fields with two different images (the frames that were constructed from two different original frames). Only frames containing one still image are left, resulting in a clean picture.

You can remove the 2:3:3:2 pull-down with Final Cut Pro while capturing the source media, or with Final Cut Pro or Cinema Tools after capturing.

**Note:** For information about applying 2:3:3:2 pull-down to video (rather than removing it from video), see “2:3:3:2 pull-down” on page 195.

---

**Removing 2:3:3:2 Pull-Down With Final Cut Pro**

**To remove the pull-down while capturing from a digital video source:**

1. In Final Cut Pro, choose Final Cut Pro > Audio/Video Settings.
2. Click the Capture Presets tab.
3. Select the preset you want to use, then click Edit.
4. Select “Remove Advanced Pulldown (2:3:3:2) From MiniDV Sources.”

At some point after removing the 2:3:3:2 pull-down, you may want to output the video with 2:3:3:2 pull-down added back to recapture it with the camera. Or, for NTSC broadcast or distribution, you may want to apply the more conventionally supported 3:2 pull-down. You can output 24P video in either of these pull-down patterns. See “Pull-Down Patterns You Can Apply to 23.98 fps Video” on page 194.

**To remove the pull-down in Final Cut Pro after capturing:**

1. In Final Cut Pro, select the clips or sequence.
2. Choose Tools > Remove Advanced Pulldown.
Removing 2:3:3:2 or 2:3:2:3 Pull-Down With Cinema Tools

Clips captured from digital video camcorders that shoot 24P, such as the Panasonic AG-DVX100 camcorder, have the pull-down pattern (also called cadence) information embedded in a way that Cinema Tools can read. When you use the Reverse Telecine feature, if Cinema Tools detects this cadence information, the Automated Reverse Telecine dialog appears. It’s a simplified version of the regular Reverse Telecine dialog.

You can use automated reverse telecine to remove the pull-down either from one clip at a time, or from a group (batch) of clips.

**Using Automated Reverse Telecine on a Single Clip**

To remove the pull-down in a single clip:

1. Choose File > Open Clip, then select the clip in the dialog.
2. In the Clip window, click Rev Telecine.
3. Choose a frame rate from the “Conform to” pop-up menu:
   - 23.98: This frame rate is useful if you want to later use the Final Cut Pro pull-down feature that lets you output 23.98 fps video as 29.97 fps video. (See “Pull-Down Patterns You Can Apply to 23.98 fps Video” on page 194 for more information.)
   - 24.0: You may want to conform and edit the clips at this rate if you plan to include them in a project that contains other clips that are exactly 24 fps.

   Note: If the audio and video are contained in the same clip, and you choose 24.0 from this pop-up menu, the Reverse Telecine feature increases the audio speed by a very small percentage so that it is in sync with 24 fps instead of 23.98 fps.
4 Select "New (smaller)" or "Same (faster)" to specify the kind of file you want to create:

- **New (smaller):** Creates a new clip file that does not contain the extra frames introduced by the pull-down. The new file is about 20 percent smaller than before, but this method is slower. Regardless of whether the original file was referencing or self-contained, this method creates a self-contained file. (See “The Difference Between Self-Contained and Referencing Clips” on page 126 for more information.)

- **Same (faster):** Modifies the current clip file so that the extra frames are not visible to the editing system, but the data is not removed from the file. This process is faster, but does not reduce the size of the file. The resulting file is self-contained if it was originally self-contained, or referencing if it was referencing.

   ![Reverse Telecine dialog box](image)

   When New is selected, "Check for cadence discontinuities" is on. For Same, you can deselect it to speed up processing.

   If you choose New, the file will be smaller. If you choose Same, the processing will be faster.

   **About cadence discontinuity checking:** While removing the pull-down, Cinema Tools looks for breaks in the pull-down cadence and if any breaks are found, it adjusts the processing to accommodate those discontinuities. A cadence discontinuity might occur when a recording is stopped and then starts again at another point in the five-frame sequence.

   Checking for cadence discontinuities is more time-consuming for the Same file option than it is for the New file option, so if you select “Same (faster),” you can deselect the “Check for cadence discontinuities” checkbox for the fastest possible processing.

   **Note:** If this box is deselected and cadence discontinuities exist in the clip, or if the cadence changes from 2:3:3:2 to 2:3:2:3 (or any other pattern) in the middle of a clip because the settings were changed during the recording, reverse telecine cannot be properly performed on the clip.

5 Click OK to start the pull-down removal process.

If you selected the New file option, you are asked to give the new reversed clip a name and location. If the original clip was connected to a database record, the new reversed clip replaces its connection to the record (regardless of whether or not the new clip overwrites the old clip).
Using Automated Batch Reverse Telecine

To remove the pull-down from several clips at once:

1. Place all the clips that you want to process into one folder. (Make sure that they are all clips that were captured from a 24P digital video camcorder.)

2. Choose File > Batch Reverse Telecine.

3. In the dialog that appears, select any source clip file in the folder that contains the clips you want to process, then click Choose.

4. Choose a frame rate from the “Conform to” pop-up menu:
   - **23.98**: This frame rate is useful if you want to later use the Final Cut Pro pull-down feature that lets you output 23.98 fps video as 29.97 fps video. (See “Pull-Down Patterns You Can Apply to 23.98 fps Video” on page 194 for more information.)
   - **24.0**: You may want to conform and edit the clips at this rate if you plan to include them in a project that contains other clips that are exactly 24 fps.

   **Note:** If the audio and video are contained in the same clip, and you choose 24.0 from this pop-up menu, the Reverse Telecine feature increases the audio speed by a very small percentage so that it is in sync with 24 fps instead of 23.98 fps.

5. Select “New (smaller)” or “Same (faster)” to specify the kind of files you want to create:
   - **New (smaller)**: Creates new clip files that do not contain the extra frames introduced by the pull-down. The new files are about 20 percent smaller than before, but this method is slower. Regardless of whether the original files were referencing or self-contained, this method creates self-contained files. (See “The Difference Between Self-Contained and Referencing Clips” on page 126 for more information.)

   If you select “New (smaller),” you can also choose to keep or delete the original clip files. To save the original clips in a separate folder, select the Keep Originals checkbox.
• **Same (faster):** Modifies the current clip file so that the extra frames are not visible to the editing system, but the data is not removed from the file. This process is faster, but does not reduce the size of the file. The resulting file is self-contained if it was originally self-contained, or referencing if it was referencing.

*About cadence discontinuity checking:* While removing the pull-down, Cinema Tools looks for breaks in the pull-down cadence and if any breaks are found, it adjusts the processing to accommodate those discontinuities. A cadence discontinuity might occur when a recording is stopped and then starts again at another point in the five-frame sequence.

Checking for cadence discontinuities is more time-consuming for the Same file option than it is for the New file option, so if you select “Same (faster),” you can deselect the “Check for cadence discontinuities” checkbox for the fastest possible processing.

**Note:** If this box is deselected and cadence discontinuities exist in the clip, or if the cadence changes from 2:3:3:2 to 2:3:2:3 (or any other pattern) in the middle of a clip because the settings were changed during the recording, reverse telecine cannot be properly performed on the clip.

6 Click OK to start the pull-down removal.

After the process is complete, the following occur:

• If you selected “New (smaller),” for each clip in the folder, a new clip with the same name is created and placed in a Cinema Tools–created subfolder named Reversed. If you selected Keep Originals, the original files are placed in a Cinema Tools–created subfolder named Originals. If you selected “Same (faster),” the new versions of the clips replace the old versions, in their original folder.

• If Cinema Tools is unable to complete the reverse telecine process for a clip, that clip is moved into a Cinema Tools–created subfolder named Skipped. A clip is not processed if it doesn’t contain a video track, if the frame rate is not supported, if the clip does not contain cadence information, or if there is no codec found for the video track.

• A text file appears at the top level of the folder you started with, named reverse.log. This log gives the date and time that the process started and ended, as well as a start time for each clip. If any problems were encountered, such as running out of disk space or memory, an error message describing the problem also appears in the log.
Pull-Down Patterns You Can Apply to 23.98 fps Video

When editing 23.98 fps video, you may want to output it to an NTSC monitor, record it to an NTSC videotape, or send it to another type of NTSC device. When you need to do this, you can use the pull-down addition feature in Final Cut Pro. Pull-down addition is a software method of converting 23.98 fps video to the NTSC standard of 29.97 fps.

There are three different patterns of pull-down that Final Cut Pro can apply to 23.98 fps video.

3:2 pull-down

3:2 pull-down is the same type employed by a telecine, as described in “Performing a 3:2 Pull-Down” on page 23. Because 3:2 is the conventionally supported pull-down pattern for NTSC devices, you need to use this pull-down pattern to record to an NTSC device, such as standard definition television, an MPEG-2 encoding device, or a high-end finishing system.
2:3:3:2 pull-down
Another type of pull-down you can use is 2:3:3:2. As with 3:2 pull-down, the “3” in the pattern represents three fields, where one redundant field is added to the original two fields of a frame. See "Working With 2:3:3:2 Pull-Down" on page 188 for details about this pattern and the advantages it provides.

While 3:2 is the conventionally supported pattern for NTSC devices, you may want to use 2:3:3:2 pull-down to output video that you can record to tape and yet later convert back to 24 fps with the advantages of 2:3:3:2 removal (the ability to remove the pull-down without the recompression and re-creation of any frames).

2:2:2:4 pull-down
The 2:2:2:4 pull-down pattern is not typically supported for recording devices or cameras, but it requires the least amount of processing power so it's a good choice if you are editing 23.98 fps video and want to preview it with as many real-time effects as possible on an NTSC monitor. This pattern is also useful if you need to output video for display from an older, slower computer (or a computer with a heavy processing load) that drops frames when you try to output 3:2 or 2:3:3:2 pull-down video.
Adding Pull-Down to 23.98 fps Video

Final Cut Pro lets you add pull-down to 23.98 fps video as you output it via FireWire. As discussed in the previous section, this is useful when you are editing 23.98 fps video and want to output it to an NTSC device.

To add pull-down back in while sending 23.98 fps video to an NTSC device via FireWire:

1. In Final Cut Pro, select the sequence.
2. In the Playback Control tab of the Sequence Settings window, choose a pull-down pattern from the Pulldown Pattern pop-up menu. See “Pull-Down Patterns You Can Apply to 23.98 fps Video” on page 194 for details on the available patterns.
3. Output the video using your FireWire connection.

The pull-down is performed on the video that is sent out of your computer via FireWire.

Using Audio EDLs for Double System Sound

As with film productions, 24P video productions almost always record the audio separately from the picture, with a separate audio recorder. This is referred to as using double system sound. This audio is often simultaneously recorded onto the videotape of the 24P VTR, making it easy to later capture both the video and audio, with the audio already synced to the video for the edit.
In most cases, once you are done editing, you will want to recapture the audio from the original production tapes and finish it at an audio postproduction facility. The difficulty is that the EDL from Final Cut Pro does not know the reel numbers and timecode of the original production audio reels; it only has the videotape information. Since the production audio recorder is started and stopped independently of the VTR, its timecode will not match the VTR’s.

Using its database feature, Cinema Tools can match the edits using the videotape audio with the original production audio tapes, and generate an audio EDL that can then be used to recapture and finish the audio.

You must create a Cinema Tools database before you can use this feature. See “Creating a New Database” on page 66 for details on creating a database and “Exporting an Audio EDL” on page 161 for details on exporting an audio EDL from Cinema Tools.
Part III: Appendixes

These appendixes contain general information related to using Cinema Tools. The glossary and index can help you quickly find the information you are looking for.

Appendix A  Background Basics
Appendix B  How Cinema Tools Creates Film Lists
Appendix C  Solutions to Common Problems and Customer Support

Glossary
Index
Background Basics

Before you use Cinema Tools to edit your film, it's helpful to have a general understanding of a few film properties and be familiar with the traditional film editing method. This appendix provides basic background information on film and how it is edited, both traditionally and digitally.

Most of this information is very general and is not intended to be a complete guide (or the final word) on the film process. There are a wide variety of resources that can provide detailed information on the subject.

Film Basics
There are a number of things that differentiate the various film standards. The most common are

• frame size
• perforation arrangement (how many sprocket holes per frame)
• film edge codes, including key numbers and ink numbers
• speed (how many frames per second)

The following sections discuss these points as they relate to Cinema Tools.

Frame Size
Cinema Tools supports two common film frame sizes: 16mm and 35mm. The aspect ratio (height versus width) of each size is different.
Due to its lower costs, 16mm film is typically used for productions with smaller budgets. If you intend to shoot 16mm but release your project as 4-perf 35mm, then you should use Super 16mm film. It has perforations along only one edge and a larger frame that more closely matches the 4-perf 35mm aspect ratio.

![16mm format and Super 16mm]

35mm film is most commonly used for theatrical releases, with 4 perforations per frame (4-perf) the most prevalent version. There are other versions of 35mm, such as 3-perf and 8-perf, but they are not currently supported by Cinema Tools.

![35mm format 4-perf]

**Perforations**

Camera and projection equipment use the perforations, also known as *sprocket holes*, along one or both edges of film to pull it past the shutter.

16mm film is available as single perforated (perforations along one edge only, allowing space for an optical track, or in the case of Super 16mm film, for a larger frame) and double perforated (perforations along both edges).

Cinema Tools supports the 20-perf 16mm format. It supports this format for film and change lists based on key numbers. It does not support it for film and change lists based on ink numbers. (See the next section for information about key numbers and ink numbers.)

Cinema Tools supports the 4-perf 35mm format for all types of film lists and change lists. It is by far the most common 35mm format. There are 16 frames per foot.
**Film Edge Code**

To aid in locating specific film frames, film manufacturers place numbers along the edge of the film. These key numbers (also known as *latent edge code*) appear once the film is developed. For workprints, film labs can add numbers called *ink numbers* (also known as *Acmade numbers*).

Edge code is essential to your Cinema Tools database because it makes it possible for you to export cut lists or change lists that specify exactly where your negatives or workprints need to be cut in order to match your digital edits.

**Key Numbers**

Key numbers provide both an identification number for each roll of film and an incremental footage count number used to identify specific film frames. They often appear as both regular text and as a bar code.

Each film standard uses key numbers differently:

- **16mm film** can have a key number every 20 frames (most common) or 40 frames, depending on the film stock. Cinema Tools supports the 16mm-20 format.
- **35mm film** has a key number every 64 perforations (which works out to every 16 frames with the 4-perf format).

Unlike video timecode, which provides a unique number for each video frame, key numbers do not appear on every frame of film. For this reason, when identifying a specific frame in a log book or in Cinema Tools, key numbers have a frame count extension added specifying the actual frame. A “+08” at the end of a key number indicates it is the eighth frame from that key number’s first frame.
In the previous illustration, the actual key number for the center frame is KJ 29 1234 5678+00. The “•” following the number indicates frame 00 for that key number. (With 4-perf film—the kind shown in the illustration—there are 16 frames per key number with the first one starting at “00.”) The frame to the right would be KJ 29 1234 5678+01. The frame to the left would be the last frame of the previous key number, KJ 29 1234 5677+15. (16mm film places the “•” at the beginning of the key number.)

35mm film also has mid-foot markers halfway between the zero frame markers. These help to identify a midpoint (the “+08” frame in the previous example) and reduce the chance of a miscount. These markers use the same key number with a “+32” appended (indicating the perforation number, not the frame number) in a smaller font.

**Ink Numbers**

Ink numbers, frequently used for workprints, are another method of encoding the edge of film in order to track feet and frames. Ink numbers are added to workprints and corresponding magnetic-stripe film soundtracks (called *mag tracks*), after the workprint and the mag track have been synchronized. On transferred workprints, ink numbers are easier to read than key numbers, and they provide a counting mechanism that is synchronized for both the soundtrack and the workprint. Ink numbers are sometimes called *Acmade* numbers because Acmade makes a machine that is used to print ink numbers. Machines that print ink numbers are commonly rented or owned and run by film crews.

The typical style of ink numbering is a three-digit prefix followed by a character or space, followed by four digits representing the footage number, followed by digits representing the frame offset. For example, in ink number 123 4567 +08, “123” is the prefix, and “4567+08” is the frame number, indicating that the frame occurs at 4567 feet and 8 frames. The ink numbers encoded on the film do not actually include the last part (the frame offset number). Rather, the frame offset is calculated by the telecine and appears in the telecine log.

The prefix may be fewer or more than three digits, and the numbering technique for the prefix is usually determined by an editing assistant. For example, the numbering could be associated with the scene number, as in “042” for the footage in scene 42. Or, the prefixes might represent daily roll numbers.
Window Burn
As part of the telecine transfer process (described in “Transferring Film to Video” on page 19), the key number is typically burned in to the video (along with the video and audio timecode), helping to identify specific frames. The burned-in numbers are called window burn.

It is much easier to use Cinema Tools if you can see the key numbers. You can use Cinema Tools without the window burn, but it requires more effort on your part to ensure edits are being tracked properly.

Note: Once you have captured your video but before you start editing, check the burned-in key numbers and timecode to make sure they match the actual ones on the film and videotape. Any errors at this point will result in serious problems when the negative is conformed. The most common way to verify these numbers is to have the lab or transfer facility physically punch a hole or otherwise mark a film frame, note its key number, and compare it to the burned-in key number when viewing the transferred video.

Speed
Film normally has a frame rate of 24 frames per second (fps). This means a new image is exposed or projected 24 times a second. To ease conversion to video frame rates, it is common to run the film at rates other than 24 fps during the telecine transfer. Cinema Tools supports film transferred to video with the telecine running at the rates of 23.98 fps, 24 fps, 25 fps, and 29.97 fps (30 fps). See “Frame Rate Basics” on page 22 for more frame rate information.
Editing Film Using Traditional Methods

The traditional process of editing film has changed little over the years. While the equipment has improved dramatically, the steps are basically the same. Following is a simplified workflow outlining the film editing process.

Note that the original camera negative is almost never used during the creative editing part of the process. The negative must be handled as little as possible, and then by professionals in the proper environment, to avoid damaging it.

**Step 1: Shoot the film and record the sound**

Audio is always recorded separately from the film, on a separate audio recorder. This is known as *shooting double system sound*. While shooting the film, you need to include a way to synchronize the sound to the picture. The most common method is to use a clapper board (also called a *slate* or *sticks*) at the beginning of each take. There are a number of other methods you can use, but the general idea is to have a single short noise that is both audible and visible (you can see what caused the noise).

**Step 2: Develop the film**

The developed film is known as the *original camera negative*. This negative will eventually be conformed to create the final movie and must be handled with extreme care to avoid scratching or contaminating it. Normally, the negative is used to create a workprint (film positive) and then put aside until the negative is conformed.

**Step 3: Create the workprint**

The workprint is created from the original camera negative, and gives you a copy of the raw film footage to use for the editing process. Because workprints are film positives, they can be projected and used as *dailies*, letting you view what has been shot.
**Step 4: Create audio scratch tracks**
An audio scratch track is similar to the film's workprint—it's a copy of the production sound to use while editing. Depending on the type of mechanical film editor you intend to use, you will often create an audio scratch track on magnetic film. Magnetic film, known as *single stripe*, *three stripe*, *mag stock*, and *fullcoat*, uses perforations like regular film, but is coated with magnetic material. Once synced with the film on the editor, both it and the workprint are run in tandem, maintaining their sync while editing.

**Step 5: Edit the workprint**
This is the point when you make decisions regarding which parts of the film footage you want to use and how you want it laid out. Editing the workprint involves physically cutting and splicing at each edit point. Changing your mind about the exact placement of a cut or trying an alternate edit is time consuming and tends to be hard on the film. (This is the part of the process that digital editing greatly facilitates.) Once you are satisfied with the edited workprint, you send it to the negative cutter.

**Step 6: Conform the negative**
The negative cutter uses the edited workprint as a guide to make edits to the original camera negative. This process is called *conforming*. Since there is only one negative, it is crucial that no mistakes are made at this point. As opposed to the cutting and splicing methods used when working with the workprint, the cutting and splicing methods used for conforming the negative destroy frames on each end of the edit. This makes extending an edit virtually impossible, and is one of the reasons you must be absolutely sure of your edit points before beginning the conform process.

**Step 7: Edit the audio**
You typically “rough-cut” the audio while editing the workprint. While the negative is being conformed, the audio is edited (using the original tapes) and finished with sound effects and any required dialogue enhancements.

**Step 8: Create the answer and release prints**
Once the original camera negative has been conformed and the audio finalized, you are able to have an answer print created. This print is used for the final color timing, where the color balance and exposure for each shot are adjusted to ensure the shots all work well together. You may need to create several answer prints before you are happy with the results. Once you are satisfied with the answer print, the final release print is made.
Editing Film Using Digital Methods

The process of editing film digitally is constantly evolving, but the basic concept remains the same—you start and end on film, with only the creative part of the editing process changing. Following is a simplified workflow outlining the basic steps. (See Chapter 2, “The Cinema Tools Workflow,” on page 33 for a more detailed explanation of these steps.)

Although this workflow appears more complicated than the one that illustrates the traditional editing method, many of these steps can be automated. For most filmmakers, the benefits of being able to edit digitally easily offset any added procedures that the process adds.

Several of the steps are identical to the traditional method—as mentioned earlier, it is only the middle part of the film editing process that is affected by editing digitally.

**Step 1: Shoot the film and record the sound**
Audio is always recorded separately from the film, on a separate audio recorder. This is known as *shooting double system sound*. While shooting the film, you need to include a way to synchronize the sound to the picture. The most common method is to use a clapper board (also called a *slate* or *sticks*) at the beginning of each take. There are a number of other methods you can use, but the general idea is to have a single short noise that is both audible and visible (you can see what caused the noise).

**Step 2: Develop the film**
The developed film is known as the *original camera negative*. This negative will eventually be used to create the final movie and must be handled with extreme care to avoid scratching or contaminating it. The negative is used to create a video transfer (and typically a workprint, as with the traditional method) and then put aside until the negative is conformed.
Step 3: Transfer the film to video
The first step in converting the film to a format suitable for use by Final Cut Pro is to transfer it to video, usually using a telecine. While the video that the telecine outputs is typically not used for anything besides determining edit points, it’s a good idea to make the transfer quality as high as possible. If you decide against making workprints, this may be your only chance to determine if there are undesirable elements (such as microphone booms and shadows) in each take before committing to them. The video output should have the film’s key number, the video timecode, and the production audio timecode burned in to each frame.

The actual videotape format used for the transfer is not all that important, as long as it uses reliable timecode and you will later be able to capture the video and audio digitally on the computer prior to editing. An exception is if you intend to use the video transfer to also create an edited video version of the project, perhaps for a video trailer. This requires two tapes to be made at the transfer—one that is high quality and without window burn, and another that has window burn.

It is strongly recommended that the audio be synced to the video and recorded onto the tape along with the video during the telecine process. There are also methods you can use to sync the audio after the telecine process is complete—the important thing is to be able to simultaneously capture both the video and its synchronized audio with Final Cut Pro.

Step 4: Create a Cinema Tools database
The key to using Cinema Tools is its database. The database is similar to the traditional code book used by filmmakers. It contains information on all elements involved in a project, including film key numbers, video and audio timecode, and the actual clip files used by Final Cut Pro. Depending on your situation, the database may contain a record for each take used in the edit or may contain single records for each film roll. The film-to-video transfer process provides a log file that Cinema Tools can import as the basis of its database. It is this database that Cinema Tools uses to match your Final Cut Pro edits back to the film’s key numbers while generating the cut list.

There is no requirement that the database be created before the video and audio are captured, or even before they are edited. The only real requirement is that it must be created before a cut list can be exported. The advantage of creating the database before capturing the video and audio is that you can then use it to create batch capture lists, allowing Final Cut Pro to capture the clips. The database can also be updated and modified as you edit.
Step 5: Capture the video and audio
The video created during the telecine process must be captured as a digital file that can be edited with Final Cut Pro. The way you do this depends on the tape format used for the telecine transfer and the capabilities of your computer. You need to use a third-party capture card to capture files from a Betacam or DigiBeta tape machine. If you are using a DVCam source, you can import directly via FireWire. To take advantage of Final Cut Pro’s batch capture capability, you should use a frame-accurate, device-controllable source.

As opposed to the captured video, which is never actually used in the final movie, the edited audio can be used. You may decide to capture the audio at a high quality and export the edited audio as an Open Media Framework (OMF) file that can be imported at a Digital Audio Workstation (DAW) for finishing. Another approach is to capture the audio at a low quality and, when finished editing, export an audio EDL that can be used by an audio postproduction facility, where the production sound can be captured and processed at a very high quality.

Step 6: Process the video and audio clips
Depending on how you are using Cinema Tools, the captured clips can be linked to the Cinema Tools database. They can also be processed, using the Cinema Tools Reverse Telecine and Conform features, to ensure compatibility with Final Cut Pro’s editing timebase. For example, the Cinema Tools Reverse Telecine feature allows you to remove the extra frames added when transferring film to NTSC video using the 3:2 pull-down process.

Step 7: Edit the video and audio
You can now edit the project using Final Cut Pro. For the most part, you edit your film project the same as any video project. If you captured the audio separately from the video, you can synchronize the video and audio in Final Cut Pro.

Any effects you use, such as dissolves, wipes, speed changes, or titles, are not used directly by the film. These must be created on film at a facility specializing in film opticals.

It can be helpful for the negative cutter if you output a videotape of the final project edit. While the cut list provides all the information required to match the film to the video edit, it helps to visually see the cuts.

Step 8: Export the film lists
Once you’ve finished editing, you use the Cinema Tools Film Lists dialog to export a variety of film-related lists, including the cut list, which the negative cutter uses to match the original camera negative to the edited video. Additional lists can also be generated, such as a dupe list, which indicates when any source material is used more than once.
Step 9: Create a test cut on a workprint

Before the original camera negative is conformed, it is strongly suggested that you conform a workprint to the cut list to make sure the cut list is accurate (some negative cutters insist on having a conformed workprint to work from). There are a number of things that can cause inaccuracies in a cut list:

- damaged or misread key numbers entered during the telecine transfer process
- incorrect timecode values
- timecode errors during the capture process
- with NTSC video, 3:2 pull-down problems

In addition to verifying the cut list, other issues, such as the pacing of a scene, are often hard to get a feel for until you see the film projected on a large screen. This also gives you a chance to ensure that the selected shots do not have unexpected problems.

If your production process involves workprint screenings and modifications, you can also export a change list that describes what needs to be done to a workprint to make it match a new version of the sequence edited in Final Cut Pro.

Step 10: Conform the negative

The negative cutter uses the cut list, edited workprint, and the edited video (if available) as a guide to make edits to the original camera negative. Since there is only one negative, it is crucial that no mistakes are made at this point. As opposed to the cutting and splicing methods used when working with the workprint, the cutting and splicing methods used for conforming the negative destroy frames on each end of the edit. This makes extending an edit virtually impossible, and is one of the reasons you must be absolutely sure of your edit points before beginning the conform process.

Step 11: Finish the audio

You usually rough-cut the audio while editing the video (step 7); the audio is typically finished while the film is being conformed. As mentioned in step 5, you can use an OMF-exported version of the Final Cut Pro edited audio or export an audio EDL and recapture the production sound (using the original tapes) at a DAW. Finishing the audio is where you perform the final sound mix, including cleaning up dialogue issues and adding sound effects, backgrounds, and music.

Step 12: Create the answer and release prints

Once the original camera negative has been conformed and the audio finalized, you are able to have an answer print created. This print is used for the final color timing, where the color balance and exposure for each shot are adjusted to ensure the shots all work well together. You may need to create several answer prints before you are happy with the results. Once you are satisfied with the answer print, the final release print is made.
How Cinema Tools Creates Film Lists

Cinema Tools can produce a film list only if it can match edits made in the editing system to records in the Cinema Tools database. The database record contains the film roll and key number information that Cinema Tools needs in order to describe the edit in the film list.

In creating a film list, there are two basic methods Cinema Tools uses to locate a database record associated with a particular edit:

- **Clip-based method**: Cinema Tools obtains the clip name from Final Cut Pro, then looks for the clip in the database. Cinema Tools first tries to locate the clip based on the clip pathname indicated in the editing system. If it fails to find the clip by looking for the pathname, it searches for the clip by its name and modification date. When Cinema Tools finds the clip in the database, it can also locate the associated record, because each clip must be linked to one record.

- **Timecode-based method**: If Cinema Tools can’t find the database record using the clip name, it finds the database record by looking for the video reel and timecode associated with the edit in the sequence in Final Cut Pro.
Cinema Tools always uses the clip-based location method when it can. If it doesn’t find a matching clip, it uses the timecode-based location method. If Cinema Tools cannot find a suitable database record with either method, the key number and film roll appear in the film list as “<missing >,” and an entry is logged in the missing elements list (if you chose to include a missing elements list in the film list). This process is outlined in the flow chart below.
About the Clip-Based Method
For Cinema Tools to locate a database record using the clip-based location method, it needs to know only the relationship between the source clip and the key numbers or ink numbers. In contrast, the timecode-based method depends on Cinema Tools knowing the relationship between the key numbers or ink numbers and the video reel and timecode. Because the clip-based method relies on fewer variables, it is more reliable, which is why Cinema Tools tries to use this method first.

If you conform the frame rate of clips from 25 fps to 24 fps, Cinema Tools can rely only on the clip-based method to locate records for film lists. The reason for this is that the clip now has new timecode for its new frame rate, so the timecode-based method is unreliable. You can see the new timecode in the editing system, where the frame offsets in the timecode won’t always match the frame offsets in the window burn.

Note: The timecode-based method can be used after clips are reverse-telecined from 30 fps to 24 fps, because Cinema Tools tracks the original timecode in this case.

About the Timecode-Based Method
There are some situations in which the timecode-based method is useful or even essential:

- If you have not logged clips in the Cinema Tools database by connecting them to database records, then only the timecode-based method can locate the database records. If the database contains the data that is needed to match the edge code and the timecode, and if the source clips were captured by Final Cut Pro using frame-accurate device control, Final Cut Pro should know which video reel and timecode goes with each clip and a film list can be produced from this information. (In such a case, you do not have to connect the source clips to the database records, saving you a fair amount of labor.)

- If you are generating a film list from an external EDL, the timecode-based method is used (assuming you have not connected the source clips to the database).

- If the clip files are inaccessible (offline) when the film list is generated, only the timecode-based method can locate the database records.
Solutions to Common Problems
and Customer Support

If you run into problems while working with Cinema Tools, there are several resources you can use to find a solution.

- **This appendix:** This appendix includes information about some of the most frequent issues users encounter.
- **Late-Breaking News:** A late-breaking news page in the Cinema Tools Help menu provides last-minute information that didn’t make it into the manual. Be sure to consult this Help page as soon as you install or upgrade Cinema Tools.
- **AppleCare Knowledge Base:** AppleCare Support maintains a database of common support issues that is updated and expanded to include new issues as they arise. This is an excellent, free resource for Cinema Tools users. To access the AppleCare Knowledge Base, go to the AppleCare support page at [www.apple.com/support](http://www.apple.com/support)
- **AppleCare Support:** There are a variety of support options available to Cinema Tools customers. For more information, see the Apple Professional Software Service & Support Guide that comes with your Cinema Tools documentation.

Solutions to Common Problems

**No film list is produced.**
- When you export a film list from Final Cut Pro, Cinema Tools opens it if it isn’t already open. If you selected the option in the Film Lists dialog to open the film list in a text editor, the text editing application must also open in order for you to view the film list. If you don’t see the film list, it may be that Cinema Tools or the text editor failed to open. The most likely reason for this is insufficient memory. Make sure that an adequate amount of random-access memory (RAM) is installed in your computer.
- If Cinema Tools opens, but the text editor doesn’t, perform a search for the film list file by searching for the name you entered in the Film Lists dialog. If the file exists, you should be able to open it in a text editing application.
There are missing elements reported in the cut list.

- In the cut list, "<missing >" appears whenever an element that Cinema Tools requires to create the cut list is missing. If you chose to include a missing elements list in the film list, you’ll see all missing items listed there. See “Missing Elements List” on page 139, for information about which elements might be missing and how to resolve them.

You see warnings about duplicate usages of source material.

- When the number of frames reused is fewer than the number of frames you entered in the Cut Handles or Transition Handles settings, it’s possible that a duplicate usage warning is a result of the cut handles or transition handles. To determine whether this is the case, try setting the Transition Handles option to zero frames and the Cut Handles option to one half of a frame, then export the film list again.

- When your edited program contains duplicate usages of source material and you only have one original camera negative to cut, you have a couple of options. You can reedit your scene or scenes in order to avoid using the material more than once. Or, you can export a dupe list and give it to a lab so they can create duplicate negatives of each shot that is used more than once. You then transfer the duplicate negatives to video, capture them into Final Cut Pro, log them in the Cinema Tools database, and use them to replace the duplicate sections in your edited project.

The key numbers in the cut list do not match the key numbers in the digital clips.

- First, make sure that it is something to be concerned about. When editing at the NTSC video rate of 30 fps (actually 29.97 fps), key numbers might be off by +/- one frame. This is normal and to be expected if you edited at the NTSC video rate. (See “Frame Rate Basics” on page 22.) Also, the key number may be off by more than one frame at the end of the cut, if it was necessary to add or subtract a frame in order to maintain sync with the sound. However, under no circumstances should the key number be off by more than one frame at the beginning of the cut. And, if you are editing PAL video at 24 fps, the key number you see burned in to the frame should never be different from the key number you see in the cut list at the In and Out points.

- If the difference is more than one frame, the most likely cause is that the clip is not properly identified in the Cinema Tools database. To check that the clip is correctly identified, go to the corresponding database record, then click Open Clip to open the Clip window. Use the Identify feature to check the key numbers for more than one location in the clip to see if the frames are properly identified. If the key number was entered incorrectly, correct it in the Identify window. See “Verifying and Correcting Edge Code Numbers and Timecodes” on page 88 for more information. Then, generate the cut list again, and verify that the correct key numbers are now displayed.
• Make sure that the timecode is accurate in Final Cut Pro. If you used device control to capture your clips, but find that Cinema Tools is reporting the wrong timecode, there is a good chance that the timecode is incorrect in Final Cut Pro. If the timecode is wrong in Final Cut Pro, recapture the source clips. If you used serial device control, the timecode mismatch may have happened because you did not set the appropriate timecode offset in Final Cut Pro for the specific deck you used. You need to make this setting once per deck, per computer. If the serial device control timecode offset was not set, set it, then recapture the source clips. For more information, see the section on calibrating the timecode signal in the Final Cut Pro documentation.

• Make sure that all the clips in your sequence have the same frame rate as the editing timebase for the sequence in Final Cut Pro. See the Final Cut Pro documentation for details on setting the editing timebase in the Sequence Preset Editor.

• There may be dropped frames or discontinuities in the key numbers of the video. Try recapturing the clips.

When you try to use the Reverse Telecine feature, you see an error about dropped frames.

• Occasionally there are clips that contain frames that are longer than they should be. This situation can cause the Cinema Tools reverse telecine process to report one or more dropped frames, when in fact there aren’t any. Try conforming the clip to 29.97 fps with the Conform feature, then start the reverse telecine process again.

• If frames were actually dropped during the capture process, it’s best to recapture the source clips without dropped frames because dropped frames can interfere with the reverse telecine process. See “Avoiding Dropped Frames” on page 96.

You see unexpected .tmp files.

• Cinema Tools may create several temporary files in the process of creating the cut list. These files are normally deleted when the process is complete, so you don’t see them. If a system failure occurs before the film list is generated, these files might not be deleted. If you find any CinemaTools–generated files with a suffix of *.tmp, *.tmp.dat, or *.tmp.idx, you can delete them.

In the cut list, you see an error about a temporary file.

• If a problem occurs while Cinema Tools is creating a temporary file, you might see error messages in the cut list about these files. The most likely reason for this problem is that there is not enough disk space available on the storage volume. Make sure the storage volume has disk space available.
Calling AppleCare Support

Included in your Cinema Tools package is documentation about the support options available from Apple. Several levels of support are available, depending on your needs.

Whatever your issue, it’s a good idea to have the following information immediately available. The more of this information you have ready to give to the support agents, the faster they will be able to address your issue.

- The Support ID number that came with Final Cut Pro. This number is different from the software serial number that is used to activate your copy of Final Cut Pro.
- Which version of Mac OS X you have installed. This information is available by choosing About This Mac from the Apple menu.
- The version of Cinema Tools you have installed, including updates if applicable. The version number can be viewed by choosing Cinema Tools > About Cinema Tools.
- The model of computer you are using
- How much RAM is installed in your computer, and how much is available to Cinema Tools. You can find out how much RAM is installed by choosing About This Mac from the Apple menu in the Finder.
- What other third-party hardware is connected to or installed in the computer, and who are the manufacturers. Include hard disks, video cards, and so on.
- Any third-party plug-ins or other software installed along with Cinema Tools

AppleCare Support can be reached online at www.info.apple.com/usen/cinematools
2:3:2:3 pull-down  A pull-down method that is the same as the 3:2 pull-down, except that it is applied by a digital video camcorder (as opposed to any other type of equipment that could apply the same pattern of pull-down). This manual uses the term “2:3:2:3” when referring to the pull-down that comes from a 24P digital video camcorder; this type of pull-down can be removed using the automated form of reverse telecine. See also 3:2 pull-down.

2:3:3:2 pull-down  A method of distributing film’s 24 fps among NTSC video’s 30 fps when film or 24P video is transferred to NTSC video. In the transfer, the recording alternates two fields of one frame and then three fields of the next two frames, followed by two fields of the next frame. In this way, the 24 frames in one second of film or 24P video fill up the 30 frames in one second of video. While 3:2 is the conventionally supported pull-down pattern for NTSC devices, some digital cameras and editing systems are beginning to support 2:3:3:2 pull-down.

24&1  A method of transferring film to PAL video, where two extra fields per second are added to the video so the 24 frames in a second of film are all contained within the 25 frames per second of PAL video. This method maintains the original action speed. See also 24@25.

24@25  The most common method of transferring film to PAL video, where the film is sped up during the telecine transfer to 25 fps. This creates a one-to-one film-to-video frame relationship, but speeds up the action by 4 percent. See also 24&1.

24P  A high definition video format using a 24 fps rate and progressively scanned video. It is finding wide use in film production due to its high quality and identical frame rate. It also converts easily to most 30 fps and 25 fps standard and high definition video formats.

3:2 pull-down  A method of distributing film’s 24 fps among NTSC video’s 30 fps when film or 24P video is transferred to NTSC video. In the transfer, the recording alternates 2 fields of one frame and then 3 fields of the next, so that the 24 frames in one second of film or 24P video fill up the 30 frames in one second of video. Also known as 2:3 pull-down.
**4-perf 35mm** A common 35mm film format that is supported by Cinema Tools. Refers to having four perforations (sprocket holes) for each film frame.

**Acmade numbers** See *ink numbers*.

**“A” frame** The first frame in the repeating five-frame 3:2 pull-down sequence. In two-field 3:2 pull-down video, it is the only frame that fully contains both fields from a single film frame. B, C, and D frames have their fields split among two video frames. “A” frames normally occur on timecode numbers ending with “0” or “5” (when using non-drop frame timecode). See also *field; 3:2 pull-down*.

**ALE file** Acronym for *Avid Log Exchange*. A file format that allows film databases to be shared between different systems. See also *telecine log*.

**answer print** The first film print that includes sound and picture, submitted by the laboratory for the customer’s approval.

**aspect ratio** The ratio of an image's width to its height expressed either as two numbers (width:height) or as a value equal to the height divided by the width. Standard video uses 4:3 (0.75) while 24P video uses 16:9 (0.56). Film aspect ratios depend on the format and lenses used.

**change list** A list you can export from Final Cut Pro with Cinema Tools, which assumes a workprint or negative has been cut to the specifications of a cut list (or prior change list) and specifies further changes to make based on new edits you have made to a Final Cut Pro sequence.

**conform (film)** To cut and arrange an original camera negative to match edits made in a digital editing system. Also, to assemble video or audio according to an Edit Decision List (EDL). See *cut list* and EDL.

**conform (video)** To change the frame rate of a video clip. For example, you can use the Cinema Tools Conform feature to change the frame rate of a PAL 25 fps video clip to film’s 24 fps rate. You can also conform a clip to its current frame rate, ensuring there are no frame rate errors within it.

**contact printing** A film printing method where the emulsion sides of the original camera negative and the print stock are in contact as the negative is projected onto the print stock. Creates an image that is reversed in color and light (for example, black becomes white and white becomes black).

**cut list** A text file that sequentially lists the edits that make up your program. The negative cutter uses the cut list to conform the original camera negative. The cut list is a subset of the film list you can export from Final Cut Pro using Cinema Tools. Also known as an *assemble list*. 
device control  Technology that allows Final Cut Pro to control an external hardware device, such as a video deck or camera.

DF  See drop frame timecode.

double system sound  Any production using separate devices to record the image and the sound. Always used in film productions and often used in 24P productions. Also known as dual system production.

downconverted video  Video created by converting high definition video (such as 24P) to standard definition video (NTSC or PAL).

drop frame timecode  NTSC timecode that skips ahead in time by two frame numbers each minute, except for minutes ending in “0,” so that the end timecode total agrees with the actual elapsed clock time. (Timecode numbers are skipped, but actual video frames are not skipped.) This skipping corrects for NTSC’s actual frame rate of 29.97 fps. It corrects for an inaccuracy of 3 seconds and 18 frames per hour in comparison to actual elapsed time when non-drop frame timecode is used. To avoid confusion, drop frame timecode should be avoided in film-based productions. See non-drop frame timecode.

dropped frames  Frames that are not captured. If computer performance is impeded or if the scratch disk is not fast enough, frames may be dropped during the capture process. When a frame is dropped during capture, the frame before it is repeated. Dropped frames can result in an incorrect cut list and interfere with the reverse telecine process.

dupe list  A film list Cinema Tools users can export, which indicates duplicate uses of the same film source material in an edited program.

edge code  Refers to feet and frame count numbers found on the film edge. May be latent key numbers on the original camera negative, or ink numbers added to the edge of workprints. See also key number and ink number.

EDL (Edit Decision List)  A text file that sequentially lists all of the edits and individual clips used in a sequence. EDLs are used to move a project from one editing application to another, or to coordinate the assembly of a program in a tape-based online editing facility.

field  Half of an interlaced video frame consisting of the odd or the even scan lines. Alternating video fields are drawn every 1/60 of a second in NTSC video (1/50 of a second in PAL) to create the perceived 30 fps video (25 fps PAL). There are two fields for every frame, an upper field and a lower field. It is possible to capture only one field of each frame. See also interlaced.

field dominance  Refers to the field that occurs first in an interlaced video frame. If only one field is captured, field 1 dominance means that only field 1 is captured and field 2 dominance means that only field 2 is captured. See also field.
**film list**  A text file you give to the negative cutter to guide them in conforming the original camera negative. The film list may contain one or more of the following: a cut list, a missing elements list, a dupe list, an optical list, a pull list, and a scene list. May also contain additional information for pulling the negative rolls, making duplicate negatives, making a workprint, or printing effects.

**FLEx file**  A common telecine log file format. See also telecine log.

**footage number**  Part of a key number; refers to the four-digit number indicating the position on a film roll. See also frame number; key number.

**found set**  The set of database entries shown in the Cinema Tools List View window. This set is called the found set because you use the Find command to display it.

**fps**  Acronym for frames per second.

**frame**  A single still image. Film and video are made up of a series of these images. While a film frame is a photographic image, a video frame contains one or more fields.

**frame number**  The last part of the key number. The frame number consists of the footage number and the frame counter, and indicates how many feet and frames into the film a particular frame occurs. See also key number.

**HD video**  See high definition video.

**high definition video**  Refers to any of a wide range of video formats, including the 24P format, providing a higher quality image than standard video. Enhancements can include increased resolution, a wider aspect ratio, and progressive scanning. See also standard definition video; progressive video.

**identifier**  In Cinema Tools, a combination of one or more letters, numbers, or both, that identifies a shot, scene, take, video reel, sound roll, lab roll, or camera roll.

**ink number**  A feet and frame count number added to the edge of workprints and magnetic film sound tracks. Also known as an Acmode number.

**interlaced**  See interlaced video.

**interlaced video**  A video frame format that divides the lines into two fields, each consisting of alternating odd and even lines, which are scanned at different times. Used in standard definition video. See also field; field dominance; progressive video.

**interpositive (IP)**  A low-contrast positive film print made from an original camera negative. It is not projectable as a full-color image, since it has an orange mask on it like a negative. IPs are typically used as an intermediate step in creating opticals and duplicate negatives.
**key number**  Latent feet and frame count numbers found on the film edge. Key numbers are often superimposed by the telecine onto the edge of the video frames (this is called window burn). Cinema Tools uses key numbers to help match digital edits back to the original camera negative. Key numbers consist of a key prefix, which is unchanging throughout an entire roll of film, and a frame number, which consists of a footage number and a frame count number. Telecine systems also often add a frame type identifier to the key number. For example, in the key number KJ 291010 5867 +07 B, the key prefix is KJ 291010, the frame number is 5867 +07, and the frame type identifier is B. Also known as edge code.

**latent key number**  A number added to the film edge during its manufacturing process. Also known as latent edge code. See also key number.

**match back**  To match the edits of a video program sourced from film back to the original camera negative. All the edits to the video are listed in a cut list, which the negative cutter uses to cut the workprint and original camera negative.

**NDF**  See non-drop frame timecode.

**negative cutter**  A professional who conforms the original camera negative according to a cut list and/or a visual reference such as workprint or a videotape generated by the digital editing system.

**non-drop frame timecode**  Normal NTSC timecode, where frames are numbered sequentially and there are 30 frames per second, 60 seconds per minute, and 60 minutes per hour. Because NTSC's frame rate is actually 29.97 fps, non-drop frame timecode is off by 3 seconds and 18 frames per hour in comparison to actual elapsed time. Compare to drop-frame timecode.

**NTSC**  Acronym for National Television Standards Committee, the organization that defines North American broadcast standards. The term NTSC video refers to the video standard defined by the committee, which is 29.97 fps, 525 lines per frame, and interlaced.

**offline edit**  The creative edit, where edit decisions are made. When the offline edit is finished, the material is often recaptured at high quality or an EDL is generated for recreating the edit on another system. See EDL.

**OMF**  Acronym for Open Media Format. A media interchange format, supported by many Digital Audio Workstations, that allows all of the audio and edit points in an audio sequence to be exported as a self-contained file. OMF files are often given to an audio postproduction facility, finished there, and then used as the final audio in a feature.

**online edit**  The final editing process, where all the decisions made in the offline edit are applied to the original camera negative or full-resolution video reels.
optical list A film list Cinema Tools users can export for the optical house to use in
printing effects for film. The optical list describes transition and motion effects that you
created in your digital edit.

optical printer Rephotographs one or more film elements onto a new section of film.
An optical printer can add or delete light from an image, create superimposed effects,
or make scene transitions such as wipes, fades, and dissolves.

opticals Effects produced by an optical printer, including transitions and
superimposed titles. See also optical printer.

original camera negative Also known as OCN. The negatives from the film shoot; the
original source film. The original camera negative is what the negative cutter cuts after
all the edits have been finalized in the digital editing system. There is only one original
camera negative. (Duplicate negatives can be made, but they are expensive.)

PAL Acronym for Phase Alternating Line. A video format used by many European
countries and other countries outside North America. The PAL standard is 25 fps, 625
lines per frame, and interlaced.

progressive video A video frame format that progressively scans all lines in a frame.
See also interlaced video.

pull list A film list Cinema Tools users can export, in which cut list shots are listed in
the order that they can be found on the negative rolls. The lab refers to a pull list when
going through your negative rolls to pull shots for a workprint or original camera
negative cut.

release print A positive print of a finished movie; the final product for distribution.

reverse telecine The process that removes the extra frames from 3:2 pull-down video,
returning it to its original 24 fps frame rate. Reverse telecine creates a one-to-one
relationship between the video and film frames so that the cut lists are accurate.
Reversing the 3:2 pull-down can be accomplished with hardware in real time during
capture, but if you do not have the proper equipment, you can use the Cinema Tools
Reverse Telecine feature. See 3:2 pull-down.

scene In filming, a time and place setting for a series of one or more shots, typically
tied together by a common story line or certain characters.

scene list A film list Cinema Tools users can export, which lists all the shots that are in
the cut list with each shot listed only once. Scene lists are typically used to order prints
of the shots in a program so that a workprint can be conformed prior to cutting the
original camera negative.

SD video See standard definition video.
shot  A continuous film recording that does not have any cuts. A shot is a subset of a scene.

slug  Blank (fill leader) or substitute footage used to fill in spaces where footage is temporarily missing, in order to maintain sync between the picture and the soundtrack.

SMPTE  Acronym for Society of Motion Picture and Television Engineers. The standard-setting organization that established the SMPTE standard timecode for video. SMPTE timecode is the most commonly used timecode format.

source clips  The media files you start with when you begin editing. These are the files that are captured into your computer and linked to the Cinema Tools database before editing begins.

standard definition video  Refers to the NTSC and PAL video standards. See also high definition video; NTSC; PAL.

supers  Short for superimposed. Overlays of images or text onto frames. For example, titles are superimposed onto frames.

sync  Short for synchronization. When audio is in unison (synchronized) with the picture, they are said to be in sync.

synchronizer block  A small mechanical bench device with sprocketed wheels mounted on a revolving shaft. Located between film reels mounted on shafted winds, it accepts one strip of film and perforated magnetic sound track per sprocketed wheel. Once the film and track are locked onto the wheels, they can be placed in exact mechanical sync and will maintain this sync while they are advanced forward through the synchronizer block. The synchronizer block also keeps track of elapsed footage via a mechanical feet and frames counter geared to the sprocket wheels. Also known as a sync block, gang sync, or synchronizer.

take  A take is another version of a particular shot. In shooting a film, there may be multiple takes of each shot.

telecine  A machine that copies the images on the original camera negative to a videotape format, often including a window burn of the film edge code. See window burn.

telecine film speed  The frame rate at which the film is run in telecine equipment during the transfer to video.

telecine log  A file generated by the telecine technician during the telecine transfer. Records the key numbers of the original camera negative and the timecode of the video transfer, tracking the relationship between them. Sometimes called a FLEX file.

timecode  A format for assigning each frame of video a unique, sequential unit of time. The format is hours: minutes: seconds: frames.
**TK speed** See *telecine film speed*.

**window burn** Visual timecode and keycode information superimposed onto video frames. It usually appears on a strip at the bottom or top of the frame, providing code information to the editor without obscuring any of the picture.

**workprint** A positive copy of the *original camera negative*, cut to provide a record and prototype of the creative edit. In traditional filmmaking, the workprint is edited first, and then used by the negative cutter as a guide for cutting the original camera negative. In digital filmmaking, a workprint is usually used to verify the cut list and to create a prototype of the film to view on a big screen before conforming the negative. Sometimes called a *work pix* or *cut pix*. 


Index

16mm film 18, 202, 203
2:2:4 pull-down 195
2:3:2 pull-down
See also 3:2 pull-down
described 187
removing with Cinema Tools 190
2:3:3:2 pull-down 25
advantages 189
described 188
removing with Cinema Tools 190
removing with Final Cut Pro 189
2:3 pull-down. See 3:2 pull-down
23.98 fps video
adding pull-down for NTSC FireWire output 196
converting to NTSC 194
24@25 method 25, 136
24@25 method 24
24P video
about the aspect ratio 184
adding and removing pull-down 187–196
audio EDLs and 196
checking for cadence discontinuities 191
Cinema Tools and 10
Conform feature and 185
converting NTSC EDLs to 24 fps 182, 186
converting to NTSC 185
converting to PAL 185
described 10, 177
editing 11
editing material that originated on film 178
editing with Final Cut Pro 179–197
exporting 24 fps EDLs 185
Final Cut Pro and 10, 25
frame rate 10, 22
frame rate on NTSC systems 25
importing 24 fps EDLs 181
importing NTSC EDLs 182
Reverse Telecine feature and 185
telecine transfers and 10, 25
timecode used 186
using Final Cut Pro as both online and offline editor 179–180
using Final Cut Pro as offline editor 183–186
using Final Cut Pro as online editor 180–182
3:2 pull-down
"A" frames and 24
cut list accuracy and 136
described 23
removing extra fields with the Reverse Telecine feature 24, 113
35mm film 18, 202, 203, 204
A
Acmade numbers. See ink numbers
"A" frames
described 24
five-frame pattern and 24
locating 120
non-drop frame timecode and 24, 26
AIFF files 161
ALE files
advantages of using 63
creating a Cinema Tools database with 63
exporting 173
fields supported by Cinema Tools 172–173
importing 173
working with 172–173
answer print 207, 211
AppleCare Knowledge Base 217
AppleCare Support 220
Apple Store 14
Apple websites 13–14
audio
See also audio EDLs, audio/video sync
adjusting speed 123
capturing 98, 210
Cinema Tools and 9
double system recording 30
edited in Final Cut Pro 9, 29
editing traditionally 207
exporting an EDL 29, 161–163, 210
exporting an OMF file 29, 160, 210
exporting considerations 160–161
finishing 210, 211
finishing with Final Cut Pro 29
mixing the final 29–30
recorders 28, 30, 98
speed issues 161
synchronizing with video. See audio/video sync
timecode 28–29, 30, 161
audio/video sync 30–31, 123, 209
24@25 method and 24
audio recorders and 28, 30
basics 30–31
camera-roll transfers and 21, 31
NTSC video and 31
PAL video and 31
telecell transfers and 29, 31
audio EDLs 66, 68
described 151–152
dialog settings 156
effective from within Cinema Tools 157
handling effects 153
saving program files 145
settings required in the Detail View window 77
timecode-based generation method 77
using with reel balance 155
when to use 152
Change List dialog 57–58, 156
Change Reel dialog 55
Cinema Tools
basic workflow steps 33–41
cut list generation and 39, 213–215
described 7–9
interface 47–59
workflow examples 41–45
Cinema Tools database
See also database records
backing up 93
basic structure 62
batch capture lists and 209
camera-roll transfers and 35, 65
changing default project settings 87
changing reel or roll identifiers 87
checking information in 67
choosing a film standard 67–68
choosing a new clip poster frame 85
choosing a sound timecode (Sound TC Rate) 68–69
choosing a telecine speed (TK Speed) 69
choosing a video timecode (Video TC Rate) 68
choosing default settings for 67–69
connecting source clips to 39, 102–106
creating 33–37, 66–69, 209
creating a new record 74
creating from a Final Cut Pro batch capture list 63, 71–72
creating from another Cinema Tools database 72
creating with a telecine log or ALE file 63, 70–71
creating without a telecine log or ALE file 64
cut list generation and 209
deleting a record 85
described 33, 61, 209
disconnecting clips from 104–105, 106
timecode-based generation method 77
using with reel balance 155
when to use 152
Change List dialog 57–58, 156
Change Reel dialog 55
Cinema Tools
basic workflow steps 33–41
cut list generation and 39, 213–215
described 7–9
interface 47–59
workflow examples 41–45
Cinema Tools database
See also database records
backing up 93
basic structure 62
batch capture lists and 209
camera-roll transfers and 35, 65
changing default project settings 87
changing reel or roll identifiers 87
checking information in 67
choosing a film standard 67–68
choosing a new clip poster frame 85
choosing a sound timecode (Sound TC Rate) 68–69
choosing a telecine speed (TK Speed) 69
choosing a video timecode (Video TC Rate) 68
choosing default settings for 67–69
connecting source clips to 39, 102–106
creating 33–37, 66–69, 209
creating a new record 74
creating from a Final Cut Pro batch capture list 63, 71–72
creating from another Cinema Tools database 72
creating with a telecine log or ALE file 63, 70–71
creating without a telecine log or ALE file 64
cut list generation and 209
deleting a record 85
described 33, 61, 209
disconnecting clips from 104–105, 106
entering information in 70–84
compression and 37
considerations for individual clips 101
device control and 38–39
dropped frames and 96
manually capturing clips 38
preparing to capture source clips 95–102
scene-and-take transfers and 39
change list 41
described 151–152
dialog settings 156
effective from within Cinema Tools 157
handling effects 153
saving program files 145
settings required in the Detail View window 77
timecode-based generation method 77
using with reel balance 155
when to use 152
Change List dialog 57–58, 156
Change Reel dialog 55
Cinema Tools
basic workflow steps 33–41
cut list generation and 39, 213–215
described 7–9
interface 47–59
workflow examples 41–45
Cinema Tools database
See also database records
backing up 93
basic structure 62
batch capture lists and 209
camera-roll transfers and 35, 65
changing default project settings 87
changing reel or roll identifiers 87
checking information in 67
choosing a film standard 67–68
choosing a new clip poster frame 85
choosing a sound timecode (Sound TC Rate) 68–69
choosing a telecine speed (TK Speed) 69
choosing a video timecode (Video TC Rate) 68
choosing default settings for 67–69
connecting source clips to 39, 102–106
creating 33–37, 66–69, 209
creating a new record 74
creating from a Final Cut Pro batch capture list 63, 71–72
creating from another Cinema Tools database 72
creating with a telecine log or ALE file 63, 70–71
creating without a telecine log or ALE file 64
cut list generation and 209
deleting a record 85
described 33, 61, 209
disconnecting clips from 104–105, 106
entering information in 70–84
compression and 37
considerations for individual clips 101
device control and 38–39
dropped frames and 96
manually capturing clips 38
preparing to capture source clips 95–102
scene-and-take transfers and 39
change list 41
described 151–152
dialog settings 156
effective from within Cinema Tools 157
handling effects 153
saving program files 145
settings required in the Detail View window 77
timecode-based generation method 77
using with reel balance 155
when to use 152
Change List dialog 57–58, 156
Change Reel dialog 55
Cinema Tools
basic workflow steps 33–41
cut list generation and 39, 213–215
described 7–9
interface 47–59
workflow examples 41–45
Cinema Tools database
See also database records
backing up 93
basic structure 62
batch capture lists and 209
camera-roll transfers and 35, 65
changing default project settings 87
changing reel or roll identifiers 87
checking information in 67
choosing a film standard 67–68
choosing a new clip poster frame 85
choosing a sound timecode (Sound TC Rate) 68–69
choosing a telecine speed (TK Speed) 69
choosing a video timecode (Video TC Rate) 68
choosing default settings for 67–69
connecting source clips to 39, 102–106
creating 33–37, 66–69, 209
creating a new record 74
creating from a Final Cut Pro batch capture list 63, 71–72
creating from another Cinema Tools database 72
creating with a telecine log or ALE file 63, 70–71
creating without a telecine log or ALE file 64
cut list generation and 209
deleting a record 85
described 33, 61, 209
disconnecting clips from 104–105, 106
entering information in 70–84
entering information using the Detail View window 76
entering information using the Identify feature 82–84
finding records in 91, 92–93
how it works 33
locking 93
manually entering records 36
modifying information in 85–88
opening 91
opening records 91
reconnecting clips to 107–108
relationships between scenes, shots, and takes 73, 78
renaming 93
Scene and Take fields 74
scene-and-take transfers and 34
telecine log data vs. default settings 66
telecine logs and 34, 63, 70–71
uses for 61, 65, 66
verifying and correcting edge code and timecode 88–90
crapper board 30, 206, 208
Clip Analysis dialog 55
Clip Analysis window 93
clips. See source clips
Clip window
entering and disconnecting clips in 106
opening 52
settings in 52
code book 61, 209
compression 38
Conform Clip dialog 54
Conform feature 40, 210
24P video and 185
batch conforming clips with 112
conforming single clips with 111
conforming the original camera negative 207
conforming video frame rates 27, 110, 111
See also Conform feature
Connect Clip/Open Clip button 82
Connect Clips command 103
contact printing 129, 131
vs. optical printing 132–134
converting film to video. See transferring film to video
cut list 9, 21, 34, 210
accuracy 32, 80, 136
clip-based generation method 215
described 138
doesn’t appear 217
double usage warning 141
editing timebase and 24, 32
effects information and 130–131
foreground layer 138
key number inaccuracies and 218–219
missing elements reported in 218
settings required in the Detail View window 77
temporary files and 219
timecode-based generation method 65, 77, 139,
213–214, 215
timecode duration of a clip and 84
D
dailies, creating database for 66
daily Roll field 79
database. See Cinema Tools database
Database Properties dialog 56, 67
database records
See also Cinema Tools database
basic rules for connecting clips 102
basic structure 62
changing all reel or roll identifiers 87
connecting source clips to 102–106
creating a new one 74
creating from a Final Cut Pro batch capture list 71–72
creating from another Cinema Tools database 72
creating one per camera roll 65
creating with a telecine log or ALE file 70–71
default settings 66–69
deleting 85
entering information using the Detail View window 76
entering information using the Identify feature 82–84
entering manually 36
finding 91–93, 140
information in 34
navigating through 91
opening 91
reconnecting clips to 107–108
requirements for batch capture lists 100
uses for 65
verifying and correcting edge code and timecodes 88–90
DAW (Digital Audio Workstation) 210
Detail View window
choosing a new clip poster frame with 85
connecting and disconnecting clips in 104–105
deleting a record with 85
displaying database records in 91
entering information in database records 76
identifiers in 75
navigating through records with 91
opening 48
opening a record in 51
reconnecting individual clips with 107
scene and shot data 78
settings in 77–82
settings required to create a cut or change list 77
settings required to export an audio EDL 77
device control 22, 38–39, 99, 210
Digital Audio Workstation (DAW) 210
digital editing 8
  basic steps 208–211
  before you begin 17–18
  Cinema Tools and 8, 9
  Final Cut Pro and 9
  preparing source clips for 109–126
  double system audio 30, 178, 196
timecode for 161
double usage warnings 141, 218
downconverted video 179
drop frame timecode 26, 28
dropped frames
  avoiding 96
  Reverse Telecine feature and 96, 219
dual system audio. See double system audio
dupe list 41, 134, 141
duplicate uses of source clips 134, 218

E
Easy Setups 127
edge code 203
  See also key numbers, ink numbers
determining with the Identify feature 83–84
  verifying 146
  verifying and correcting with the Identify feature 88–90
double system audio to-timecode relationship
camera-roll transfers and 64–65
  continuous vs. noncontinuous 64–65
edit decision list. See audio EDLs, EDLs
ingooding and 40
cut list accuracy and 24, 32
setting in Final Cut Pro 32, 109
edit decision list. See audio EDLs, EDLs
  converting NTSC to 24 fps 182, 186
  exporting 24 fps 185
  format requirements for saving 171
  frame rates and 169
  how Cinema Tools processes them 170
  importing 24 fps 181
  importing NTSC 182
  making changes in TextEdit 171
  reel names and 168
  repairing problems 170
  supporting by Cinema Tools 168
  using to generate film lists 168–171
  video standards and 169
  effects 128–131, 210
Export Audio dialog 163–164
Export Audio EDL dialog 59
Export command 169–170
exporting to videotape 159–160

F
field dominance 115
fields 23, 25, 27
  Reverse Telecine feature and 114–115
film
  16mm 18, 201
  16mm-20 18
  35mm 18, 201
  4-perf 35mm 18, 201
  audio considerations 28–31
  basics 201–211
  before you shoot 18
  edge code 203
  editing digitally 8–9, 208–211
  editing traditionally 206–207
  formats supported by Cinema Tools 18, 201
  frame rate 22, 205
  frame sizes 201
  ink numbers and 204
  key numbers and 203–204
  mixing formats 18
  perforations 202
  reverse direction 80
  speed 205
  Super 16 201
  transferring to video 19–28, 209
  using a timecode slate 30
film chains 20
film-digital-film method 129
film lists 137, 210
  See also specific list names
described 137–144
don’t appear 217
derective code and 146
exporting 145–146
generating from external EDLs 168–171
generating from other video editing applications 167–171
generating with the Cinema Tools Export command 169–170
temporary files and 219
timecode-based generation method 65
generate lists dialog 56–57, 210
  opening from within Cinema Tools 57
  opening from within Final Cut Pro 57
  settings in 146–150
film positive 19, 206
film standard
  choosing a default 67–68
  pop-up menu in Detail View window 80
Final Cut Pro
dropped frames and 96
Easy Setups for Cinema Tools users 127
editing 24P video with 179–197
exporting audio EDLs from 29
exporting OMF files 29, 160, 210
finishing the audio with 29
memory allocated to 220
setting the editing timebase 24, 32
using as 24P offline editor 183–186
using as both 24P online and offline editor 179–180
Find dialog 51
finding database records with 92–93
FireWire
Web site for 13
FLEx files 63
found set 51, 78, 91
frame rates
See also 24P video, PAL video, NTSC video
basics 22–28
film 22
matching to Final Cut Pro’s editing timebase 32, 100
NTSC video 22
PAL video 24
frames 23, 27
avoiding dropped 96
dropped 90
G
genlocking 97
H
HD video. See high definition video
high definition video 10
See also 24P video
I
Identify feature 82–84
edge code-to-timecode relationship and 88, 90
verifying and correcting edge code and timecode with 88–90
video without window burn and 83
Identify window 54, 88
Ink number field 79
ink numbers 204
See also edge code
interpositives 131
K
Key field 79
key numbers
16mm film and 203
35mm film and 203, 204
Cinema Tools and 203
cut list values do not match values in digital clips 218–219
described 203
finding 91
motion effects list and 144
OfflineRT and 96
verifying 37, 205
window burn 205
L
Lab Roll field 79
latent edge code. See edge code
Length field 80
List View window 49–51
opening database records from 91
M
Mac OS
version of 220
magnetic film 207
memory
allocated to Final Cut Pro 220
missing elements list 34, 41
described 139–140
resolving 140
motion effects list
described 143–144
key numbers and 144
N
negative. See original camera negative
negative cutter 207, 211
New Database dialog 47, 66
settings in 67–69
New Record dialog 74
NLE (nonlinear editor) 8
non-drop frame timecode 26, 28
“A” frames and 24, 26
nonlinear editor (NLE) 8
NTSC video
3:2 pull-down and 23–24
audio synchronization issues 31
converting from 23.98 fps 194
converting from 24P 185
EDLs and 169
field rate 22
frame rate 22
outputting to videotape 32
timecode 26–28
transferring film to 22–24
working with 22–24
O
OfflineRT 96
OMF files 29, 160, 210
Open Media Framework files. See OMF files
optical list 41, 142
optical printing 129, 130–131
vs. contact printing 132–134
optical scene list 144
original camera negative 206, 207, 208, 211

P
PAL video
audio synchronization issues 31, 32
converting from 24P video 185
frame rate 22, 24
outputting to videotape 32
timecode 26
transferring film to 24–25
working with 24–25
parsin error 169, 170
poster frame 85, 104, 105
progressive scanning 25, 177
pull list 41, 144

Q
QuickTime movie files 40

R
Reconnect Clips command 107–108
reel identifiers 87
referencing clips 126
release print 207, 211
Reverse Telecine dialog 53
automated version 53
settings in automated version 190–191
settings in detailed version 115–118
Reverse Telecine feature 40, 113–122, 210
24P video and 185
dropped frames and 96, 118, 219
field information and 114–115
tips for using 113
using on one clip at a time (single-clip reverse telecine) 115–119
using on several clips at a time (batch reverse telecine) 119–122
reverse telecine process
3:2 pull-down and 113
checking the results 119
effects on timecode 27
roll identifiers 87

S
scene-and-take transfers
advantages of 22
audio synchronization issues 22
capturing clips and 39
cut lists and 34
database structure and 62
telecine logs and 34
workflow examples 42–43
Scene field 74, 75, 79
scene identifier 75, 78, 79
scene list 41, 144
SD video. See standard definition video
self-contained clips 126
shot identifier 75
slate 30, 206, 208
sound. See audio
Sound Roll field 81
Sound TC Rate (sound timecode rate) 77
choosing a default 68–69
pop-up menu in Detail View window 81
Sound Timecode field 81
source clips
accessing information about 93
basic rules for connecting to database 102
breaking down or deleting sections of before editing 125–126
capturing. See capturing process
changing frame rate 40
choosing a new poster frame 85
conforming 40, 111, 112
connecting to the database 39, 102–106
considerations for capturing individually 101
deleting 126
determining length with the Identify feature 84
disconnecting from the database 104–106
editing timebase and 32
naming scheme for batch-captured clips 101
preparing for digital editing 109–126
preparing to capture 95–102
problems with moving or renaming in Finder 103
reconnecting to the database 107–108
referencing 126
renaming 93
reverse telecine and 40
self-contained 126
tracking duplicate uses of 134
sprocket holes. See perforations
standard definition video 184
sticks 30, 206, 208

T
Take field 74, 79
take identifier 75, 79
telecine log 19
advantages of using 63
camera-roll transfers and 35
creating a Cinema Tools database with 63
cut lists and 34, 35
data used in database 66
exporting audio EDLs and 31
scene-and-take transfers and 34
supported by Cinema Tools 70
telecines 19, 209
telecine transfers 24P video and 25
audio/video sync and 19, 29, 31, 209
camera-roll 21
Final Cut Pro and 32
rates supported by Cinema Tools 205
scene-and-take 21, 22
video output 19, 209
window burn 19
timecode 25–28
24P 186
audio 26, 28–29, 30
calibrating the offset 98
capturing accurately 97–98
conforming and 27
crossing midnight 25
determining values with the Identify feature 83–84
discrepancies between window burn and values in Final Cut Pro 27
drop frame 26, 28
free run 26
genlocking and 97
inaccuracies and Final Cut Pro 90, 97–98
noncontinuous 26
non-drop frame 26
non-drop frame timecode 28
NTSC 26–28
PAL 26
pre-roll and post-roll handles 26
record run 26
reverse telecine and 27
serial device control and 97–98
supported by Cinema Tools 26
supported by Final Cut Pro 26
verifying accuracy when using FireWire 37
verifying and correcting with the Identify feature 88–90
TK Speed (telecine film speed)
choosing a default 69
pop-up menu in Detail View window 80
transferring film to video 19–28
24&1 method 25
24@25 method 24
24P video and 25
3:2 pull-down method 23–24
camera-roll transfers 21
options for NTSC video 22–24
options for PAL video 24–25
recording a projected image with a camcorder 20
running the film at 30 fps 24
scene-and-take transfers 21, 22
using a film chain 20
using a telecine 19
transition effects list 143
transitions 128–131
troubleshooting 217–220
contacting AppleCare Support 220
video
capturing 37–39, 210
matching Final Cut Pro's editing timebase 32, 40, 109, 210
Video Duration field 81
Video Reel field 80
videos
creating for negative cutter 32, 210
exporting 24 fps sequences to 159–160
issues when editing at 24 fps 32
NTSC video and 32
PAL video and 32
Video TC Rate (video timecode rate)
choosing a default 68
pop-up menu in Detail View window 81
Video Timecode field 81
websites
AppleCare Support 220
Apple Store 14
Apple websites 14
FireWire 13
window burn 9
described 205
OfflineRT and 96
using the Identify feature on video without 83
workprint 19, 20, 206
change lists and 41
conforming to the cut list 211
editing 207